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1 
����������	�
 STAAD.Pro 

 

1.1 �����		������	�
 

STAAD.Pro 2005 ��������	
��	������������������������������������������������

�� !�"������#, ��������&'	, 
"&������
�� ���&��#�#(����)*��+����
�����,,-�����+����
�(�� �����.����.������
���)"���'"��'"�� �����������/����������&'	
"&���
�������
��&��01�� ����	
��	�+��������������&���2��#��������	
#( &�+��������������� Windows 

XP 

 STAAD.Pro �������
������/*��".������.���+����������
�������"��".���+� ��3����
�����&'	
���/#����#�	'�.� "���#�	4���&���, ���������/����� �, ����������#���, 
����������'"5�, ������#, �"*����� '�.� ������������, '��������(�, ��#����� '�.�������������
��������.��6 

 1.2 ���
��
��������� !��"#!$%&$�'� 

• ���.��� PC ����������*��������4������"'�.��������(� 

• ���	�
���)"
"&'��� �����"&����� 1024x768, 256 �� (
�&�!� 16 bit high color) 

• 128 MB RAM '�.������(� 

• Windows NT 4.0 '�.��&������*���(� ��(
�&�!��'�������
����� Windows 95 & 

Windows 98 ����&��/�&����!����#�"� ���
����!�������������� Windows 2000 
"& 
XP 

• �.3�����(�����������9��	����	 4:3�������*"���#�#�3� ���������#��������(������������ 500 MB 

• �&����"#�������������	������
"&"!������.����������
"&��"�	�������+���� 

'����'#�: ������� RAM 
"&���� �9��	����	 &+(��������&��01������!����4�����
��� 
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���#�3�
#( STAAD.Pro 2001 ����#����4������������������
��� ����������4�������4:3���� 
�!��'�4���4��'�(������ !� ��
"&
�����.������4:3���� 600MB )*��+� :�#���#�� ����(���
'�(������ !��������'�.���( 

1.3 ���)���	����� STAAD.Pro 

STAAD.Pro �������
�������������;����*(#"����"���+�����
��� &��&����������
���
�(��#(��6�����3 
 

 

STAAD.Pro #�����
���'"���+����������" �����&'	
"&���
�� 

���)"
�����,,-�
"&
��#���� 
"&��������������� 

OpenSTAAD ����
'"(���5����,<��	+���4�� STAAD.Pro �:�� &
����'�)*��+��!����+������
���4��#������� 

  

 

STAAD.etc �������.����.�+(��������������������������(����3�
�����&'	
"&���
����(�(� &���� �.3� 
)(����=����� =����� 
"&
�.��6 

  

 

 

STAAD.foundation �������
�������+�����������&'	
"&
���
��=�����4��������������/*�������� STAAD.Pro ���
���
�������3� =�������� =���(�� =�����
��
� 
"&=���������45� 

  

 

Section wizard �������
�������+�������!���>��>����#'���#��
4��+3��(����������� #�����'"5�#����#�=��#(��6 
"&'���#�����
)*��+������4:3���� 

  

 
Advance Mesher �������
���
���+����������� mesh 4��
+3��(���������
)(� �+(�)���
"&�.3� 

 

1.4 	���������	�
 STAAD.Pro 

�"������ STAAD.Pro  ���"�(����
��� STAAD.Pro 2005 
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'��� �'"�� STAAD.Pro 
���4:3���������*�4���"(�� 
 

 
 

�"��".�� Cancel 
"���"������ Open Structure  ��.����-��,"	#����(���������*(
"�� 

�".���,"	#����(�� �����,"����	: 

SPro2005/STAAD/Examp/US/EXAMP09.STD 
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1.5 �,�����	��-����� STAAD.Pro 

 

'��� � STAAD.Pro ����������*�4���"(�� ���(����&���'"�� 5 �(���.� 

�������� (Menu Bar) 

��*(�����4��'��� � ��������/������������!�����4�� STAAD.Pro ��� �����*��3 


������ (Toolbar) 

�*"���	�����*(/��"��� �����*
"&�����*(��
��������������:�������//���4�������� �+�����������!�����
����+��(�� ��.�������&��������5�������!���� ���)*��+������/�!�'�������� 

��������� (Main Window) 

�����.3�����'?(����������>�"��'��� � �+�
�������"
"&)"����!���> 

�������
�� (Page Control) 

����+��
/�����4�������4����������	 �����
/��.�
#("&'���'"�� (Pages)  &
���������'���
�(�� (Subpages) �+��!�����@��&��(�� ��������'���'"��
"&'����(�� &������#��"!�������
�!����  

����
�������� (Data Area) 

�����.3�������4��4��'��� � 
����"(���#�#�� (Dialog Boxes) #���� (Tables) '�.� �"(��
������ (List Boxes) #(��6#��"��A>&����!���� 
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1.6 �-
& (Mode) 5�	��"����� 

STAAD.Pro ��'"���'������!���� �".����� �����* Mode ���'��".�������3 

������������� (Modeling) 

'�.��'���(�������&��")" (Pre-processing) ����4�3�#��������!�'��4������������ 
�3!�'���������  �������� 
"&�.��6 �����#
"����.�������+�������
����4���*(�'����3�(�� 

��������� ���!� (Post -processing) 

 &����4�3�#�����)*��+�#�� ���)"����!���>�����&'	4�����
��� ��3�
�����,,-�
"&
��
#���"4 #"�� ������������������� 

������"���#��$������%� (Interactive Design) 

 &�'�)*��+����
��+3��(����������� ( ��#(����������, =�����, 
)(��'"5����=����� 
"&�.��6) 

�&������� ���!�� ��� (Bridge Deck Preprocessor) 

 &�'�)*��+�������3!�'�����������'"���&�����.��� �������".������4�������'�& �+�������
���
�(�� STAAD.beava 

���
&� (Piping) 

�'����3 &�+��(����� ADLPIPE ��.���'������/������*�*��(��4���������������"(����� 

1.7 �-
&������
�&7 

������������"�� STAAD.Pro �!��������0��.� 

a. �+��,"	�!����� (Command file) 

b. �+���������
���#�#���+����,-� 

�,"	�!������.��,"	4��������� �4���*"��������� ��� &�����!�������1�A�����4��� �(��#���*�
��
4�� STAAD.Pro )*��+������/������,"	��3�������+����
������#��	�������+(� Notepad '�.� 
WordPad '�.��+������������
��� STAAD.Pro ����&'�(���+���� STAAD.Pro )*��+������/
��-��,"	�!�����4:3���#�� ���
"&
���4��� 

  �����-� STAAD Editor �!�����������"������    ���*"���	 

�0���������
�����,-� &�+����.����.�������,-����'�����������" 
"&�!�'��4���*"�+(�  
��>����#�����, �(������#(��6, �3!�'��������� 
"&�.��6 ���4>&������������"���,"	�!������5 &/*�
�����4:3������#����#��*(��.3��'"���:��)*��+������/��-��*���#"����"� 
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�0�'�:����� &�*��(������*(���'���'� �.��* ��4��������
/��/��&����"(�� (�*�*�4���"(��) 

 

1.8 -���$,��95��-
&������
�&7 

'���'"�� (Pages) 
"&'����(�� (Subpages) ���'��������������"�������3�.� 

 

• Setup 

� Job 

• Geometry 

� Beam 

� Plate 

� Surface 

� Solid 

� Parametric Models 

� Composite Deck 

• General 

� Property 

� Spec 

� Support 

� Load 

� Material 

• Analysis/Print 

� Pre-print 

� Analysis 

� Post-print 

• Design 

� Steel 

� Concrete 

� Timber 

� Aluminum 

� Footing 

� Shearwall 
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1.9 -��� Setup | Job 

'��� Setup | Job �+���(4���*"������4����������� ��.���"��".��'��� Setup | Job �"(���#�#��
 &
���4:3���������*� 

  

�"���B� More  &��'��� � Structure Information 
���4:3��� &
��� !���� ��#(�, ���, 
"&

)(���3�'������������� 
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1.10 -��� Geometry | Beam 

 

�+��!�'�����������	�����
�������+.����&'�(����� ��#(��+(� ���, ���, 
"&���	
���������/�� ��.����-�'��� Geometry | Beam #���� ��#(�
"&#������� &

���4:3��� 

 

#�������
��� ��#(� ��>����# ����� 
"&������� ���
������*�4���"(�� 
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1.11 -��� General | Property 

�+������
"&�!�'����>����##(��6�'�������	����� '��� � Properties �������4�� &�+������
�����
"&�!�'����>����#4�����	����� 

 

 

 

�������	
��� Values… ���
����������������������������������	����� ����� !��� 

����
"# $� ��!������� ���	� �������% �&� 

 

 

 

 

��.���"���� Section Database  &
����" ���# #��#����'���#��4:3����'��".�������
/��".��
��������+���.� Steel, Timber, 
"& Aluminum #����(���+(�#�����'"5���#�=�� &���'��".��
4��'"����&����+(� ������� ����CA ?����B� �(��4�������3��� �+�#�����'"�  
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��.���"���� Define…  &�� ��������'��#��#��#������+ � ����'"���� ���"� �*�#���� 

�� �#� 
"&�����/�!�'����>����#������'�� � ������#/�'"5�/�"*������ '�.��!�'�� 

1��'"���5�� ������*� 
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��.���"���� Materials… ���
��� &
���#�������"&�������>����#����� �������* ��=��4 ��*"
�����# &�� 3 �� ���.� ������# �'"5� 
"&�"*������ 

 

��.���"���� Thickness…  &�� �����!�'������'���' 
� ��"���# 
��
) � ���
������*�
4���"(��  &�'5����������/�!�'������'��4��
)����
#�#���������������� 

#������!�'������'������� ��  &�!�'��� ���� Node 1 ����� ��������5�� 

 

 

Assignment Method �.�����!�'����>����#��������4:3����
"�� �'�
�(���	�����'�.��"���#	�!�
���'"���0� ���#(�����3 

• Assign to Selected Beams ����".����>����#���#������ ������������#�������
"�� 
"���!�
����".�����	�����'�.��"���#	
"���"��".����B� Assign 

• Assign To View  �.�����!�'����>����#�'�������	������������
�����*( �!��������"�
�".��'���#��
"���"���B� Assign 

• Use Cursor to Assign  ��������+�����	����	����'��&���".�����	��������#���������#��
 ��'��� � �!�����������".��'���#�����#������ ����B� Assign 
"���+�����	����	���"��".�����
���	�����  
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1.12 ���� General | Spec 

�� �� �����	
 ������������������	� �� ���� � (Node) ��� ��� (Beam) ��������� �� �!!�" � 

(Plate) #$���% ���&� !'�����������������������������(�����  

 

��)��(�*��!	��+��*�!���%��!�*�, 3 �)����� �)�������,�� �)����*������������&� !'�� 
��%�)���������&� !'��	�*��)���/��� 

Highlight Assigned Geometry 

� ���
)����01+���������� ���/������1+��������&� !'���%���2��3��4���/	�(�����*� 
�'��,)��
)�1*����������,�� MEMBER TRUSS ���/��������3�(���1'��'0�� ��%1+�
�4���/ 

Edit/Delete 

�����5 ��0,� 	�*����'!�����)����������*�����!�)�'0� �
)�1*���*������*���,�� START 

MZ ��%�����,���3� START MY MZ �6	�*����������,����*�������5  Edit ��)��(�*��!�'�
	��+��*��)��%�����$0�  

1*��&�,��!�,�� MEMBER TRUSS 	�*����������,����*�������5  Delete 
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Toggle Specification 

��3�����
/��,'�(� � toggle #$��	�(� ���0 � ���������,����%	
*��7������ Use Cursor to 

Assign �% ��'0�����'���0 

• ����������/������������ ��/��$����'0� – �%��3����������&� !'�� 
• ����������/������������ ��/��� ��'0������� – �%1�����������&� !'�� 
• ����������/������������ ��/��� �����'0� – ��&� !'���%1+��������'! ��� 

�'��'0���)�%��'0���������%� ,1$��������1*,'�� )1+������ ��%�%1���������1*1+������
��*��*� 

 

��5  Node… 	
*�'0��*����������,��'!����)��
)�������� master/slave � �������5 ��*�� Node 

Specs �%1+������$0� �'�	��+��*��)� 
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Master/Slave 

Master node � ,1$�����)������3�����*��������'!����������'��������)� Slave node ����8 	�*
�������������)�����%��3� Master ���,�� 

Rigid � ,1$�����/���,$��%��)� master ��% slave  ��)���9�����3���'��/	��'0������������% 1*
����
)����0����6�%����������)�8�$0� 	�*����� 

1.13 ���� General | Support 

	
*	�����*���%������������'! ��)��(�*��!	��+��*��)���%��!�*�, 3 �)����� �)������
�,�� �)����*�������*����&� !'�� ��%�)���������&� !'��	�*��)���/��� 

 

	���'0����������� ��:���*��0�% ���)�,�� S1 No support ��)�'0� �*����*��������'!�!!����8
�$0� ���� ����*���� 

 

������5 ��0�������*��������'!� �*���� (�,�% ���)��(�*��!�����$0� �'�	��+��*��)� � ���	�)
�)�'��&%� �*�������6�	�*������5  Add 

�)����������)�'0��6���!!���  �� ������������&� !'��	�*����)�� ���� 
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1.14 ���� General | Load 

	
*	�����*���%������0���'�!����� ��)��(�*��!	��+��*��)���%��!�*�, 3 �)����� �)��
�����,�� �)����*�������*�� ��%�)��������0���'�	�*��)���/��� 
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�0���'�!����� ���,��%�;���*��) �0���'�!���������� �0���'��� ����  �")������� ��%����8 
	� STAAD.Pro �'0�"+*	
*� �1��*��$0���*��� ��% � ��<�	�*������
)� UBC, IBC ����'!
����")������� ��% ASCE ����'!����   

����*��0���'�!������%���� �� Primary Load Case �)��(�,����������,�� Load Cases 

Details ��*�������5  Add… ��*���'�	��+��*��)��%���2�$0�  

 

� �����*� Primary Load Case ��!�����&���*� �)� �6�%������0���'�!������)� ��%�� ��
(�,����� Load Cases Detail ������5  Add… ��*������ Define Combinations 	��,��
���*�#*, ��*���%��3��'�	��+��*��)� 
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1.15 ���� General | Material 

	
*	�����*���%������'��� ��)��(�*��!	��+��*��)���%��!�*�, 3 �)�� ��� �)������
�,�� �)����*�������*�� ��%�)�������	�*��)���/��� 

 

�% ��'������(�����  ��,+)��*���� STEEL, ALUMINUM ��% CONCRETE  ���&� !'���'�	�
��� 

 

1*�*������*��$0����	�*����5  Create �% ���)���*��� �����$0� 	�*�����*� +� 

1.16 ���� Analysis/Print | Pre-Print 

	
*!��(����� 	�*�� �/�*� +��)�8�������,��*���)���������%�/(�����*��
)� �*� +�(�����*� ���
����'! �0���'�!����� ��%����8 

	��,��	���� �����������,!�*�,��*��%������3��������� ,1+� ��)1*��3��������� ,��1 
�����),'�� )���,!�*�,	�*"+*	
*��*���)�����������%�/ 
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1.17 ���� Analysis/Print | Analysis 

�%	
*������'0����	��������%�/�
)� �0���'�!����� ��������!�
���1��,/��3��*� 
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(�,�'������ ��%��	��=�%��6! Perform Analysis � ���'���������� �� ��  Nonlinear 

Analysis, P-delta Analysis ��% Change �� ��'����������'!�������%� �'0��+� �
 � ����
���%��!!� �� ��
���� � #$��� ���� �	������0 

�,�%���,��'������ 	��'�� � Perform Analysis � �1�������'�������0 
• No Print � ����� � +�	� 

• Load Data ����� � +��0���'�!����� 

• Statics Check ������!"��� ������;,��� ����2�����,����������'! �� �'0�( � �� 
�������'��� ������������� 

• Statics Load �
 ����,��'! Statics Check �� ���� ������"��� ������;,�����%
���;,	� ������%�������, 

• Mode Shapes ����� �'��� ��������� 

• Both  �� �� �'! Load Data �� �'! Statics Check 

• All  �� �� �'! Load Data �� �'! Statics Load 

1.18 ���� Analysis/Print | Post-Print 

��3��'0����	���������*� +�"���������&�����%�/ ����*����	�*����	��9�/"��'�7/��� 
STAAD/Pro (� ���� .ANL) #$��� �����*�+)��*,)�, Analysis/Print > Post-print ��%� ���
������5  Define Command… �%������)��(�*��!�'�	��+��*��)� 
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• Load List ����
���0���'��������� 

• Section ��������'�	�
�0�� ������������	������ ( � ����%��� 
• Joint Displacement ����� �����,�+� (���������, � ��) �������� 

• Member Forces �������	�
�0�� �� �
 � ���� ������ ����=��� ( � �� 	��+��!!
�������'!���
���0���'� 

• Support Reactions ����� ����2�����,	��+��!!��� 
• Force ����� ������(�� (Envelopes) ���( � ����%�������'!
�0�� �����  ����� 
• Max Force ����� �����%( � ������+������%������ 

• Story Drift ����� ������������	�����!�%�����0����
'0� �'0��������� 
• Element Force ����� �����8 ��������$0�	������ ���!!�" � 

• Element Force Solid ����� �����8 ��������$0�	������ ���!!�'� 

• Mode Shapes ����� �����,�+��������� ����'!���(� � (Mode) 

• Entire Table �����,��������6���������	
  
• Section Displacement ��������&��%����� �����,�+������ �'���������� �,+ 	�

�%!!���'�(��!�� 

• Analysis Results  �� �� �'!���'�� Joint Displacements, Support Reactions ��% 

Mode Shapes �� �'� 

• Member Section Forces �������	��� �'� (� ���������� (�,���'�� Section) 
����'!
�0�� ���������� �
 � ���� ������ ����=��� ( � �� 	��+��!!��� 

• Member Stresses ����� �� �,������������� ��%�����,���
�0�� �� ��%����� �'����
���������'!
�0�� ���������� 
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1.19 �����'() Design 

 

�� ��'0������������ �'���� (Parameter) ��8 ������� �	� �� (�����  

���������	
 	�������!!� ��� � ����� �+ �� ��'� Design �%��%��!�*�,
�� , �, Steel, Concrete, Timber, Aluminum, Footing #$���� �� , �,
�% �� ������ (Code) ������� ��'�� �� 
����'�������%����!! �� �% �
�'0����������(�,�� �� ,�'����� ���������� Select Parameter… �%   
�� ���������'��������%�����	�������!! ��%� ���������� Design 

Parameter… �%�� ��� ��� �'��������� ������� �� � �� �������� 
Command �������������'�����	
 	�������!! �'�	��+��*��)� 

 

 

 

� ���������5 ��0�%	�*"+*	
*������� �����/����%1+��� �,+)	�������&����!! (�,���������
�� �����/����*�������,�� 
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� ���������5 ��0�%	�*"+*	
*������� �����/����!! (�,�% ���)��(�*��!�����$0�  

 

 

 

������5 ��0�%,� 	�*"+*	
*��������'��	�������!! (�,���������)��(�*��!�'�	��+� 
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2 
��������	��
�
������ 

 

2.1 ����������� 

���������	�
������������
���
��������
���
 

  
������� 

���	�
�����������������
��� ���!�"
�����
�#$�$�$"� %&�%���������������"��� �
 �'
%&�
&�����������()�&��$*���(&���� ��������
����*�+"�
�����,����
�-��������.�����& .�"
 ������&&(�$�'��/'	
�0%&�&�1�����������*)�������
�#$�$�$"�����"��
�� 

���������	 1 �� ���.�����&���"������	
 File > New ����&���� �������%���� New 

Structure  � ���� �!�	����
�2 &
����&  ������&����
��� 

• 3�$�.��
����
 : Plane 

• 3�	�%2�4 : Beam2D  

• ���*"�*�&"�* : Meter 

• ���*"��
 : Kilogram 

• ���+����*��$��(5& Next 

1200 kg 

500 kg/m 

4 m 1 m 2 m 
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������
.�������&��������� Add Beam ���*��$��(5& Finish 

���������	 2 ��$�������� �" �" Setup > Job � ��� �&������ �
.� �� Job Info 

��&� �
��� �� *������� �" �" Geometry > Beam .�����&�0���
�� �
.� �� 

Snap Node/Beam !��&�*"����
 Nodes ��0 Beams 

��$������������
1��������� (Front View) ��� ����4 

 

���
����0�� �0"0��$� ���*����
.&�����
��� 

• Plane : X-Y 

• Construction Lines : 

X : 0 →→→→ 10, Spacing = 1 

Y : 0 →→→→ 10, Spacing = 1 

��$��(5& Snap Node/Beam ���*����
.&�����
����� 
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�&�	� �����+��� *�0��+�%�*� ����
 Nodes ��0 Beams &�� �&����*�����
�(�� ���0���
��& �	�� �
 1� �3 ��&��6�� %�� �������
 /'	
�0� 
1��� ������
���&�*$�.�* 
����	"����
%��*" 

 
 

���������	 3 �3 �!����. �� �� ������" �" General > Property �!�	��������()�&��$
���� �
� ����� ������.� " � ������ �0������������������
���+�&���7�� �!�	��*�&
�*���+* 

��$��(5&  ���������������+�&���'	
������� ��$� Add ����� Assign To 

View ���*��$��(5& Assign 

��$���8�!.&�������� Label ������
�&�"����(������0��� 

���������	 4 ������� �" �" General > Support �!�	� �	�0�� �(���
���� �� .��
�� �
 
/'	
&� ��
�&� 3 � ��� �"'��� � (Fixed) ��&(�%�  (Pinned) ��0���	��%�  
(Roller) .�"�� �
�����(���
�� ��
 3 �'��&�� ��� *"�����	
 Add �� *�'
 Assign �� 
�� �(��� �	��
��� ��0�(���&����� �*" Node Cursor 



STAAD.Pro 2005: LECTURE NOTES 2 - 4 

 

�������(���
��� Roller ���������6 Fixed But ��$������������$��0 �	���
��� 

 

��"������
�(���
���0��,���
����� 

 
 

���������	 5  ��������������������� (��� �� .��
�� �
 .�"����� �	�� �" �" General 

>Load �� �
3(����������� (��'��&� /'	
��0��� *"����������0 ���� ��(� 
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(Concentrated Force) ��0���������1 ��0��"�
 �	 (Uniform Force) .�"��$� �	 
Load Cases Details ���*��$��(5& Add 

 

�&�	�����
��)����������� (����+��0���
�'������"��������$���������*��$��(5& Add ���
���&����
���������� (���
��������
���
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����"����0���
���������� (� ��
��
�'��&���
����������$���������* Assign ���
��� �	���
��� 

 
 

 

 
 

���������	 6  ������������ �������
1� ���2 &� �&��1���!9  (.ANL) %� .�"�3 �����	

����&����  Commands > Pre Analysis Print > Print All… ��0 Command > 

Analysis > Perform Analysis ����� All �����3��!����. ����
%������*&����* 
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���������	 7 ��	
�� .�����& �����*$����0� � *"�����	
����&����  Analyze > Run 

Analysis… ����� �����*$����0��*" STAAD 

���������	 8 �� ��� .�&����
1����*$����0� � *"�����	
����&����  Mode > Post 

Processing �������%����� ���� �����3(����������� (� �	�0�3  ��������
1� 

 

 
 

1� �3 ��&��6�������� �������
1�%� ��&� �
��� �� ������� ������ �	����������� ���

�#$�$�$"�/'	
��%� ����� �" �" Node > Reactions ��0������"�������� �" �" Node > 

Displacement �������%���� Deflections %�.�"��
 
 

 

�������������8�!��������
1� �� �"�"�'��������+��
 ��%� .�"�3 �����	
 View > 

Structure Diagrams > Scales �������%���� Scales  6 ���
����� �"�"�'���� 
���� ���*�������"�
 ��0�� �
������6 ���
�������+��
 �+���� ���*������!$	&�'�� 

��0����� �" �" Beam > Forces �0��&��6� ���
��
�����!� �& ��
�1�8�!%�  

����.�"�3 %����.�"��
 %���  Bending Z Moment  Shear Y Force  
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� *����" �" Beam > Graphs �0�� �������
1� ��0�
� ����� ��������2 �!��& 

���
� ���
��*����*" 
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���������	 9 ����� �
��"
��  ��%� .�"�� ��� �� ����� Reports ����!����. �� ����

����&����  Report Setup  �&�	��������"��� �	� �
����� *��&��6����*�" �
� �� 

!$&! %��*"%���� Print Preview  �0%���"
�� �	���!$&! �����+���� 
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3 
��������	
������������ 

 

3.1 ���������� 

��������	�
� ���� 	�������������������	���� �� � TRUSS ���
�����
�	�
�� �

�����
 ��������� ���!� ���
"�# ���$	����
���%����	����&�
'$�� 

"
���	���� �	�
� ���� �'��(! �����$%�  E = 2 x 10
8
 kN/m

2
 ��� A = 6 x 10

-4
 m

2
 

����������#�!�� �� 

 

���������	 1 �� ��)��������(��	�����
 File > New "����)��� ����"��'�	�� New 

Structure  ���)���� �*������
�+ 
��%�  %�,�-�)�$�
�(! 

• #��$�	�
��-�
 : Truss 

• #���'+�/ : Truss2D  

• ��,��	����� : Meter 

• ��,����
 : KiloNewton 

• ���0"��-�	�����1 Next 
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%���,�
� - �� ,��%�-����� Add Beam ��-�	�����1 Finish 

���������	 2 	���������� �� �� Setup > Job � ��� �)�%��� �
�  �� Job Info 

 � �
��� �� �������� �� �� Geometry > Beam ������"���$
�� �
�  �� 

Snap Node/Beam *��$�� ���
 Nodes ��� Beams 

	�������������$
2�$-����-� (Front View) "���)����/ 

 

 �!
	,������ �������$ ��-���-�
��$�$�
�(! 

• Plane : X-Y 

• Construction Lines : 

X : 0 →→→→ 6, Spacing = 0.5 

Y : 0 →→→→ 1, Spacing = 0.7 

	�����1 Snap Node/Beam ��-�"���-�
��$�"���$
$�
%��)��-�
�,�
 

 

%�������
���"����
����$�	����(�"�$ �$��
�� � ���
�(�'$  �!
	 �'� �� � ����	����(�"�$ � 

1 ���"�$ � 2 $ ���	����
��������� ������"��� �
�
	 ��	�������� 1 ��!��
�$��� ��� � �������	����(�"�$ � 3 �������0"��� �
�
	 ��	�������� 2 "��"�$ � 

2 '���
"�$ � 3 �$��� ��� ��# ���� 

 

� �����
"����� �
����� �
�
	 ��	�������� 2 "��"�$ � 1 '���
"�$ � 3 ($)�"�� 
������) ���"�
 �
� ��"�$�(�$
 (Hot Grips) ���
�� �"�$���� ���
�
	 ��	��%�  "��
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"�$ � 2 '���
"�$ � 1 $ ������$ Ctrl 	 �
'� �� �	����(�"�$ � 1 "���0�'$ � �"�$�(�$
"�
����5�(�"�$ � 1 �� �� Ctrl �� �	����(�"�$ � 3 ������"��� �
�
	 ��	�������� 2

��!�$�
��* 

 

����� ���	
���������� ������������� �	���
���������� ������ �� ���! ����	�"��


������ 

 

���
�$�����'��� � �����"������$"�$ ��������(�(	 � ����� ��� �"�$���� � '���
"�$ � 
�������(�(	 ������ 

TIPS 

 

���"����6(� �
 ��� � �����""��� �
���"����
�$� �� �
�7*��"�$ ��� �
�$(��
 ����$���(� �
��� �� �	 ��%# 	�����
 Add Beam �� �
�
	 ��	������ �
"�$ ��(�  �

��� 

- �$ Ctrl 	 �
'� ��$�� �	����(� �����
"�$ ��(� �
��� ����$�� "�	�� 

 

- 	����(� Snap Node/Beam �*������������%# 
�� (�� �)���!�) 	����(��)����  Add 

Beams ����"����)���  Geometry > Add Beam �*����� �
�
	 ��	���$�	����(�
"�$ ����� ����"�$ �������
 ����$�� ������"��� �
�
	 ��	����!��%�  
��������
	 ��	�� �'��0 �
	���"�$ ����� ����"�$ �������
 2 "�$�# ��$� 
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���������	 3 %# �*"	������ �� ��)���� �� General > Property �*��������$	�&��� �
%��� �
	 ��	�� ��������"�� � 8���(! �"�� �����$*�!��(��� � �$ (A) � ��	�&��� ����$�
�"�� �����$	 ��$)�����$��� � (E) �%�  ���
*��*(�
��������	�
�� �
��� TRUSS

	�����1 Define… ����� General �*������
	�&��� ���� �$ 

 
 

	��� Add ����� Assign To View ��-�	�����1 Assign 

 
 

���������	 4 ������� �� �� General > Support �*����(�"�%� "�$��
���%� �� �	�
�� �
 
���
(��!
�$ 2 ��� 	�� ������'$  (Pinned) ���������'$  (Roller) �$��� �
�)����
"�$��
�����!
 2 ��!��� ��$ ��	�����
 Add �� �"�
 Assign %� �� "�$ ��(� �
����(��"�$
 ����$�� $�� Node Cursor 

TIPS 

 

%���&(�(� -�
�����"�$��
������"���	�
��-�
���'$-�$� Assign S1 (No Support) 
%�-��,"�$ ,��(�("�$��
����$���), 

 



STAAD.Pro 2005: LECTURE NOTES 3 - 5 

 

 

 

 

���������	 5 �����������$�!������������%� �� �	�
�� �
 �$�������(��� �� �� General 

>Load �� �
#�$�!��������������!�� ���
"���9��!�������������� �"�$ (Concentrated 

Force) 	����(� Load Cases Details ��-�	�����1 Add �*�����-�
�!��������������&( 1 
(Load Case 1) 	���������������(���-�
��!���-�	�����1 Add ����� Nodal Load %�,	,�
Fy = -120 kN $�
%��)��-�
�,�
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����!�����(��� Fy = -150 kN %�������"���$
�!��������������!
��
��!��$�
%��)�%�-
	����������-� Assign %�-"�$ ,��(� -�
��� 

 
 

����������������$�����$
	,�%�-�!������������"�'$-$�
%��)��-�
�,�
 

 
 

��������������* '��*���%# ���������
���$�	���'�	�� Take Picture  

�����
"����
' '$�����$	�&��� ����$� ���%���
' ��������������	����'$ 

�����������$�$)�����$��� �%� �� �
	 ��	��%��	�
�� �
'$ �$� %# 	�����
 Commands 

> Material Constants > Elasticity… �� ������$	 �%� �� ��!
�	�
�� �
�$������
 ������� To View 
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���������	 6 �����������$	 ������$
2� %��+ � �)�2���*6  (.ANL) '$ �$�%# 	�����

"����)���  Commands > Pre Analysis Print > Print All… ��� Command > 

Analysis > Perform Analysis ����� All ����%#-�*"	������$�
'$-��,�����-� 

 

���������	 7 ���
%� ���������������	���� $ ��	�����
"����)���  Analyze > Run 

Analysis… ��������������	����$�� STAAD 

���������	 8 �� ��) ��$��$
2�������	���� $ ��	�����
"����)���  Mode > Post 

Processing ����	���'�	�����)����   �����#�$�!�������������(�"�%#-������
��$
2� �����$)�����$
2���
�5������� (Reactions) ��������(��)���
 
(Displacements) ��-���������*$-��	�����
 Take Picture �*���%#-���������
�� 

 

����������$�)���*%������$
2� %� ������!�������0��
���'$ �$�%# 	�����
 View > 

Structure Diagrams > Scales ����"��'�	�� Scales  � � �
���%� ������!�%� 
����	 � �����%�����
 ���%���
�������� � �
���%���0��
 �0����	 � �����%��*����!� 

���������	 9 ����� �
���
�� ���'$ �$��� ��) �� ����� Reports "���*"	������ ����

"����)���  Report Setup  ����������������(� �
����� ������$) ���� �
� �� 

*�* '$$��'�	�� Print Preview  "�'$���
���(�"�$*�* �����0"�)� 
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4 
��������	
���������������� 

 

4.1 ����������� 

��������	
����������� (Frame Structures) �� 2 ���� ������������������� !
������� ����"#��������������������� � PLANE $%!���&'%�	
��������� 

(�������� ���� ����� �)�� * �����+��  E = 2.05 x 10
6
 Kgf/cm

2
 �"�� ���+����

��+ A = 12 cm
2
 �"�������������,#!�& I = 600 cm

4
  ��������-�.�*�� �� 

 

���������	 1 �� ��/��������� &������! File > New (�����/��� ��#�(��)���� New 

Structure  ���/"��� �0#!�����1 ������  ��2����/"+�� * 

• .��+������� : Plane 

• .#!�)1"� : Frame2D  

• ��2�&����&�� : Meter 

• ��2�&�� : Metric Ton 

• ����(�"���"���-3� Next 

3 m 3 m 

2.5 m 

4 t 

2 t-m 
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���"2��������2�������"#�� Add Beam �"���"���-3� Finish 

���������	 2 �"���"#���� �& �& Setup > Job � ��� ��/"���" ��� ��� Job Info 

���� ���� �" ��"#���� �& �& Geometry > Beam �������(���+�" ��� ��� 

Snap Node/Beam 0���+�&���� Nodes �"� Beams 

�"���"#�������+4"+������� (Front View) (���/"���� 

 

��*�2������ ��&����+ �"���������+"+�� * 

• Plane : X-Y 

• Construction Lines : 

X : Left = 0, Right = 2, Spacing = 3 

Y : Left = 0, Right = 1, Spacing = 2.5 

�"���-3� Snap Node/Beam ����(��������+"(���++����/����"2� 

 

������(��"�+���+���/� 
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���������	 3 �. �0(������" �� ��/���& �& General > Property �0#!������+�-5������
�� �� �� ����� ��������(�& � 
��� * �(�& �����+0#*�� !�� ���+ (A) �"������������
�,#!�& (I) � ���-5���������+-�(�& �����+� ���+/"��&#+�&- � (E) ����  $%!0��0 &�������
������������������ 

�"���-3� Define… �"#�� General �0#!�����-5�����������+ 

�+�-3� F2 ����0#*�� ! AX: 12 cm2 �"���+ Enter �������(���"��2�&��6� m2  

 

��������/"������������,#!�& IZ: 600 cm4�+&��7 �+ &���� �"���"�����#!����&'/�� ! 
Material ��� 

 

�"�� Add �"#�� Assign To View �"���"���-3� Assign 

 

�����������+��+/"��&#+�&- ��� �� �� ������������ �)+ �+& �. �����! Commands 

> Material Constants > Elasticity… �" ������+� ��� �� ��*����� ��+&�"#��
����"#�� Assign To View 
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���������	 4 �"#���� �& �& General > Support �0#!�� !(��� (-+������� �� ����� � 
$%!� ��*��+ 2 ��� �#� �����-�)+  (Pinned) �"��"#!��)+  (Roller) �+&�� ��/����
(-+�������* 2 �%*���� ��+ �&�����! Add �" �(% Assign �� �� (-+� �� !� ����� "�(-+
���"��+�� +�& Node Cursor 

 

���������	 5 �����������+�*����������-��� �� ����� � �+&�"#��� !�� �& �& General 

>Load �� �.-+�*����������-��%*��� $%!(���6��*�������������� �(-+ (Concentrated 

Force) �"�������� �"��� ! Load Cases Details �"���"���-3� Add �0#!������*������
����-���5  1 (Load Case 1) �"���"#����&���� !�����%*��"���"���-3� Add �"#�� 
Nodal Load ��2�2����"�������� +����/����"2� 

 
 

�������"�"������+�����+�2�����*����������-�(�)+�+����/����"2� 
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����������%���0 )��0#!��. ��������&���+&�"��)���� Take Picture  

���������	 6 �����������+� ������+4" ���1 �� ��/"4""�07  (.ANL) )+ �+&�. �����!
(�����/���  Commands > Pre Analysis Print > Print All… �"� Command > 

Analysis > Perform Analysis �"#�� All ��#��.��0(������"+�)+��"2�����"�� 

��������  �0#!�+/)1"������!� !'/������%*���#*��"��0#!����(��� 

 

STAAD PLANE 

START JOB INFORMATION 

ENGINEER DATE 30-Nov-05 

END JOB INFORMATION 

INPUT WIDTH 79 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 3 2.5 0; 3 6 2.5 0; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 

MEMBER PROPERTY 

1 2 PRIS AX 0.0012 IZ 6e-006 

UNIT CM KG 

CONSTANTS 

E 2.05e+006 MEMB 1 2 

SUPPORTS 

1 PINNED 

3 FIXED BUT FX FZ MX MY MZ 

LOAD 1 LOADTYPE None  TITLE LOAD CASE 1 

UNIT METER MTON 

JOINT LOAD 

2 FY -4 

3 MZ -2 

PERFORM ANALYSIS PRINT ALL 

FINISH 

���������	 7 ��!�� ��������������������� + �&�����!(�����/���  Analyze > Run 

Analysis… �"#����������������+�& STAAD 
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���������	 8 �� ��/ ���+��+4"����������� + �&�����!(�����/���  Mode > Post 

Processing ��#��"��)�������/"���   �"#��.-+�*����������-�� !(��.�������
��+4" �"#��+/�����+4"���8�����&� (Reactions) �"������ &�/��� 
(Displacements) �"������%���0+��&�����! Take Picture �0#!��.���������&�� 

 

����������+�/���0�������+4" �� �&�&�%*���#��"��"���)+ �+&�. �����! View > 

Structure Diagrams > Scales ��#�(��)���� Scales  ' �������� �&�&�%*��� 
����� �����"�����&" �"������"�����' ���������"��" ������� �����"����0�!��%*� 

�"������&2�& Beam | Forces �"#���"��)���� Mz  �0#!���+�4��/��������� 

 

��+�2����4��/�� �+&�"#�����/ Result > View Value… �"���'� Ranges �"#�� All 

�"���'� Beam Result �"���"���"#�� Ends ���2���� Bending 

�"���-3� Annotate �"���"�� Close (�)+� 
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���������	 9 ����� ���&�� ���)+ �+&�� ��/ �� ��"�� Reports (���0(������" ��#�

(�����/���  Report Setup  ��#!��"#����&���� !� �����" ������'+/����& �� �� 

0��0 )++�&)���� Print Preview  (�)+��&��� !(�+0��0 ������(�/� 
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5 
����������	
��	������ 

 

5.1 ���	�������� (Internal Hinge) 

��������	�
��������� 2 ����������������������� ��	�
!	�
������
"�����#�
�� �$�
��%������
��&����
'	�
 

 
��������(���
)���'��	��*���+�#,-�����&'����&'������
�����	�
�����#���� )��!��$�(��
 
File > Save As… #'������.���%�#,-�
����	 

���������	 1 #�������	�)���'���'*����� #'���'*�����& Geometry > Insert Node… 

��*��'�������/������
���#'���'*�� Insert Node ������������#(�
�.0��� 

 

1200 kg 

500 kg/m 

4 m 1 m 2 m 
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(	� �  2 ���� �'����1� Add New Point #'���'�� OK )���'� �'����%� 

 

����	����#�����	� ��%�����/ 4 ".�
����������
��	��*����( ����	�������
��
#' ����
�����2������$���3 

�'���'*������	���0
���)���'*�����& Select > By All > All Nodes 

�'*�����& Geometry > Renumber > Nodes… �'	�
)������ #(�
�.0��� 

�'*�� X Coordinate ��%��
*�������������
#�� Ascending #'���'����1� Accept 

 

�$��!	���������($�������� ��*������
�(�2�� �����
��&����
'	�
 

 

���������	 2 �� �(& �� �� �� General > Spec ��*���$������'�(�
� ����� )���'����� 
Beam… ��' �
)���� Specifications 

�'��#4� Release �'*�� Location: Start, Mz #'���'�� Add  →→→→  START MZ 

 

�$�"0$� �'*�� Location: End, Mz #'���'�� Add  →→→→  END MZ 

��������'	�
 Specification � #(�
�.0���
��&����
'	�
 

 

1 

2 

3 
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�$���� Assign ��3(����������'�()����� ����'*���� � #� �
� ��������� �
��� � ��
����'*�� Assign To Selected Beams )���$���� START MZ �#� ��������'� 2 

#' �$���� END MZ �#� ��������'� 1 

 

4����+��&�,'/�$�(��
� ��������������.0��*� 

MEMBER RELEASE 

2 START MZ 

1 END MZ 

�$���������� �/�	����������� ���5'��������� �/��
��0 
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5.2 ����*+�,-.--�*/�+ (Inclined Support) 

($������ 6��)��
� ������&�(����'��������� ���������� ���� 3 m ��� �)��&'�(�*���� � 

E = 210 kN/mm
2 �*0���������� A = 4 x 10

3
 mm

2
 ($��������!�0�( �� 

 

��*��
���� 6����0! �� �������� �.
� �
��0
� ����#(�
5'��
)��#��� )���$����� � 
�� ���*0�7�� (Base Unit) ��  ������&���  File > Configure… �'*��#�2� Base 

Unit #' ��'*����'������� English �� � Metric 

���������	 1 �� �(&)��#���������$�(��
 File > New ������&��� ��*��������� New 

Structure  ���&'��� ��*��(��
#, �
����  (	����&'��
��0 

• !���)��
(���
 : Truss 

• !*���,'/ : TrussSK  

• ��	��������� : Meter 

• ��	��#�
 : KiloNewton 

• �(�2�#'���'����1� Next 

��'	�
)������	������'*�� Add Beam #'���'����1� Finish 
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���������	 2 �'���'*���� �� �� Setup > Job � ��� ��&'��' �
)� ��� Job Info 

���� �
��� #' ��'*���� �� �� Geometry > Beam )��#���� #(�
�' �
)� ��� 

Snap Node/Beam �����������
 Nodes #'  Beams 

�'���'*�����#(�
5'�������� (Front View) ����&'���/ 

 

��*��
������������� 3 m �� �����������#������
 �.
� �
#�'
�������
���� ��    
�� ������ X-Y ".�
�����& ��&�� � Sin #'  Cos ".�
�� (����4� ��� )��#����� 
)����
 � �
�$���3�� �����'�".�
�� '
��� #' �� ��� �����$���3�� ��
�' ��'
�����

����� Nodes #�5&! (����4! ��������*������ ���������4&���
������(�� )��! �������
� ��� (Angle of Plane) ��
#(�
������0 

��0
�	�� ��� � � ���� #'��(���
)���'��
��0 

• Plane : X-Y 

• Construction Lines : 

X : Left = 0, Right = 5, Spacing = 1 

Y : Left = 0, Right = 5, Spacing = 1 

����� ��� Z-Z �� 30 �
8� ��*��(���
�
�/����������'� 1 ��
��&����
'	�
 

 

����� ��� Z-Z �'������
������� #'��(���
�
�/����������'*� ��	�'*��'���'*�� Snap to 

existing nodes too 
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���������	 3 ! ������)��' �� �(&���� �� General > Property ��*���$������3(�����
� #� �
� ����� )���$������	���$�(��
 Tools > Set Current Unit ����%� 
Millimeter �'����1� Define… �'*�� General ��*��(��
��3(����������� 

 

��������&'�*0���� Ax: 4000 mm2 #'���'�����*��
����4&���� Material ��� 

�'�� Add �'*�� Assign To View #'���'����1� Assign 

�$�����$����)��&'�(�*���� �� #� �
� ������)��
(� �
�� )�� ! �$�(��
 Commands 

> Material Constants > Elasticity… #' ��$����� �� #� ��0
)��
(� �
)���'*��
����'*�� Assign To View 
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���������	 4 �'*���� �� �� General > Support ��*������ ( �����
���� #� )��
(� �
 
".�
����0
��� 2 #�� �*� #��������  (Pinned) #' �'*�����  (Roller) )��(� �
�&�#��
�����
�����0
 2 �.0���� ������$�(��
 Add #�	��*��
��������
�����%�#������
���'*��#4� 
Inclined #'����������&'��
��&����
'	�
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NOTES 

 

������
��
 (Incline Reference Point) ��
�����
���#������
�*����(����������������
�����
��� )�����#�������)'��'��������#�������)�'��' �#�������)'��' X � 
����8��
��������
�������
������
��
 ��
#(�
��&����
'	�
 

 
(���
�����
�������
������!� Incline Reference Point Coordinate X = 1, Y = -

1.732 #'  Z = 0 �'*�� Support Type ��%�#�� Pinned 

���������	 5 �$�����$�����0$������������ #� )��
(� �
 )���'*������� �� �� General 

>Load (� �
!���0$������������.0��� ".�
� ��%��0$������� �$��� ���� (Concentrated 

Force) #' )�����/ �'����� Load Cases Details #'���'����1� Add ��*��(���
�0$�����
��������3� 1 (Load Case 1) �'���'*�����������(���
�.0�#'���'����1� Add �'*�� 
Nodal Load (	�	�#�
#' )�����/ ��
��&����
'	�
 

 

Global 

X 

Y 

Reference 
point 

30
o
 

30
o
 

-1 

-1.732 

X 

Y 
Local 
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����(��'#' �$�������#(�
�	����0$������������������
��&����
'	�
 

 

�$��������.���� ����*��! �� ������
��)���'������� Take Picture  

���������	 6 �$�����$����� ����#(�
5' �#, �� ��&'5''��9  (.ANL) �� )��! �$�(��

������&���  Commands > Pre Analysis Print > Print All… #'  Command > 

Analysis > Perform Analysis �'*�� All ��*�!�������)��'��
����'	����#'�� 

���������	 7 (��
� )��#����$���������� � � ���$�(��
������&���  Analyze > Run 

Analysis… �'*���$���������� ���� STAAD 
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6 
����������	
��	������(���) 

 

6.1 ��������� ������ (Support Settlement) 

����������	
 ���� ���	�� ������������� � E = 210 kN/mm
2
 �������������� �! 20 

mm ������ ������
 2 ��	"�� 

 

���������	 1 �
 ����$����������%����	 File > New ������&�� �������'���� New 

Structure  &����&�� ��������	�( 	��)�  )�*
+�����	��, 

• -������	��+�	 : Truss 

• -���'(�. : TrussSET 

• ��*!��!���! : Meter 

• ��*!���	 : KiloNewton 
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• ���/���+!����$�0 Next 

)���*�	� + �& *��)�+����� Add Beam ��+!����$�0 Finish 

���������	 2 ����������� �� �� Setup > Job $ ��
 ���)��� �	�  �& Job Info 

 � �	��� �� !������� �� �� Geometry > Beam �$���������	�� �	�  �& 

Snap Node/Beam ����!� ���	 Nodes ��� Beams 

���������������	1��+����+� (Front View) ������&��. 

 

 �,	�*�����& �������� ��+!��+�	������	��, 

• Plane : X-Y 

• Construction Lines : 

X : Left = 0, Right = 22, Spacing = 0.5 

Y : Left = 0, Right = 10, Spacing = 0.5 

����$�0 Snap Node/Beam ��+!��+�	������	)���$
+�	�*�	 

 

���������	 3 )- ���������� �
 ������� �� General > Property ������%��������&� �
)� �� �	� ����� ����%������*!��%����	 Tools > Set Current Unit )�+�$2� 
Millimeter ����$�0 Define… ����� General ��������	����&� ���� ��  

���	���� 
 ���,�����&� ���� ������ � �	��� 3 ��$�&&��� AX = 20 cm
2
, 40 cm

2
, ��� 

60 cm
2 ������+�	���/���+!�������$�0 Value… ��������*���+� ����,	�� 
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 �����,� Assign ����&� ���������)� �� �	� ���������-�,�� !� �!����� Assign To 

Selected Beam… 

 

�%�����%���������������� �)� �� �	� �����)����	�� �	'� ��� )- �%����	 Commands 

> Material Constants > Elasticity… �� !�%����� �)� �� ��,	���	�� �	��������
 �!����� Assign To View 

 

���������	 4 ������� �� �� General > Support ����������)� �����	��&)� �� ���	�� �	 
���	���,	�� 2 �&& ��� �&&���'�  (Pinned) ���������'�  (Roller) ����� �	��$�&&
�����	��&��,	 2 
�,��� ��� !��%����	 Add ��+!��	 Assign )�+��*��� *���� +�	����������
 ��%���&�+!� Node Cursor 
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)������+�	�����	��&����$2� Roller ��,�)�+������3& Fixed But ��+!��������� Release 

���-*�	���!+� FY � *��������,�$�������
+�&���*�	 ������+�	���/�)�+ �!���&�����
���,	����������� View > Table… ��������� Supports ��+!��$�0 OK ��� ���	���
��	��&���	
�,����	)���$
+�	�*�	 �����3& Fixed But 

 

3+��$2���*�	)���$
+�	&�3��!*�1�� �����	��� Release �� �	
+���& Restraint )�
 �!��*�	��,��� Release �����!+� FY (���� Restraint �5��� FY) ���������&��	'�+
�5�����7��	 Y � *)� ���	���&���	1��$2� �	
+� 

3+���)�'(�.�%����	���&!*� 

SUPPORTS 

1 PINNED 

3 4 FIXED BUT FX FZ MX MY MZ 

���	3�� +�	 � +�	��� !�8���+)�+���	 Save ��+!$9��$���� �����$9�
�,��)�*�������$2� 

 

���������	 5 �%�����%�����,%�����&�����)� �� ���	�� �	 ������������� �� �� General 

> Load �� �	-���,%�����&�����
�,�� ���	���$2��,%���������%��$ ���� (Concentrated 

Force) �����	�����	���������� �!
�	�����	��& (Support Displacement)  

��������� Load Cases Details ��+!����$�0 Add �������+�	�,%�����&��������� 1 
(Load Case 1) ��������������������+�	
�,���+!����$�0 Add ����� Nodal Load )�*
�*���	���������� �!
�	�����	��&��	)���$
+�	�*�	 
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Assign ��	��,	��	�	)����	��+�	 � ��� *���� +�	��� 

$��&��������%����������	�*�)�+�,%�����&�������'�+��	)���$
+�	�*�	 

 

���������	 6 �%�����%����� �������	1� )��( 
 ���1����8  (.ANL) '� ���)- �%����	
������&��  Commands > Pre Analysis Print > Print All… ��� Command > 

Analysis > Perform Analysis ����� All ����)-+������������	'�+��*�!���+! 

���������	 7 ���	)� �$�����%����!������� � !��%����	������&��  Analyze > Run 

Analysis… ������%����!��������!� STAAD 
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Reaction: 

 
 

Displacement: 

 

 

6.2 ,-.�	,����� ���,/0�������1	234� (Temperature Load) 

�������� ���	������������	� � ���$�����8 �������� �!�����	�������"�� αααα = 6×10
-6

 

/°F ��������������� � E = 5×10
3
 k/in

2
 ����
�����	"�� ����"��"��)��� ���& 70° 

F � !�����"��"������� ���& 110° F  

�	�����������$�����	�������"��)����!������� �%��$ � �	�%�����"�!�
�&�
  

(Boundary Condition) )� ��  ���	�� �	 ��- ���,��$������' ����3�%����!�
������'� ��������	��&����%����)� �� ���	�� �	 ��� Hinge ��� Roller ��	"�� ���	��
��)����	���	������$���������'��������3
��� �!������ �!'�+ 
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�����	���$ :����,)- �� !���	�;< ��	 �	 �,	� �������	1�
�	�$���� ����%����� � 
�� !���,�=�� (Base Unit) )�  ������&��  File > Configure… �������/& Base 

Unit �� !������$�������� Metric �$ � English 

���������	 1 �
 ����$����������%����	 File > New ������&�� �������'���� New 

Structure  &����&�� ��������	�( 	��)�  )�*
+�����	��, 

• -������	��+�	 : Plane 

• -���'(�. : FrameTMP 

• ��*!��!���! : Inch 

• ��*!���	 : KiloPound 

���������	 2 )- !�8�$ ��� ������
�	��� �)� ���	 Nodes �� !)- '���� Add Beams 

���	�	� �������� �	��� ��%���&������ �������	
�,� 

 

���������	 3 )- ���������� �
 ������� �� General > Property ������%��������&� �
)��� �	� �����  

������� Define… ����� Rectangle ��������	����&� ���� �� ��� 2” ��� 6” 
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Assign ����&� ���������)��� �	� ���������-�,�� !� �!����� Assign To Selected 

Beam… 

 

�%�����%���������������� �)� �� �	� �����)����	�� �	'� ��� )- �%����	 Commands 

> Material Constants > Elasticity ………… �� !�%����� �)� �� ��,	���	�� �	��������
 �!����� To View 

 

)��%���	����!��� �%�����%����� ����$�����8�>�������� �!�����	�������"��)� �� �	� 
�����)����	���	'���� )- �%����	 Commands > Material Constants > Alpha 
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… �� !�%����� �)��� ��,	���	���	�������� �!����� To View 

 

���������	 4 ������� �� �� General > Support ����������)� �����	��&)� �� ���	�� �	 
���	���,	�� 2 �&& ��� �&&���'�  (Pinned) ����&&������'�  (Roller) ����� �	
��$�&&�����	��&��,	 2 
�,��� ��� !��%����	 Add �� !��	 Assign )� �� ��� ���� �	�����
����� ��%���& �!� Node Cursor 

���������	 5 �%�����%�����,%�����&�����)� �� ���	�� �	 ������������� �� �� General 

> Load �� �	-���,%�����&�����
�,�� ���	�$ ��,%����������	�������"�� (Temperature 

Load) ��������� Temp… ������� �	�,%�����&����� �� ! Assign )� �� � ����� ���)-  
Node Cursor �������� *�����,%���������%� ��+!)-+ �!����� Assign To Selected 

Beams & Plates ������%������� *��������%� 
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���������	 6 �%�����%����� �������	1� )��( 
 ���1����8  (.ANL) '� ���)- �%����	
������&��  Commands > Pre Analysis Print > Print All… ��� Command > 

Analysis > Perform Analysis ����� All 

���������	 7 ���	)� �$�����%����!������� � !��%����	������&��  Analyze > Run 

Analysis… ������%����!��������!� STAAD 

���������	 8 �
 ��� ������	1����!������� � !��%����	������&��  Mode > Post 

Processing �������'����&����&��  �����-���,%�����&����������)- �%�������	1�
�������������	1���	$?������� (Reactions) ������������$ (Displacements) �� !&��
���"��� !��%����	 Take Picture �����)- $����&)����	�� �'$ ���	��' 
��� �!)�
���������� 
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Tutorial Problem 1 

2D Portal Frame 

���������	
������������	����������������������������� � STAAD.Pro �����"�#��$���%�����
&���
�������� 

- "��%�����(��	�� 

- 	���������"�
 

- ������&�����
����)����� 

- ����$���"
��&�����
���� 

- 	*�$���&+���������)����� 

- 	*�$���������%���& 

- 	*�$��������,"-�������)����� 

- .��.)����/
���)����� 

- 	*�$���&������� 

- 	*�$����*�$��	����&	 

- 	*�$���0�	���"����$) 

- 	*�$���*���%�.��.)$
��	���"����$) 

- 	*�$��.�����"���)��	���"$
�	 

- �*�	���"����$)�
���	��� 

- �/1,
)2
	���*��+ 

- ������2
��$����� �������	��,3	�
���"
� 

 



STAAD.Pro 2005 : Tutorial 1 1 - 2 

 

1.1 ��������	
����� 

�0����������/
���������������0��#� : 

��������� �1,
)�*���%� Command file 

��������� ����"���)",����������	��,,3	 Graphical user interface: GUI 

Command file ��"(4�1,
)����	5���%����&����/
�����������%���/	����� "(4�1,
)��%���*���%�����$��-�%�
�����������1������ � Editor ��%�����	���(��	��$�#��(��	���#%���%���"	�����/(����	5�1��" �� 
Notepad $�#� Wordpad 	�1�� 

1,
)�*���%����/	�������������������/�$
�	6�	 "�#%�����������/	��������	��,,3	 "���������
��1(��
��$�������$�����1���
��"
�".#%�����������/
��%	��	���	��,,3	 ��	��	������"���	�1�1,
)
�*���%��
����"	�� �(��	����"(
�%���(
� GUI �$�"(4�1(�����%"���	�1�������� 

����������������"(4�����"$
�	$��%� ���$��%� �������������/(����
��� 

 

����(��	�� STAAD.Pro $������� New ���/	�$
��������&	�������%"��%�����(��	�� ���1������	���$�
�
�	"��#%��$����/	$��������� Display this dialog box at the Startup ��%�&�-�����	 �
�������
"���	1����$
����	"��/ File > New 

������������ : 

����$��������(��	������������#� �������	75 (,&�, (���)) �
�����"����	 (�����, "���) 
����$������/	"
#�	������������������(��	�� ���/	� �"(4����"��%�������"��1����%��$�"(
�%���(
� 

	����#%��$��
�	 Cancel ".#%�(3�$��������/(	���$������"���	��� ��	����	��"(
�%��$����*�1�����"
#�	
"��/ File > Configure… (�/�/(����
���) �
�"
#�	����$�����%����	�� �$�"
#�	����"����	 Metric 

6 m 

1 

W300 x 56.8 

1 

W300 x 56.8 

3 

4 

4 m 

W350 x 59.2 2 

2 3 
Wind = 5 ton 

DL = 1 ton/m 
LL = 2 ton/m 
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�
�	(&;� Accept ".#%�(3�$����������� ��	����"
#�	"��/ File > New $������� New ��������������	����� 

1.2 ��������	���� 

��$����� New "������	��	����/
"��%������%�*���<�*�$���	���������"�
 "��%���	 �����������������%��
�$�"
#�	�#� Space, Plane, Floor �
� Truss ���"(4� ��� Space ���������, ��*�$��	����&	 �
�	��
"����/(���������������	��#� X, Y �
� Z �� ��� Plane ����������
���*�$��	����&	����/���������� 
X-Y "������� �*�$��� ��� Floor �������������/������ X-Z ������������ Truss ���� ���)����������
"6.�����������	�"������� �*�$�����"�
��%"�����������������$�"
#�	 Plane 

"
#�	 Meter "(4�$�������� �
� Metric Ton "(4�$������ "��%������	���������"�
 ���"��
������"(
�%��$���"$
�����1��=��$
���������	�� 

��� #%�1,
)��%����	��
��� ��� File Name �$����� #%��� Portal1 ��	�����$�"
#�	�*��$�����%����	�����"	��
1,
)����/

��� ��� Location  

��	��	����	������� #%�����	��
��� ��� Title �$���� #%�"(4� Portal Frame -�%��� ���$�"�����&
����	��1����	�+���%��	�������$
����"�
 $
����		*�$���������$���
��$��
�	(&;� Next 



STAAD.Pro 2005 : Tutorial 1 1 - 4 

 

 

��$�������������$�"
#�	"��#%���#�"��%������	���������"�
�#� ���"
#�	 Add Beam, Add Plate $�#� 
Add Solid ��"��%����	����������, �2��.#�� $�#��/(������ Open Structure Wizard �� �������
��"�
��������������������%����/���1
�����%����(��	�� ������������"�
���� �=�5��*���%� STAAD 
�������$�"
#�	 Open STAAD Editor  

$���"$�&: �������	��� � Editor ��	���������"�
 �$�"
#�	 Open STAAD Editor  

�*�$�����"�
���"���$�"
#�	 Add Beam �
�	(&;� Finish $����������$��1( $�����	��,,3	 
STAAD.Pro ��(��	>������ 

����/
�����������(��	����� $���"
� joint �
�.�	�������� $���"
� member �
�	��" #%�����
������ �*���%� STAAD ��%���/	����������*�$��������������������#� 

JOINT COORDINATES 

1  0.  0. ; 2  0.  4. ; 3  6.  4. ; 4  6.  0. 

MEMBER INCIDENCE 

1  1  2 ; 2  2  3 ; 3  3  4 

�
�	1����  View from + Z ��	�/
���) �
�"
#�	 X-Y "(4������ Plane ��$������� Snap 

Node/Beam  

	*�$��"������������*�$�����������	��� 6 "��� �/� 4 "��� ������/(����
��� 
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�
�	(&;� Snap Node/Beam �
�"��%��������"�
���� �"����)�
�	-
�	��1�����������������/(����
��� 

 

�
�	���(&;� Snap Node/Beam ��	 �
��
�	(&;� Close ".#%���	���������"�
 

1.3 ����������������������� 

��	�������&�����
�����$��
�	����%�&���?��.#����%=�.�� �
�"
#�	 Labels ��"��/��%(��	>���� $�#�
"
#�	"��/ View > Structure Diagrams… ".#%�"���	$����� Diagrams �������
�"
#�	��� Labels 
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����� Labels �$��
�	"
#�	 Node Numbers �
� Beam Numbers ��	�����
�	 OK 

 

 ���/(��"�
����$���"
� node �
� member ������/������������ ������/(����
��� 
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�������	��"�����"(
�%�� font ���$���"
� node/beam 	��������*�1�����"
#�	"��/ View > Options 
�
�"
#�	�����%����	�� (Node Labels / Beam Labels)  

1.4  �"������#���������$����� 

������1(���"��	��#�	��	*�$������$����������
�"�� �*���%� STAAD ��1,
)�*���%� �#� : 

MEMBER PROPERTY KOREAN 

1  3  TABLE  ST  W300X200X56 

2  TABLE  ST W350X250X69 

STEP : 

1) ".#%�������&+���������)����� �
�	1���� Property Page ���/
���)������: 

 

$�#�����
�	$��� General > Property ��	����-������$�������=�.$
�	������/(����
��� 

 

 

2) ��	����$����� Properties ��(��	>������������� (����/(����
���) $��������%"���������"(4�$������
�/( W ��	�����"$
�	 ����
�	(&;� Database… ������/( 

3) ����$������$�"
#�	(��"�@ -�%���1����(��"�@1���������������"�����&+��������%"$�#��	��	��(��"�@
�#%� �*�$����������������$�"
#�	 Korean �
��
�	 OK $�����"
#�	$������������������ ���"	��� ��� 
Material ���/	"
#�	��/� �$�(
���1����������1(	��� ".������*��$�"��������"(
�%���������%���& E, 
$�����*�$��	, (A�)-�� �
��#%�? 
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"
#�	$������ W300X200X56 �������
�	(&;� View Table �/�����".#%�"(����"����	�����1���$����
�������	��	�1�� �
�"
#�	 ST "(4� ���$������ ��	�����
�	(&;� Add ����������/(����
��� 

 

4) "
#�	��	$������ W350X250X69 �
�	�(&;� Add "�#%�"
#�	$������������
��$��
�	(&;� Close 
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5) �������1(�#�	���*�$��������%"
#�	�� assign �$� member ����"�
 ��������������� 

"
#�	$��������	��$����� Properties (W300X200X56) 

����/��(&;� Use Cursor to Assign �/	"
#�	"(4��0� Assign ��/� 

�
�	(&;� Assign -�%���"���)"-��)��"(
�%��"(4��/(  

� �"���)"-��)1(�
�	��% member 1 �
� 3 

�&�����	
�����
�	��%(&;� Assign ��	����� $�#�	� Esc �����)���)� ".#%�$�&��������	�� assign 

 

 

6) � ��0�"��� assign $��������%��� W350X250X69 �$�	�� member 2 "�#%�"�����
���"�
��"(4�����/( 

 

7) "�#%������������$�"��(3� property label ����
�	����.#����%�/(=�. "�#%�"��/"(3��������$�"
#�	 
Labels… ��	����"�#%�$����������������$�"
#�	 None ��	������ Properties �
��
�	 OK 

"�����
��$� Save ����/
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1.5  �
�&��������������� 

��	��	*�$�������,"-���� member �����		������ �$��������"(4� -�. �����%��"(4� "��� 
�*���%���%� �"(
�%��$����#� 

 

UNIT  CM  MTON 

 

1) ".#%�"(
�%��$����$��
�	1���� Input Units ���/
���)������: 

 

$�#����"
#�	��	"��/ Tools > Set Current Input Unit "�#%���$��������������$��
�	"
#�	$������
��"(4�"-���"����
��
�	 OK 
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1.6  �"������'�(�������$����� 

"�#%����	���"���) 2 �� ������������#����� ��������$���2������"������������� 1��� �����
��$���@/��)	
�� "��������� ����1��"(�������1�����	*�$����,"-� member 2 ���/	 OFFSET ��%�&� 
START 1( 15 cm ����	��� X �
� 0.0 �
� 0.0 ����	��� Y �
� Z ��"
�"���	����,"-���%
(
�� END "(4����
� 15 cm �*���%� STAAD ��%� ��#� : 

 

MEMBER OFFSET 

2  START 15  0  0 

2  END  -15  0  0 

 

1) "�#%����	"���/��� member 2 ���/	��,"-� �$�"��%���	"
#�	 member 	������	���
�	��% member 2 

��� Beam cursor  member ��%�/	"
#�	���/	1C1
�)���� 

2) ��	��������,"-���� member �$��
�	1���� Specification Page ���/
���)���&� 

 

$�#�����
�	"
#�	$��� General > Spec ��	����������-������$�������=�.$
�	 

3) $����� Specification ������������ ������/(����
��� �$��
�	��%(&;� Beam 

 

4) "�#%�$����� Beam Specs �����������$�"
#�	��� Offset ".#%�	*�$����,"-���% node "��%������
��@��� X ������ 15 
��� ������ �
�	�(&;� Add 
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5) �*�������� 3 �
� 4 -�*� ���"
#�	 End �
������� -15 �� ��� X ��1�����	��������/(����
���  

 

6) Assign ����������	���$��	����$���"
� 2 ������/(����
��� 

 

�
�	��%��?��=�.".#%�"��1C1
�)��	 �
� Save ��� 
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1.7  �"������������� 

��	�/(��������� ���&���������% node 1 "(4���� FIXED �
���% node 4 "(4���� PINNED  

SUPPORTS 

1  FIXED  ;  4  PINNED 

1) ".#%�������&������� �
�	1���� Support Page ��%�/
���)���&� 

 

$�#����"
#�	$��� General > Support ��	����-������$����� 

2) $����� Supports ������������ �
�	(&;� Create ".#%�������&���������� Fixed �
�	�(&;� Add 
��	����	��������� Pinned ����������/(����
��� 

 

3) �
�	"
#�	 S2 �&���������� FIXED �
�"
#�	 Use Cursor To Assign �
�	(&;� Assign �
�"
#�	
�
�	��% node 1 "�����
� Assign S3 �&���������� PINNED �$��	� node 4 ����0�"���	�� ��"�
��
	
��"(4�����/( 
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1.8  ����	����+� 3D 

"����
������=�.��"�
���������� ����
�	����=�.���
�"
#�	"��/ Structure Diagrams $�#�
"
#�	"��/ View > Structure Diagrams ����$��������������� 

 ��	��� 3D Sections �$�"
#�	������� Full Section �
����"
#�	��$�#�"������1�� "����
�
��
�	 OK 
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 1.9  �"�����,"��������-�� 

�*�$��������������� ����*�$��	����&	��/�$����� ����*���%�����
��� 
 

UNIT METER MTON 

 

LOAD 1 LOADTYPE None  TITLE DEAD LOAD 

SELFWEIGHT Y -1 

MEMBER LOAD 

2 UNI GY -1 

 

LOAD 2 LOADTYPE None  TITLE LIVE LOAD 

MEMBER LOAD 

2 UNI GY -2 

 

LOAD 3 LOADTYPE None  TITLE WIND LOAD 

JOINT LOAD 

2 FX 5 

 

LOAD COMB 4 1.2DL+1.6LL 

1 1.2 2 1.6 

 

LOAD COMB 5 0.75[DL+LL+W] 

1 0.75 2 0.75 3 0.75 

 

1) 	����������*�$��	����&	 "����"(
�%��$��������"(4� ���� 	�������
�	1����  

2) ".#%��������*�$��	����&	 �
�	1���� Load Page ��%�/
���)���&�  

$�#����"
#�	$��� General > Load ��	����-������$����� 

3) "�#%�$����� Load �����������$��
�	"
#�	 Load Cases Details �
��
�	(&;� Add ".#%�"��%������
��*�$��	����&	�$�� 
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4) ��$�������%�����������$�"
#�	 Primary �� ��� Loading Type �$�"
#�	 None��� #%���*�$��	
����&	"(4� DEAD LOAD 	� Add �
�	�(&;� Close 

��*�$��	����&	��%�/	����������$����(��	>�� ����$�"
#�	��������������� 

  

���1("�#%�����*�$��	$
��(��"=�	�������"
#�	1����	�/
���)��� 

5) ��$����� Load �$��
�	"
#�	���	�� DEAD LOAD ��%".�%��������$�� �
��
�	(&;� Add… 

 

6) $������� Add New : Load Items "
#�	 Selfweight ����@��� Y -1 �
�	(&;� Add 

7) "
#�	 Member Load > Uniform Force ".#%������*�$��	����&	
� member "�#%�$���������������
�$�"
#�	��� Uniform Force 	*�$����@��� GY �
���� -1 �
�	�(&;� Add �
������� Close  

 

��	���	����%����".�%������� �*�$��� Selfweight "(4���*�$��	��"�����������
�����/��
� ���1������ 
Assign ��	 ������	�� Uniform load ���"(4�"��#%��$����*���� ? ��/�  

 

�
�	��%���	���
� Assign �$����$���"
���� "��#%��$����*������$��1( 

 



STAAD.Pro 2005 : Tutorial 1 1 - 17 

 

 

5) ����� Load case �$�� ���� ��0�	��"���"(4� Load case 2 ���� #%��� LIVE LOAD 

6) $������� Add New : Load Items "
#�	 Member Load > Uniform Force ".#%������*�$��	����&	

� member "�#%�$����������������$�"
#�	��� Uniform Force 	*�$����@��� GY �
���� -2 �
�	�
(&;� Add �
������� Close �
� Assign �$����$���"
����" ��"��� 

7) ����� Load case �$�� ���� ��0�	��"���"(4� Load case 3 ���� #%��� WIND LOAD 

8) $������� Add New : Load Items "
#�	 Nodal Load > Node ������ Fx = 5 Mton �
�	(&;� Add 
������(&;� Close �
� Assign �$��&����$���"
� 2 
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7) ".#%������ Load Case 3 -�%�"(4� Load combination �#� 1.2DL+1.6LL �
�	"
#�	 Load Cases 

Details �
��
�	(&;� Add…  

8) ��$����� Add New : Load Cases "
#�	 Define Combinations �*�$��� Load No. 4 ���� #%��� 
1.2DL+1.6 ������ ai = 1.2 �
�	"
#�	 DEAD LOAD ��	���	�� Available Load Cases ���

����-����
�	�(&;�  ".#%�"
#�	"����������	����������� 

 
9) �
�	"
#�	 LIVE LOAD ���� ���� ai = 1.6 �
��
�	����"������	����������� 

 

10) "�����
��
�	(&;� Add $����������� Load case 5 �$�������� �$�	��	���1( 

11) �*�$��� Load No. 5 ���� #%��� 0.75[DL+LL+W] ������ ai = 0.75 �
�	(&;�  ".#%������&	���	��
"�#%����	� �����,	"���)"���	�� "�����
��
�	(&;� Add 
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���	����$����� Load ��"(4�������/(����
��� 

 

1.10  �"����/�����������������$ 

 ������	���"����$)��%����	���#��������" ��"��� �
�����	������������=���������&
��� �*���%���%
� ��#� : 

PERFORM ANALYSIS PRINT STATICS CHECK 

STEP : 

1) 	*�$�� ���	���"����$)���1(��%$��� Analysis/Print �
��
�	��� Analysis ����������/( 
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2) "
#�	 Print Option "(4� Statics Check �
�	 Add �
������� Close 

1.11  �"�����"�����0��0$���������������$ 
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"������	�������%(
�� member �
���%�&������� ��1,
) Output -�%��*�1������ ��*���%� 
 

PRINT MEMBER FORCES ALL 

PRINT SUPPORT REACTION LIST 1 4 

STEP : 

1) 	*�$�� ���	���"����$)���1(��%$��� Analysis/Print �
��
�	��� Post-Print  

2) "
#�	�&	 member ���� �"����)��	��������"�
 �
��
�	(&;�  

3) "�#%�$����� Analysis/Print Commands (��	>�����$�"
#�	��� Member Forces �
�	 Assign 
�
������� Close 

4) �
�	"
#�	��� Support Reactions �
��
�	 Add ������(&;� Close 

5) �
�	"
#�	���	�� PRINT SUPPORT REACTION �
� Assign �$��&�����������$�� 

��$����� Post Analysis Print ����
�	5+�������/(����
��� 

 

 1.12 �"�����������,"��������-���01��+/�+���������� 

	����	������������"$
�	���*��*�$��� load case 4 �
� 5 	����	�(��	���$�"
#�	�*����� ��*���%� : 
 

LOAD LIST 4 5 

STEP: 

1) "
#�	"��/ Command > Loading > Load List… 

2) $����� Load List ��(��	>������ "
#�	 load case 4 �
� 5 �
�	����"��� Load List �
�	� OK 
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1.13 �"����0���������$������������2� 

�*���%���%� ��#� 

PARAMETER 

CODE AISC 

FYLD 25000 MEMB 1 TO 3 

UNT 5.7 MEMB 2 

UNB 5.7 MEMB 2 

TRACK 2 MEMB 2 

SELECT MEMB 2 

STEP: 

1) ".#%�	*�$�����.�����"���)��	��� 1(��%$��� Design > Steel �
�"
#�	 AISC ASD �� ��� 
Current Code ��$���������������#� 
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2) �
�	(&;� Define Parameters… 

3) ��$����� Design Parameter "
#�	$���� FYLD 	*�$��	*�
�����	"(4� 25000 Mton/m
2
 �
�	� 

Add 

 

4) 	*�$��������(��#%�"$�#��������% 3 ������ 
UNT 5.7 

UNB 5.7 

TRACK 2 

5) "�#%�"�����
��$��
�	 Close $����� Design Parameters 

6) �������1(�#�	�� assign .�����"���)"$
������$� member ����� assign ��� FYLD �$��&	 member 

���.�����"���)��%"$
#��� assign �$�"6.�� member 2 �$��
�	"
#�	�0� assign "(4� Use Cursor to 

Assign $
����	 assign .�����"���)�&	���
� $����� Steel Design ��"(4�������/(����
��� 
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7) ".#%�	*�$���*���%� SELECT �
�	(&;� Command �*���%� SELECT ���$��(��	��"
#�	$��������%"��
��%�&���%"(4�1(������	*�$�� 

8) ��$����� Design Command ��%(��	>�������$�"
#�	��� Select �
��
�	(&;� Add �
������� 
Close 

 

9) "��D��
��$� assign �$�	�� member 2 ���� � Use Cursor to Assign $�#�"
#�	 member 	����
�
"
#�	 Assign to Selected Beams 

1.14  �"�����"�������������$�&����,� 

"�#%��(��	���*�	���*��+�
���	������"
#�	 member �����%"����%�1���$������%�
� �&+�������$��
���/	 assign �$� member "$
������ �*��$�	��	��������,"��������������"(
�%��1( "����������*�	��
�"����$)-�*� ".#%��$�1������"�
#%������� node, ����� member �
��#%�? ���	��	��������,"���$�� 
�*���%���%� ��#� : 

PERFORM ANALYSIS 

�
�	"
#�	����������� Analysis/Print > Analysis ��$����� Analysis Commands ��%(��	>������
�$�"
#�	��� Perform Analysis "�#%����	"��1������	�����������&
�����
� �$��
�	"
#�	 No Print 
�
��
�	 Add ������ Close �������	�� PERFORM ANALYSIS �����%�������������$
���*���%� 
SELECT ������/( 
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1.15  �"����0���������$ TRACK �&����,� 

��	���*��+�&�����"������	���$�������� &���� member ��%"
#�	���+����2������	*�$�� �������� 

member ��%"(
�%���$��$�#�1��? �*��$�"���������������	*�$����	�� �*���%���%� ��#� : 
 

TRACK  1  ALL  

STEP: 

1) ".#%�	*�$��.�����"���) TRACK "(4� 1 �$��*�-�*�������% 1 ��� 4 ���$���� 1.13 

2) ��	����"
#�	 member ����$������ �"����)��	��� �
� assign �$��&	 members 

1.16  �"����(,"��"����� CHECK CODE 

	���*��+�"����$)�������������*���%���$���� 1.14 ���$������ member  &��$�� -�%�����	����1(
"
�	������	��%� ���	��"
#�	$������ �������"����������������/�����������(
��=��$�#�1�����
���	*�$�� ����������������	*�$�� �*���%��#� : 

 

CHECK  CODE  ALL  

STEP: 

1) �
�	(&;� Command ��$����� Steel Design "
#�	��� Check Code �
��
�	(&;� Add �
����
��� Close 
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2) "�#%����	�*���%� CHECK CODE ���� assign �$��&	 member �0�	����%������%�&��#� �
�	(&;� Assign 

to View 

1.17  ������������$����34�����"���# 

"
#�	"��/ Analyze > Run Analysis… �
��
�	(&;� Run Analysis ".#%�"��%�	���*��+ 

 

���1�������2��.
�� 0 Error(s), 0 Warning(s) �$��
�	"
#�	 View Output File �
�	�(&;� Done 
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�������	
�� : 

STAAD PLANE 

START JOB INFORMATION 

ENGINEER DATE 14-Jun-06 

END JOB INFORMATION 

INPUT WIDTH 79 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 4 0; 3 6 4 0; 4 6 0 0; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 

DEFINE MATERIAL START 

ISOTROPIC STEEL 

E 2.09042e+007 

POISSON 0.3 

DENSITY 7.83341 

ALPHA 1.2e-005 

DAMP 0.03 

END DEFINE MATERIAL 

MEMBER PROPERTY KOREAN 

1 3 TABLE ST W300X200X56 

2 TABLE ST W350X250X69 

CONSTANTS 

MATERIAL STEEL MEMB 1 TO 3 

UNIT CM MTON 

MEMBER OFFSET 

2 START 15 0 0 

2 END -15 0 0 

SUPPORTS 

1 FIXED 

4 PINNED 

UNIT METER MTON 

LOAD 1 LOADTYPE None  TITLE DEAD LOAD 

SELFWEIGHT Y -1 

MEMBER LOAD 

2 UNI GY -1 

LOAD 2 LOADTYPE None  TITLE LIVE LOAD 

MEMBER LOAD 

2 UNI GY -2 

LOAD 3 LOADTYPE None  TITLE WIND LOAD 

JOINT LOAD 

2 FX 5 

LOAD COMB 4 1.2DL+1.6LL 

1 1.2 2 1.6 

LOAD COMB 5 0.75[DL+LL+W] 

1 0.75 2 0.75 3 0.75 

PERFORM ANALYSIS PRINT STATICS CHECK 

PRINT MEMBER FORCES ALL 

PRINT SUPPORT REACTION LIST 1 4 
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LOAD LIST 4 5 

PARAMETER 

CODE AISC 

FYLD 25000 ALL 

UNB 5.7 MEMB 2 

UNT 5.7 MEMB 2 

TRACK 2 MEMB 2 

SELECT MEMB 2 

PERFORM ANALYSIS 

PARAMETER 

CODE AISC 

TRACK 1 MEMB 2 

CHECK CODE ALL 

FINISH 

����	���� : Member Forces 

 

   MEMBER END FORCES    STRUCTURE TYPE = PLANE 

   ----------------- 

   ALL UNITS ARE -- MTON METE 

  MEMBER  LOAD  JT     AXIAL   SHEAR-Y  SHEAR-Z   TORSION     MOM-Y      MOM-Z 

      1    1     1      3.21     -0.53     0.00      0.00      0.00      -0.41 

                 2     -2.98      0.53     0.00      0.00      0.00      -1.71 

           2     1      5.57     -0.99     0.00      0.00      0.00      -0.77 

                 2     -5.57      0.99     0.00      0.00      0.00      -3.21 

           3     1     -1.86      3.83     0.00      0.00      0.00       8.85 

                 2      1.86     -3.83     0.00      0.00      0.00       6.48 

           4     1     12.76     -2.23     0.00      0.00      0.00      -1.72 

                 2    -12.49      2.23     0.00      0.00      0.00      -7.19 

           5     1      5.19      1.73     0.00      0.00      0.00       5.76 

                 2     -5.02     -1.73     0.00      0.00      0.00       1.17 

  

      2    1     2      0.53      2.98     0.00      0.00      0.00       1.27 

                 3     -0.53      3.12     0.00      0.00      0.00      -1.66 

           2     2      0.99      5.57     0.00      0.00      0.00       2.37 

                 3     -0.99      5.83     0.00      0.00      0.00      -3.10 

           3     2      1.17     -1.86     0.00      0.00      0.00      -6.20 

                 3     -1.17      1.86     0.00      0.00      0.00      -4.39 

           4     2      2.23     12.49     0.00      0.00      0.00       5.32 

                 3     -2.23     13.06     0.00      0.00      0.00      -6.95 

           5     2      2.02      5.02     0.00      0.00      0.00      -1.92 

                 3     -2.02      8.10     0.00      0.00      0.00      -6.86 

  

      3    1     3      3.12      0.53     0.00      0.00      0.00       2.12 

                 4     -3.34     -0.53     0.00      0.00      0.00       0.00 

           2     3      5.83      0.99     0.00      0.00      0.00       3.97 

                 4     -5.83     -0.99     0.00      0.00      0.00       0.00 

           3     3      1.86      1.17     0.00      0.00      0.00       4.67 

                 4     -1.86     -1.17     0.00      0.00      0.00       0.00 
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           4     3     13.06      2.23     0.00      0.00      0.00       8.91 

                 4    -13.33     -2.23     0.00      0.00      0.00       0.00 

           5     3      8.10      2.02     0.00      0.00      0.00       8.07 

                 4     -8.27     -2.02     0.00      0.00      0.00       0.00 

 

����	���� : Support Reactions 

 

   SUPPORT REACTIONS -UNIT MTON METE    STRUCTURE TYPE = PLANE 

   ----------------- 

  

 JOINT  LOAD   FORCE-X   FORCE-Y   FORCE-Z     MOM-X     MOM-Y     MOM Z 

  

 

      1    1      0.53      3.21      0.00      0.00      0.00     -0.41 

           2      0.99      5.57      0.00      0.00      0.00     -0.77 

           3     -3.83     -1.86      0.00      0.00      0.00      8.85 

           4      2.23     12.76      0.00      0.00      0.00     -1.72 

           5     -1.73      5.19      0.00      0.00      0.00      5.76 

      4    1     -0.53      3.34      0.00      0.00      0.00      0.00 

           2     -0.99      5.83      0.00      0.00      0.00      0.00 

           3     -1.17      1.86      0.00      0.00      0.00      0.00 

           4     -2.23     13.33      0.00      0.00      0.00      0.00 

           5     -2.02      8.27      0.00      0.00      0.00      0.00 

 

����	���� : Steel Design #1 

 

                     STAAD.PRO MEMBER SELECTION - (AISC 9TH EDITION) 

                     *********************************************** 

  |--------------------------------------------------------------------------| 

  |                                                    Y        PROPERTIES   | 

  |*************                                       |        IN  CMS UNIT | 

  |            *  |=============================|   ===|===     ------------ | 

  |MEMBER   2  *  |  KOREAN SECTIONS            |      |        AX =  85.20  | 

  |            *  | ST  W12-12X8X45             |      |   --Z  AY =  24.87  | 

  |DESIGN CODE *  |                             |      |        AZ =  40.05  | 

  | AISC-1989  *  ===============================   ===|===     SY = 203.92  | 

  |            *                                                SZ = 954.25  | 

  |            *  |<---LENGTH (M)=     5.70 --->|               RY =   4.94  | 

  |*************                                                RZ =  13.09  | 

  |                                                                          | 

  |                118.4 (KNS-METRE)                                         | 

  |PARAMETER        |               L4  L4                      STRESSES     | 

  |IN KNS  CMS      |                       L4                  IN NEWTON MMS| 

  |---------------  +                                           -------------| 

  | KL/R-Y= 115.36  |                                           FA  =  76.48 | 

  | KL/R-Z=  43.54  +           L4                              fa  =   2.56 | 

  | UNL   = 570.00  |                           L4          L4  FCZ = 135.47 | 
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  | CB    =   1.00  +                                           FTZ = 147.09 | 

  | CMY   =   0.85  |L4     L5                                  FCY = 183.87 | 

  | CMZ   =   0.85  +   L5                                      FTY = 183.87 | 

  | FYLD  =  24.52  |                               L4  L5      fbz = 124.09 | 

  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 

  | DFF   =   0.00  27.3                                        Fey =  79.32 | 

  | dff   =   0.00               ABSOLUTE MZ ENVELOPE           Fez = 556.73 | 

  |                                 (WITH LOAD NO.)             FV  =  98.06 | 

  |                                                             fv  =   1.13 | 

  |                                                                          | 

  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 

  |                      -------------------------                           | 

  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 

  |                                                                          | 

  |      VALUE      21.8       128.1        0.0         0.0       118.4      | 

  |   LOCATION       0.0         5.7        0.0         0.0         2.9      | 

  |    LOADING         4           4          0           0           4      | 

  |                                                                          | 

  |**************************************************************************| 

  |*                                                                        *| 

  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 

  |*                         --------------                                 *| 

  |*                                                                        *| 

  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 

  |         FX              MY             MZ           LOCATION             | 

  |        ======================================================            | 

  |          PASS        AISC- H1-3       0.949              4               | 

  |         21.83 C          0.00      -118.41             2.85              | 

  |*                                                                        *| 

  |**************************************************************************| 

 

����	���� : Steel Design #2 

 

                       STAAD.PRO CODE CHECKING - (AISC 9TH EDITION) 

                       ******************************************** 

  |--------------------------------------------------------------------------| 

  |                                                    Y        PROPERTIES   | 

  |*************                                       |        IN  CMS UNIT | 

  |            *  |=============================|   ===|===     ------------ | 

  |MEMBER   1  *  |  KOREAN SECTIONS            |      |        AX =  72.40  | 

  |            *  | ST  W300X200X56             |      |   --Z  AY =  21.98  | 

  |DESIGN CODE *  |                             |      |        AZ =  32.05  | 

  | AISC-1989  *  ===============================   ===|===     SY = 160.00  | 

  |            *                                                SZ = 768.71  | 

  |            *  |<---LENGTH (M)=     4.00 --->|               RY =   4.70  | 

  |*************                                                RZ =  12.49  | 

  |                                                                          | 

  |                 77.6 (KNS-METRE)                                         | 
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  |PARAMETER        |                                       L4  STRESSES     | 

  |IN KNS  CMS      |                                   L4      IN NEWTON MMS| 

  |---------------  +                                           -------------| 

  | KL/R-Y=  85.09  |                               L4          FA  = 101.85 | 

  | KL/R-Z=  32.02  +L5                                         fa  =  16.88 | 

  | UNL   = 400.00  |   L5                      L4              FCZ = 147.09 | 

  | CB    =   1.00  +       L5              L4                  FTZ = 147.09 | 

  | CMY   =   0.85  |           L5                              FCY = 183.87 | 

  | CMZ   =   0.85  +               L5                          FTY = 183.87 | 

  | FYLD  =  24.52  |                   L4                      fbz = 100.95 | 

  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 

  | DFF   =   0.00  27.1                                        Fey = 145.80 | 

  | dff   =   0.00               ABSOLUTE MZ ENVELOPE           Fez =1029.69 | 

  |                                 (WITH LOAD NO.)             FV  =  98.06 | 

  |                                                             fv  =  10.88 | 

  |                                                                          | 

  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 

  |                      -------------------------                           | 

  |                                                                          | 

  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 

  |                                                                          | 

  |      VALUE     124.9        23.9        0.0         0.0        77.6      | 

  |   LOCATION       0.0         0.0        0.0         0.0         4.0      | 

  |    LOADING         4           4          0           0           4      | 

  |                                                                          | 

  |**************************************************************************| 

  |*                                                                        *| 

  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 

  |*                         --------------                                 *| 

  |*                                                                        *| 

  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 

  |         FX              MY             MZ           LOCATION             | 

  |        ======================================================            | 

  |          PASS        AISC- H1-2       0.801              4               | 

  |        122.20 C          0.00        77.60             4.00              | 

  |*                                                                        *| 

  |**************************************************************************| 

 

                       STAAD.PRO CODE CHECKING - (AISC 9TH EDITION) 

                       ******************************************** 

  |--------------------------------------------------------------------------| 

  |                                                    Y        PROPERTIES   | 

  |*************                                       |        IN  CMS UNIT | 

  |            *  |=============================|   ===|===     ------------ | 

  |MEMBER   2  *  |  KOREAN SECTIONS            |      |        AX =  85.20  | 

  |            *  | ST  W12-12X8X45             |      |   --Z  AY =  24.87  | 

  |DESIGN CODE *  |                             |      |        AZ =  40.05  | 

  | AISC-1989  *  ===============================   ===|===     SY = 203.92  | 

  |            *                                                SZ = 954.25  | 

  |            *  |<---LENGTH (M)=     5.70 --->|               RY =   4.94  | 
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  |*************                                                RZ =  13.09  | 

  |                                                                          | 

  |                110.6 (KNS-METRE)                                         | 

  |PARAMETER        |               L4  L4                      STRESSES     | 

  |IN KNS  CMS      |                       L4                  IN NEWTON MMS| 

  |---------------  +                                           -------------| 

  | KL/R-Y= 115.36  |                                           FA  =  76.48 | 

  | KL/R-Z=  43.54  +           L4                          L4  fa  =   2.81 | 

  | UNL   = 570.00  |L4                         L4              FCZ = 135.47 | 

  | CB    =   1.00  +       L5                                  FTZ = 147.09 | 

  | CMY   =   0.85  |                                           FCY = 183.87 | 

  | CMZ   =   0.85  +   L5                              L5      FTY = 183.87 | 

  | FYLD  =  24.52  |                               L4          fbz = 115.87 | 

  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 

  | DFF   =   0.00  20.8                                        Fey =  79.32 | 

  | dff   =   0.00               ABSOLUTE MZ ENVELOPE           Fez = 556.73 | 

  |                                 (WITH LOAD NO.)             FV  =  98.06 | 

  |                                                             fv  =   1.21 | 

  |                                                                          | 

  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 

  |                      -------------------------                           | 

  |                                                                          | 

  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 

  |                                                                          | 

  |      VALUE      23.9       128.2        0.0         0.0       110.6      | 

  |   LOCATION       0.0         5.7        0.0         0.0         2.9      | 

  |    LOADING         4           4          0           0           4      | 

  |                                                                          | 

  |**************************************************************************| 

  |*                                                                        *| 

  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 

  |*                         --------------                                 *| 

  |*                                                                        *| 

  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 

  |         FX              MY             MZ           LOCATION             | 

  |        ======================================================            | 

  |          PASS        AISC- H1-3       0.892              4               | 

  |         23.92 C          0.00      -110.57             2.85              | 

  |*                                                                        *| 

  |**************************************************************************| 

                       STAAD.PRO CODE CHECKING - (AISC 9TH EDITION) 

                       ******************************************** 

  |--------------------------------------------------------------------------| 

  |                                                    Y        PROPERTIES   | 

  |*************                                       |        IN  CMS UNIT | 

  |            *  |=============================|   ===|===     ------------ | 

  |MEMBER   3  *  |  KOREAN SECTIONS            |      |        AX =  72.40  | 

  |            *  | ST  W300X200X56             |      |   --Z  AY =  21.98  | 

  |DESIGN CODE *  |                             |      |        AZ =  32.05  | 

  | AISC-1989  *  ===============================   ===|===     SY = 160.00  | 
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  |            *                                                SZ = 768.71  | 

  |            *  |<---LENGTH (M)=     4.00 --->|               RY =   4.70  | 

  |*************                                                RZ =  12.49  | 

  |                                                                          | 

  |                 95.7 (KNS-METRE)                                         | 

  |PARAMETER        |L4                                         STRESSES     | 

  |IN KNS  CMS      |   L4                                      IN NEWTON MMS| 

  |---------------  +           L4                              -------------| 

  | KL/R-Y=  85.09  |               L4                          FA  = 101.85 | 

  | KL/R-Z=  32.02  +                                           fa  =  17.71 | 

  | UNL   = 400.00  |                       L4                  FCZ = 147.09 | 

  | CB    =   1.00  +                                           FTZ = 147.09 | 

  | CMY   =   0.85  |                           L4              FCY = 183.87 | 

  | CMZ   =   0.85  +                               L4  L4      FTY = 183.87 | 

  | FYLD  =  24.52  |                                       L0  fbz = 124.45 | 

  | NSF   =   1.00  +---+---+---+---+---+---+---+---+---+---|   fby =   0.00 | 

  | DFF   =   0.00  -5.3                                        Fey = 145.80 | 

  | dff   =   0.00               ABSOLUTE MZ ENVELOPE           Fez =1029.69 | 

  |                                 (WITH LOAD NO.)             FV  =  98.06 | 

  |                                                             fv  =  10.88 | 

  |                                                                          | 

  |                      MAX FORCE/ MOMENT SUMMARY  (KNS-METRE)              | 

  |                      -------------------------                           | 

  |                                                                          | 

  |                AXIAL      SHEAR-Y    SHEAR-Z    MOMENT-Y    MOMENT-Z     | 

  |                                                                          | 

  |      VALUE     130.9        23.9        0.0         0.0        95.7      | 

  |   LOCATION       4.0         0.0        0.0         0.0         0.0      | 

  |    LOADING         4           4          0           0           4      | 

  |                                                                          | 

  |**************************************************************************| 

  |*                                                                        *| 

  |*                         DESIGN SUMMARY  (KNS-METRE)                    *| 

  |*                         --------------                                 *| 

  |*                                                                        *| 

  |*       RESULT/     CRITICAL COND/     RATIO/         LOADING/           *| 

  |         FX              MY             MZ           LOCATION             | 

  |        ======================================================            | 

  |          PASS        AISC- H1-2       0.966              4               | 

  |        128.22 C          0.00        95.66             0.00              | 

  |*                                                                        *| 

  |**************************************************************************| 
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1.18 Post-Processing 

STAAD.Pro �����������	��
����
�������������� �������������� Post-Processing  

������ �!"#���$ �����%������������&���!�$ : 

• ������'��(
���
����� 

• ��������%��)�����!��
�  

• ������'��(��������%�&* 

• %!������
���(���+��
�������'��(��������%�&* 

• �������!��
� ��'��( 

• ����+��+�����*����� 

1.19 ��������	
� Post-processing 

STEP: 

1) �&�� ���+�� 1.17 %�����, �(-��!��� Post-processing ������&������
���(%�����* �������
.&��
�(-����%!/���
���)���(
%�)�
���� Post-processing  ��� ��* �0� ��)���
%�� Mode ������!
+������� 

 

 
 

2) ����� Result Setup ������+1$�� ���%�)�
 load case ���&���
�������� ���%�)�
 Load 4 : 

1.2DL+1.6LL ��� Load 5 : 0.75[DL+LL+W]  ������(
 OK 

���%
&����	 ���+���+�� Page control ��%!�����!%!/2"�3�� post processing 
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Page Control in 

Post-Processing Mode 

 
%�� ��*
.%!�����!%3�
� 

 

1.20 ����������������� 

STEP: 

&��$�������%!/������!+������� 
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��'��(�������������%!/
��%��)��&��+�� Load 4 3)����%+����������������+����!'�, 	��%���!����)�����
���
��
�� ��'�,�$���%�)�
 Node > Displacement ��
+� ��!���4��� 

 
 


����������%��)��&��!��
� '�,���������%�)�
%�� Result > View Value… 

��
������������+1$�� ���%�)�
�	  Ranges ����%�)�
 All nodes  
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��(
%�)�
�	  Node ����%�)�
 Resultant 41����%!/��������
��������+������&���
 X, Y ��� Z 

��(
!05� Annotate ��%�.������� ��%�� ��(
 Close %,)��!6������ 

 

��!+�������������%����
����������%��)��&����
 Load 4 

���&���!�� �%
�
�������� �����(
%���!05�+�� %�)�
 Label… ������(
�	  Scales !��  
Displacement scales &������%������ 
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���%
&����������+1$��
� ����&���� Node Displacements ������4��� Node 2 ��� 3 � L/C 4 �
����� Resultant ��%!/&��%�+���	�
����+1$�� 

 

���	�����!%
. ��� %,)���3�����������  ��
�$%!�����!������� Load 5  

 

����� Node Displacement ������!+������� ���	�����!%
. ���%3�
� 
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������ Node Displacement �����	 ��������� ���%�)�
����	 �)� All ��� Summary ���
��(
�	  Summary ���������
��%��)��&����
����0����
���(���&��� ��������
����0���	�
%�%!/&��
%+������������!+������� 

 

��
���������������+����%!/ Beam Displacement �����	  All Relative Diaplacement ��
����
��%��)��&���������&���7 �&��� Beam  
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%�)����(
�	  Max Relative Displacements ����������%��)��&����
����0���&��� Beam  

 

�&��������������%��)��&����
����0����&���������%
(�+1$ ���*����� �
��
�$�������
��&�����&������������*����� 

1.21 ���������������� ������! 

��(
%�)�
�	 ���(�����+��� Node > Reactions 
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Support Reactions Table 

!��
� ��������	 �)� All, Summary ��� Envelope 

All : �	 �$���������!8(
(�(������0������ ������ �0

�9� ���0
 

 

Summary : �	 �$���������
����0�����������0� +�����!8(
(�(������0������ ������ �&�����
���(��� 

��������
����0���	�
%�%!/&��%+�� 

 

Envelope : &�����$���������
����0�����������0�+�����!8(
(�(���0������ ���
���(���&���7 �����
�� 0������������������$%
(�+1$��

�9� ���0
�� 
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1.22 ����"�#$
����/�
�
��& 

��(
%�)�
�	 ���(�����+��� Beam > Forces ����%�)�

�9� ���0
�������%!/ Load 4 ������!
+������� 

 

��)����%�)�
��
%�� Result > Bending Moment 

1.23 ����'�!��"�#$
����/�
�
��& 

%�)�
%�� Result > View Value… %�)�������������+1$�� ��(
�	  Ranges ����%�)�
 All 

%�)�
�	  Beam Results ��(
 Ends ��� Midpoint ������  Bending ��(
 Annotate ���� Close 
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1.24 ����������������(�	��!���������"�#$
���� 

��'��(+����������%�&*�����	%+�������$���� 6 ��
���(�������
� Axial, Shear-Y, Shear-Z, 

Torsion, Moment-Y, Moment-Z %�������	%�)�
��
��%�����$�����
��� ��*��� �)� 

 

41��%�������	%�)�

�������������
 ��������	����������
�����,����
���
���� 

 



STAAD.Pro 2005 : Tutorial 1 1 - 44 

 

��)�%�����%�)�
��
%�� View > Structure Diagrams > Loads and Results ���%�)�
 Load Case 

5 : 0.75[DL+LL+W] ��� Shear yy �����! 

��
�$���%�)�
%�� Results > View Value… ��	  Range %�)�
 All ��� 

�	  Beam Results %�)�
�
�0��+�� Shear %�)�
 Ends 

 

 

1.25 ���������'����������� 

&���� Beam End Forces ������ ������+�� ������������&���7���!�����$����+���&����� 
!��
� ��������	 �)� All, Summary ��� Envelope 

All : �������!����������� �0
���*���������0

�9� ���0
���	�
%�)�
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Summary : ���������
����0�����������0�+���&�����
���(���+���0
������0

�9� ���0
 

 

Envelope : ������� �
��
����0� +ve ������� ��
����0� –ve �������
�9� ���0
�����������
����0�

��
� ������� 

 

1.26 ���������'����)���� 

&���� Beam Forces Detail ����������������+�� ������������&���7���!�����$����+���&����� 
!��
� ��������	 �)� All, Summary ��� Envelope 

All : �������!����������� �0
���*���������0

�9� ���0
���	�
%�)�
 �������&���7 
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Max Axial Forces, Max Bending Moments and Max Shear Forces ���������
����0�+�����
'���%�����$������ �&������*��������
�9� ���0
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1.27 	�'�����)���� 

��(
%�)�
�	 ���(�����+��� Beam > Stresses %,)����������������� �������	
�����	�����
������	�������������������������������������� 

 

���������	������������������������� 
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����
����������
����������	
������������ ���
���
���	������ !���������
��"���������������#��

�������������������� ����$��%�����
����
#��#&��'( � ���)(������	��������������������
������������	��(�*���'(#��
�����������
��%� 

 

�����������
 Select Profile Point 	��*���#������� local Y ��� Z ��������� � ���*	+��"����� (0,0) 
�)�
,*�	+�-)��&%���
�������� %����
�����)�����������,*�	+���.��������� �����������,&��������� 	�����
�(/�	+���*���������$�
� Y Point ��� Z Point 	��(�*���'( ����������	�����
�)����������
�����
���������)(�������� 

 

�
��
�$��������(
3��� Display Legend %,)������������� �������&���	 �� ���3��� Display 

Corner Stress %,)��������������������0����&�� 

	��&���
�� ��1
�������������&����������+������ �����(
!05� Add Stress to Table 
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����&������
������4�������������������1�����������������������&���
� 

 

��+����'��(������������	%!����������%�)�
�	  Loads and Results ������ Diagrams ��

%�� View > Structure Diagrams 41�����!
&(��&�$��������������%!/����������������1�%!/��$��
%�( 

��������	�'������'�
����(���������
��������������� 

�*! All : ���������������
���������0���$����+�����&���������&���7&��
���� ������ �0

�9� ���0
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&������+���0���$�����)� 1, 2, 3, 4 �&����+1$
� 3(�+�����&����������&����+������� 

 

Max Stresses : &�����$����������������������������1���
����0������� �0
���*����� 
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1.28 ������"$�)+��(�	����� 

��(
%�)�
�	 ���(�����+��� Report %,)��%�(��&����������� �������	
 Report Setup 	������ !��� 

 

�*! Items : �3�
�������+����������������� ���
�� Available �������+����������%�)�
�����������
����!��%'��&�����3� ����)� Input, Output ��� Pictures ���
�� Input ��%!/+������������3����%+���! 
������
�� Output ��%!/����������

������9 ���
�� Pictures ��%!/��!���	���%�����41���������

�	  Picture Album 

%�)��%�)�
%��.����� ��(
!05� OK �������	�
�����+1$���&��������
��,(�,*���
:9� Print Preview 
	��&���
���
��+�����(
!05� Setup Report %,)��
�� ���
��+���� 

�*! Load Cases : �3�
����
�9� ���0
��������������� 
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�*! Modes : �3��
���(%�����*�  ,�;��&�* %,)��%�)�
��!�  
�����������&���
��������� 

�*! Ranges : ���
�������*��������&���
������ !
&(��%�)�
���%!/ All �&�%�����%�)�
�������
%<,�� �����*�������� 

�*! Picture Album : %!/��� �$���!'�,���	�
	���%
. %����� ���%�������	
����+��+��'�,�����
������� ���	1�%+��+�������-( ���&�'�,�3��� Caption 

 

�*! Options : �3�
�������%�)�
&���+�������%3� Header, Page Outline ��� Footer %�+������ 
��!�  &���� 
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�*! Name and Logo : �3����3)�� �(:��������
��������� ���%�������	,(�,*3)�� �(:�����!,����
%�)�
3(����+��2=��* ������
�&���%!/�2�*'�,3(� Windows Metafile (.wmf) ��)� .bmp 

 

 

�*! Load/Save : �3����%
. %)$������������3�
����%�� ���������������	�
%
. ���+1$�� 

�*! Steel Design : ������
����
�  %��.
�������9����������
���(%�����*������������� 
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Tutorial Problem 2 

RC Frame Structure 

���������	
������������	����������������������������� � STAAD.Pro �����"�#��$���%�����
&���
�������� 

- "��%�����(��	�� 

- 	���������"�
 

- ������&�����
����)����� 

- ����$���"
��&�����
���� 

- 	*�$���&+���������)����� 

- 	*�$����,������)��������� ��&�"���� 

- 	*�$���&������� 

- 	*�$����*�$��	����&	 

- 	*�$���-�	���"����$) 

- 	*�$��.�����"���)��	������	���"����"$
�	 

- �*�	���"����$)�
���	��� 

- �/01
)2
	���*��+ 

- ������2
��$����� �������	��13	�
���"
� 

- �����������2/�� �	*�$��"�� 
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2.1 ��������	
����� 

������������������"(4��������	������ �������������/(����
��� �����%�����*��#�	���������"�
 
	*�$�����(�����5��%����� � �*�	���"����$)�
���	������	��� 

 

2.2 ������	���� 

��(67$������"�
���"��"(4�������� �������"
#�	 ������������"(4� Space "
#�	 Meter "(4�$������
�� �
�"
#�	 Metric Ton "(4�$������ ��� #%�01
)�$�����"(4� rcframe 

 

3.5 m 

1 

2 

4 

3 

1 

2 

3 

5 

4 

5 

6 

6 m 

6 m Y 

X 

Z 
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2.3 ��������������������  

	��	*�$���&�����
����)����� �*���%���%� ��#� 

 

JOINT COORDINATES 

1 0 0 0 ; 2 0 3.5 0 

3 6 3.5 0 ; 4 6 0 0 

5 6 0 6 ; 6 6 3.5 6 

MEMBER INCIDENCE 

1 1 2 ; 2 2 3 ; 3 3 4 ; 4 5 6 ; 5 3 6 

 

STEP: 

1) $
����	�
�	"
#�	 Add Beam �
�	�(&8� Finish �(��	����"����/�$��� Geometry > Beam 

2) ��$����� Snap Node/Beam �������9��� �����������������%�� member 1 ��� 3 �
� node 1 ��� 
4 ��/�������� X-Y ��������$�"
#�	"(4������ Plane "(4� X-Y ��	��� Construction Lines ����
�*���"������������	� X 0� 12 �
�����	� Y 0� 7 ����$��� Spacing � � 0.5 "��� ������/( 
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3) ".#%�"��%������ nodes �$�"��%����	���
�	(&8� Snap Node/Beam ��%���
����&�������
�"
#%��"����)��
�
�	��%�&�	*�"��� (0, 0) ".#%�"��%������ node ��	 

4) ��	�����
�	��% node ���������(��	��������� element " #%������$������������� 

 (0, 3.5), (6, 3.5) �
� (6, 0) 

$
�	��	"�����
��$��
�	(&8� Snap Node/Beam ��	����� �����������%0����"(4�����/( 

 

5) �
�	(&8� Close ".#%�(3�	������	��� �
��
�	����.#����%��:�.�
�"
#�	"��/ Label… "�#%�$�����
�����������$�"
#�	 Node Numbers �
� Beam Numbers ".#%�����$���"
� 

6) ����������#�	������� members 4 �
� 5 9�%�����*�0�����	������� copy ��� members 1 �
� 2 
��	����$�&�������"�����%���%2����&� (6, 0, 0 9�%�	��#� node 4) 0( 90 ��,�  

"���������*�0�����	��� � Circular Repeat ��"��/ Geometry "��%���		��"
#�	 member 1 �
� 2 

���� � Beam Cursor  

7) ��	�����
�	0���� Circular Repeat ���/
���)������  $�#�"
#�	��	"��/ 
Geometry > Circular Repeat 

8) ��(��	;$����� 3D Circular ������ �$�"
#�	�	�$�&�"(4��	� Y �&�$�&� Total Angle: 90 
�*������� (No. of Steps) "(4� 1 �
�"
#�	 Though Node: 4 $�#����.�	�� X = 6, Z = 0 	�0�� 
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��"�
��"(4�������/(����
��� 

 

2.4 �
��������������� 

".#%�������	��	���������/
����$��������� member �$�"(
�%��$����������	 meter "(4� 
centimeter �*���%���%���/	������#� 

 

UNIT CM MTON 

STEP: 

1)  �
�	0���� Input Units ��	�/
���)  $�#�"
#�	��	"��/ Tools > Set Current Input Unit 

2)  "�#%���$�����(��	;�������$��
�	"
#�	$��� Centimeter �
��
�	 OK 
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2.5 ���������� !�� member 

������0(�#�	��	*�$������$����������
�"�� �*���%���%� ��#� 

 
MEMB PROP 

1 4 PRIS YD 30 ZD 30 

2 5 PRIS YD 40 ZD 30 

3 PRIS YD 35 

 

STEP: 

1)  �
�	0���� Property Page  ��	�/
���) $�#�"
#�	��	$����������� General > 

Property 

2)  "�#%�$����� Properties (��	;������ 	�(&8� Define… "�#%�$�����(��	;�����$�"
#�	��� 
Rectangle ���"	���� ��� Material ��%�/	"
#�	0�"(4� concrete ���"��(
�������0��(��	����	*�$��
�&+���������&�$������������� �������%���"������	��	*�$��"����$
����������$��
�	"
#�	��	 �
������� YD 

= 30 cm, ZD = 30 cm 

 

 

 

��	�����
�	(&8� Add ".�%�$������"���0(�����	�� 

4)  �����$��������%��� PRIS YD 40 ZD 30 ����������"��� 

5)  $��������%���"(4�$������	
� ��������$�"
#�	��� Circle �
�	 ��� Material ��	 �
���� YD = 35 

cm �
��
�	 Add 
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"�#%������$������0������$���
��$��
�	(&8� Close 

 

���������"���� assign $��������%����������$��	� members ������ 

 $������ 1 : Rect 0.30x0.30 �$�	�� member 1 �
� 4 

 $������ 2 : Rect 0.40x0.30 �$�	�� member 2 �
� 5 

 $������ 3 : Cir 0.35 �$�	�� member 3 

2.6 �������� �� 

��	�+���%0�����*���%�	*�$�� STAAD �������,������"���
��������,��%	*�$�����(��	�� �*�$��� 
member 4 ���&����"������	���$�������(������%�����	� local Y)�������	� global Z 	��*�0�����
	*�$���&� beta "(4� 90 ��,� �*���%��#� 

 

BETA 90 MEMB 4 

 

STEP: 

1)  "
#�	��� Beta Angle ��$����� Properties 

2)  ��$������������&� 90 ��,� �
�"
#�	 member 4 
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2.7 ���������"���!��� 

�������%"��	*�$���&+������$������ "��������%��"
#�	0�����&�&+���������& "�#%����	"������	����%�����&
�&+���������&"��9�%���	������	��%����/����(��	�� �*���%���%� ��#� 

 

CONSTANTS 

E 220 ALL 

UNIT METER 

DENSITY 2.4 ALL 

POISSON 0.17 ALL 

 

STEP: 

1)  ��	"��/ Command > Material Constants > Elasticity… ".#%�	*�$��������/
���#�$�&�� 

2)  ��$����� Material Constant ������ 220 
��� ��� Enter Value �
��
�	 OK 

 



STAAD.Pro 2005 : Tutorial 2 2 - 9 

 

3)  ��	�������� DENSITY �$�"(
�%��$������ Set Current Unit "(4� Meter 

4)  "
#�	"��/ Command > Material Constants > Density ������ 2.4 Mton/m
3
 

5)  ������ POISSON’S RATIO ���� ��������"���	�������� 0.17 

2.8 ������������!  

�&����������"�������������/	����������	��$�&��
�	��"�
#%����% �*���%��#� 

 

SUPPORTS 

1 4 5 FIXED 

STEP: 

1)  ".#%�������&��������$�"
#�	 Support page ���/
���)  $�#����"
#�	��	���
�������� General > Support 

2)  "�#%�$����� Support �����������$�	�(&8� Create ".#%������ Fixed support ��	����	� assign �$�
>��"�����������"�
��"(4�������/( 

 

2.9 ������#���!� ��"�� 

�*�$���������������"�����������*�$��	����&	 5 cases 0���	� 

Load case 1 : Dead Load 

Selfweight of the structure 

Beam 2 & 5 : 400 kg/m in global Y downward 

 

Load case 2 : Live Load 
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Beam 2 & 5 : 600 kg/m in global Y downward 

 

Load case 3 : Wind Load 

Column 1 : 300 kg/m along positive global X 

Column 4 : 500 kg/m along positive global X 

 

Load case 4 : DEAD + LIVE 

L1 X 1.2 + L2 X 1.5 (Use REPEAT LOAD, not Load Combination) 

 

Load case 5 : DEAD + WIND 

L1 X 1.1 + L3 X 1.3 (Use REPEAT LOAD, not Load Combination) 

�� case 4 �
� 5 ��� � REPEAT LOAD 9�%�������	�������>�� ��	��	������������"����$)
������������ PDelta 9�%������2
������	���*����������
����������%�.����	�� �*���%���%� ��#� 

 

UNIT METER KG 

 

LOAD 1 DEAD LOAD 

SELF WEIGHT Y -1 

MEMBER LOAD 

2 5 UNI GY -400 

 

LOAD 2 LIVE LOAD 

MEMBER LOAD 

2 5 UNI GY -600 

 

LOAD 3 WIND LOAD 

MEMBER LOAD 

1 UNI GX 300 

4 UNI GX 500 

 

LOAD 4 DEAD + LIVE 

REPEAT LOAD 

1 1.2 2 1.5 

 

LOAD 5 DEAD + WIND 

REPEAT LOAD 

1 1.1 3 1.3 

 

STEP: 

0) 	����#%��$�"(
�%��$���"(4� METER �
� KG 

1)  �
�	0���� Load Page ���/
���)  $�#�"
#�	����������� General > Load 

2)  ��$����� Load �$��
�	"
#�	���	�� Load Case Details �
��
�	(&8� Add…  

�����	�� Primary ��*�$��	$���"
� 1 ���� #%��� DEAD LOAD �
��
�	 Add 

3) ��*�$��	$���"
� 2 ���� #%��� LIVE LOAD �
��
�	 Add  

4) ���$���"
� 3 ���� #%��� WIND LOAD �$��
�	 Add �
��
�	 Close ���	����"(4�����/( 
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5) �
�	"
#�	���	�� 1 : DEAD LOAD �
��
�	(&8� Add… "
#�	 Selfweight Y -1 �
��
�	(&8� Add 

6) "
#�	���	�� Member Load > Uniform Force ������ GY -400 kg/m ������/(����
��� 

 

7) Assign ��*�$��	����&	�$����"���) 2 �
� 5 ����
�	"
#�	��%���	�� 	�(&8� Assign �
��
�	��%��� 

 

8) �
�	"
#�	 2 : LIVE LOAD �������*�$��	����&	�2� UNI GY -600 kg/m �
� Assign �$����"���) 
2 �
� 5 
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9) �
�	"
#�	 3 : WIND LOAD �������*�$��	 UNI GX +300 kg/m �
� Assign �$�"��"���) 1 �
�
�������*�$��	 UNI GX +500 kg/m �
� Assign �$�"��"���) 3 ������/(����
��� 

 

���	����$����� Load ��"(4�������/(����
��� 

 

REPEAT LOAD CASE 4 and 5 

10) ��	�������	�+�����&	 4 �$��
�	"
#�	 Load Cases Details �
�	(&8� Add "
#�	���	�� Primary 
��� #%�"(4� DEAD + LIVE 
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11) ��$����� Add New : Load Items "
#�	���	�� Repeat Load "
#�		�+�����&	 1 �
� 2 ������
�1	"���) 1.2 �
� 1.5 ���
*���� ������/(����
��� 

 

12) �
�	(&8� Add �
������� Close  

 



STAAD.Pro 2005 : Tutorial 2 2 - 14 

 

13) �����	�+�����&	 5 ���"���	��	�+� 4 ���� #%� DEAD + WIND �
�� ��1	"���) 1.1 	�� DEAD 
�
� 1.3 	�� WIND ��0��������/(����
��� 

 

2.10 �������$��������� 

�-�	���"����$)��%��� �	���������������#� P-Delta "�#%����	����������
�"�����	���9�%�������	������
����>�� ACI 	���"����$)
*������%���� ����	����*�$��	�/+".�%����	���*�.����	��9�%�0���/	�����0��
�
�� Load case 4 �
� 5 �*���%���%� ���	��	*�$���-��"����$)�#� 

 

PDELTA ANALYSIS 

STEP: 

1)  0(��%$��� Analysis/Print ��%�����%�����9���������
��
�	������� Analysis  

2)  "�#%�$����� Analysis/Print �����������$�"
#�	��� PDelta Analysis �
�	(&8� Add �
������� 
Close 
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2.11 ���� load cases "����%&�%�������  ������� 

	����	������	������*����� � load case 4 �
� 5 "������� ".#%���	�(��	���$�� � load cases ��%��
� ���	���"����� ��*���%������� 

 

LOAD LIST 4 5 

STEP: 

1)  "
#�	��	"��/ Command > Loading > Load List 

2)  ��$����� Load List �$�"
#�	"?.�� load case 4 �
� 5 ���	�(&8� ctrl ����0� "�����
�	� OK 

 

2.12 �����'������������  ������� 

���(�������	����	������	���"����"$
�	���� 2/�� ���������%��	*�$��0��" �� "	��������	���$�#�
����"$
�	"����$7���%�&���%���	��� � ���.�����"���)	*�$��������� ��*���%������� 

 

UNIT CM KG 

CODE ACI 

CLT 2.5 ALL 

CLB 3 ALL 

CLS 2.5 ALL 

FC 240 ALL 

FYMAIN 4000 ALL 

TRACK 1 ALL 

STEP: 

1)  	����#%��$�"(
�%��$��������"(4� cm �
�$������"(4� kg "���	��� ����
�	0���� Input Unit 

 "�#%�$����������������$��
�	"
#�	$�����%����	���
�	� OK 

2)  �����0(��%$��� Design > Concrete "
#�	 Current code "(4� ACI ��	�����
�	(&8� Define 

Parameters 
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3)  ��$����� Define Parameters "
#�	��� Clt ����$&�������� ������ 2.5 cm �
�	 Add 

4)  ��������%"$
#�������������% 3) ����� �
�	�(&8� Close $����� Concrete Design ����������/( 

 

5) ��%"(4�"��#%��$����*�������������0���/	 assign �$� member �� "�#%����	"����� �	���&	 members 
��������-���%������%�&��#� Assign To View ����$��
�	"
#�	�����%�� assign �
��
�	"
#�	�-� �
�	�(&8� 
Assign 

2.13 ��������!������   

�*���%���	�����%"����� ��#�	����	�������*�$��� member 2 �
� 5 �
���	���"���*�$��� 

member 1, 3 �
� 4 �*���%���%� ��#� 

 

DESIGN BEAM 2 5 

DESIGN COLUMN 1 3 4 

 

STEP : 

1)  �*���%���	������/	�����0����	$����� Concrete Design ���	�(&8� Command… 

2)  "�#%�$����� Design Command �����������$�"
#�	��� Design Beam �
�	(&8� Add �����"
#�	
��� Design Column �
�	(&8� Add �
�����
�	(&8� Close $�������"(4�������/( 
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3) ����������#�	�� assign 	����	�������$�	�� member 2 �
� 5 ����$��
�	"
#�	 DESIGN 

BEAM ��	���	��, �
�	"
#�	������� members 2 �
� 5, �
�	"
#�	�-� assign "(4� Assign to 

Selected Beams �
�	�(&8� Assign 

4)  � ��-�"���	��������� 3) assign 	����	���"���$�	�� member 1, 3 �
� 4 

5)  "�#%��*�"�����
�"��#%��$����*���� ? �����	����$��0( 

2.14 ���������������   

"
#�	"��/ Analysis > Run Analysis… "�#%�$����������������$�"
#�	 STAAD Analysis �
��
�	
(&8� Run Analysis 

�+��*�	���*��+����$
������������������ $�	0�������2�	.
�� "�#%�"�����
��$�"
#�	 Stay in 

Modeling Mode �
��
�	(&8� Done ������/( 
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2.15 ����()�� Output 

��$����������	���"����$) STAAD.Pro �������01
) output ������9�%���������/
�*���7��	���"����$)
�*�"���0(������/	����$�#�0�� �������" ����� STAAD.Pro "��(67$�"�����:�.��$���	���*��+ 	���
��������	����01
) output  

 "��������"������01
) output 0����� �
�	"
#�	 View Output File �����"�#%�"��������	��
�"����$)��$������%�
� $�#�������/:��$
��0�����"
#�	��	"��/ File > View > Output File > 

STAAD Output 

 

             **************************************************** 

             *           STAAD.Pro                              * 

             *           Version  2005    Bld 1001.US           * 

             *           Proprietary Program of                 * 

             *           Research Engineers,  Intl.             * 

             *           Date=    JUN 23, 2006                  * 

             *           Time=     7:41:38                      * 

             **************************************************** 

     1. STAAD SPACE 

INPUT FILE: rcframe.STD 

     2. START JOB INFORMATION 

     3. ENGINEER DATE 21-JUN-06 

     4. END JOB INFORMATION 

     5. INPUT WIDTH 79 

     6. UNIT METER MTON 

     7. JOINT COORDINATES 

     8. 1 0 0 0; 2 0 3.5 0; 3 6 3.5 0; 4 6 0 0; 5 6 0 6; 6 6 3.5 6 

     9. MEMBER INCIDENCES 

    10. 1 1 2; 2 2 3; 3 3 4; 4 5 6; 5 6 3 

    11. UNIT CM MTON 

    12. MEMBER PROPERTY AMERICAN 

    13. 1 4 PRIS YD 30 ZD 30 

    14. 2 5 PRIS YD 40 ZD 30 

    15. 3 PRIS YD 35 

    16. UNIT METER MTON 

    17. DEFINE MATERIAL START 

    18. ISOTROPIC MATERIAL1 

    19. E 2.2E+006 

    20. POISSON 0.17 

    21. DENSITY 2.4 

    22. END DEFINE MATERIAL 

    23. UNIT CM MTON 

    24. CONSTANTS 

    25. MATERIAL MATERIAL1 MEMB 1 TO 5 

    26. UNIT METER MTON 

    27. SUPPORTS 

    28. 1 4 5 FIXED 
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    29. LOAD 1 LOADTYPE NONE  TITLE DEAD LOAD 

    30. SELFWEIGHT Y -1 

    31. UNIT METER KG 

    32. MEMBER LOAD 

    33. 2 5 UNI GY -400 

    34. UNIT METER MTON 

    35. LOAD 2 LOADTYPE NONE  TITLE LIVE LOAD 

    36. UNIT METER KG 

    37. MEMBER LOAD 

    38. 2 5 UNI GY -600 

    39. UNIT METER MTON 

    40. LOAD 3 LOADTYPE NONE  TITLE WIND LOAD 

    41. UNIT METER KG 

    42. MEMBER LOAD 

    43. 1 UNI GX 300 

    44. 4 UNI GX 500 

    45. LOAD 4 LOADTYPE NONE  TITLE DEAD + LIVE 

    46. REPEAT LOAD 

    47. 1 1.2 2 1.5 

    48. LOAD 5 LOADTYPE NONE  TITLE DEAD + WIND 

    49. REPEAT LOAD 

    50. 1 1.1 3 1.3 

    51. PDELTA ANALYSIS 

 

            P R O B L E M   S T A T I S T I C S 

            ----------------------------------- 

     NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS =     6/     5/     3 

     ORIGINAL/FINAL BAND-WIDTH=     3/     3/     12 DOF 

     TOTAL PRIMARY LOAD CASES =    5, TOTAL DEGREES OF FREEDOM =     18 

     SIZE OF STIFFNESS MATRIX =        1 DOUBLE  KILO-WORDS 

     REQRD/AVAIL. DISK SPACE  =     12.0/  23325.6 MB 

  

  ++ Adjusting Displacements                            7:41:39 

  

    52. LOAD LIST 4 5 

    53. START CONCRETE DESIGN 

    54. CODE ACI 

    55. UNIT CM KG 

    56. CLT 2.5 ALL 

    57. CLB 3 ALL 

    58. CLS 2.5 ALL 

    59. FC 240 ALL 

    60. FYMAIN 4000 ALL 

    61. TRACK 1 ALL 

    62. DESIGN BEAM 2 5 
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          BEAM  NO.     2 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02 

   LEN -  6000. MM  FY -  392.  FC -  24.  MPA, SIZE -  300. X  400. MMS 

   LEVEL    HEIGHT     BAR INFO       FROM          TO           ANCHOR 

             (MM)                     (MM)         (MM)         STA  END 

   _____________________________________________________________________ 

     1         51.     2 - 16MM         0.         5442.        YES  NO 

   |----------------------------------------------------------------| 

   |   CRITICAL POS MOMENT=     45.20 KN-MET  AT  3000.MM, LOAD    4| 

   |   REQD STEEL=   380.MM2, ROW=0.0036, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

     Cracked Moment of Inertia Iz at above location =    30519.8 cm^4 

     2        354.     2 - 16MM         0.         1108.        YES  NO 

   |----------------------------------------------------------------| 

   |   CRITICAL NEG MOMENT=     29.60 KN-MET  AT     0.MM, LOAD    4| 

   |   REQD STEEL=   374.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

     Cracked Moment of Inertia Iz at above location =    31472.8 cm^4 

     3        354.     2 - 16MM      4142.         6000.        NO   YES 

   |----------------------------------------------------------------| 

   |   CRITICAL NEG MOMENT=     32.30 KN-MET  AT  6000.MM, LOAD    4| 

   |   REQD STEEL=   374.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

     Cracked Moment of Inertia Iz at above location =    31472.8 cm^4 

 

          B E A M  N O.     2 D E S I G N  R E S U L T S - SHEAR 

  

    AT START SUPPORT - Vu=   44.49 KNS  Vc=   92.10 KNS  Vs=    0.00 KNS 

    Tu=    3.16 KN-MET  Tc=    3.2 KN-MET  Ts=    0.0 KN-MET  LOAD     4 

    NO STIRRUPS ARE REQUIRED FOR TORSION. 

    REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1. 

    PROVIDE 12 MM 2-LEGGED STIRRUPS AT 181. MM  C/C FOR 2655. MM 

    AT END   SUPPORT - Vu=   45.39 KNS  Vc=   90.73 KNS  Vs=    0.00 KNS 

    Tu=    3.16 KN-MET  Tc=    3.2 KN-MET  Ts=    0.0 KN-MET  LOAD     4 

    NO STIRRUPS ARE REQUIRED FOR TORSION. 

    REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1. 

    PROVIDE 12 MM 2-LEGGED STIRRUPS AT 181. MM  C/C FOR 2655. MM 
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  ___   2J____________________  6000X 300X  400_____________________   3J____ 

 |                                                                           | 

 ||=============                                     =======================|| 

 | 2No16 H 354.|  0.TO 1108                         2No16|H 354.4142.TO 6000 | 

 | 16*12c/c181 |                                      |  |  | 16*12c/c181    | 

 | 2No16 H  51.|  0.TO 5442                           |  |  |  |  |  |       | 

 ||===================================================================       | 

 |                                                                           | 

 |___________________________________________________________________________| 

  ___________     ___________     ___________     ___________     ___________ 

 |           |   |           |   |           |   |           |   |           | 

 |    oo     |   |           |   |           |   |    oo     |   |    oo     | 

 | 2#16      |   |           |   |           |   | 2#16      |   | 2#16      | 

 |           |   |           |   |           |   |           |   |           | 

 | 2#16      |   | 2#16      |   | 2#16      |   | 2#16      |   |           | 

 |    oo     |   |    oo     |   |    oo     |   |    oo     |   |           | 

 |           |   |           |   |           |   |           |   |           | 

 |___________|   |___________|   |___________|   |___________|   |___________| 

 

          BEAM  NO.     5 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02 

  

   LEN -  6000. MM  FY -  392.  FC -  24.  MPA, SIZE -  300. X  400. MMS 

  

   LEVEL    HEIGHT     BAR INFO       FROM          TO           ANCHOR 

             (MM)                     (MM)         (MM)         STA  END 

   _____________________________________________________________________ 

     1         51.     2 - 16MM       308.         5442.        NO   NO 

   |----------------------------------------------------------------| 

   |   CRITICAL POS MOMENT=     45.20 KN-MET  AT  3000.MM, LOAD    4| 

   |   REQD STEEL=   380.MM2, ROW=0.0036, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

  

     Cracked Moment of Inertia Iz at above location =    30519.8 cm^4 

  

     2        354.     2 - 16MM         0.         1108.        YES  NO 

   |----------------------------------------------------------------| 

   |   CRITICAL NEG MOMENT=     29.60 KN-MET  AT     0.MM, LOAD    4| 

   |   REQD STEEL=   374.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

  

     Cracked Moment of Inertia Iz at above location =    31472.8 cm^4 
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     3        354.     2 - 16MM      4642.         6000.        NO   YES 

   |----------------------------------------------------------------| 

   |   CRITICAL NEG MOMENT=     32.30 KN-MET  AT  6000.MM, LOAD    4| 

   |   REQD STEEL=   374.MM2, ROW=0.0035, ROWMX=0.0197 ROWMN=0.0035 | 

   |   MAX/MIN/ACTUAL BAR SPACING=   295./   41./  209. MMS         | 

   |   REQD. DEVELOPMENT LENGTH =   467. MMS                       | 

   |----------------------------------------------------------------| 

  

     Cracked Moment of Inertia Iz at above location =    31472.8 cm^4 

  

          B E A M  N O.     5 D E S I G N  R E S U L T S - SHEAR 

  

    AT START SUPPORT - Vu=   44.49 KNS  Vc=   92.10 KNS  Vs=    0.00 KNS 

    Tu=    3.16 KN-MET  Tc=    3.2 KN-MET  Ts=    0.0 KN-MET  LOAD     4 

    NO STIRRUPS ARE REQUIRED FOR TORSION. 

    REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1. 

    PROVIDE 12 MM 2-LEGGED STIRRUPS AT 181. MM  C/C FOR 2655. MM 

 

    AT END   SUPPORT - Vu=   45.39 KNS  Vc=   90.73 KNS  Vs=    0.00 KNS 

    Tu=    3.16 KN-MET  Tc=    3.2 KN-MET  Ts=    0.0 KN-MET  LOAD     4 

    NO STIRRUPS ARE REQUIRED FOR TORSION. 

    REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1. 

    PROVIDE 12 MM 2-LEGGED STIRRUPS AT 181. MM  C/C FOR 2655. MM 

 

  ___   6J____________________  6000X 300X  400_____________________   3J____ 

 |                                                                           | 

 ||=============                                           =================|| 

 | 2No16 H 354.|  0.TO 1108                         2No16 H 354.4642.TO 6000 | 

 | 16*12c/c181 |                                            | 16*12c/c181    | 

 |   2No16 H| 51. 308.TO 5442                               |  |  |  |       | 

 |  ==================================================================       | 

 |                                                                           | 

 |___________________________________________________________________________| 

  ___________     ___________     ___________     ___________     ___________ 

 |           |   |           |   |           |   |           |   |           | 

 |    oo     |   |           |   |           |   |           |   |    oo     | 

 | 2#16      |   |           |   |           |   |           |   | 2#16      | 

 |           |   |           |   |           |   |           |   |           | 

 |           |   | 2#16      |   | 2#16      |   | 2#16      |   |           | 

 |           |   |    oo     |   |    oo     |   |    oo     |   |           | 

 |           |   |           |   |           |   |           |   |           | 

 |___________|   |___________|   |___________|   |___________|   |___________| 

  

   ********************END OF BEAM DESIGN************************** 

  

    63. DESIGN COLUMN 1 3 4 
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        COLUMN  NO.     1  DESIGN PER ACI 318-02 - AXIAL + BENDING 

  

   FY - 392.3  FC -  23.5 MPA,  SQRE SIZE - 300.0 X 300.0 MMS, TIED 

           ONLY MINIMUM STEEL IS REQUIRED. 

           AREA OF STEEL REQUIRED =   900.0  SQ. MM 

  

   BAR CONFIGURATION       REINF PCT.   LOAD   LOCATION   PHI 

   ---------------------------------------------------------- 

     8 - 12 MM               1.005        4      END     0.650 

   (PROVIDE EQUAL NUMBER OF BARS ON EACH FACE) 

   TIE BAR NUMBER    8 SPACING 192.00 MM 

  

       COLUMN INTERACTION: MOMENT ABOUT Z -AXIS (KN-MET) 

    -------------------------------------------------------- 

      P0        Pn max    P-bal.    M-bal.     e-bal. (MM) 

    2137.31   1709.85    828.93     97.97     118.2 

       M0       P-tens.   Des.Pn    Des.Mn     e/h 

      45.00   -354.91     77.41     45.53    0.16805 

    -------------------------------------------------------- 

  

       COLUMN INTERACTION: MOMENT ABOUT Y -AXIS (KN-MET) 

    -------------------------------------------------------- 

      P0        Pn max    P-bal.    M-bal.     e-bal. (MM) 

    2137.31   1709.85    828.93     97.97     118.2 

       M0       P-tens.   Des.Pn    Des.Mn     e/h 

      45.00   -354.91     77.41      4.86    0.01795 

    -------------------------------------------------------- 

 

        COLUMN  NO.     3  DESIGN PER ACI 318-02 - AXIAL + BENDING 

  

   FY - 392.3  FC -  23.5 MPA,  CIRC SIZE  350.0 MMS DIAMETER  TIED 

           ONLY MINIMUM STEEL IS REQUIRED. 

           AREA OF STEEL REQUIRED =   962.1  SQ. MM 

  

   BAR CONFIGURATION       REINF PCT.   LOAD   LOCATION   PHI 

   ---------------------------------------------------------- 

     9 - 12 MM               1.058        4      END     0.650 

   (EQUALLY SPACED) 

   TIE BAR NUMBER    8 SPACING 192.00 MM 

  

       COLUMN INTERACTION: MOMENT ABOUT Z/Y -AXIS (KN-MET) 

    -------------------------------------------------------- 

      P0        Pn max    P-bal.    M-bal.     e-bal. (MM) 

    2303.67   1842.94    915.92    100.91     110.2 

       M0       P-tens.   Des.Pn    Des.Mn     e/h 

      53.12   -399.28    172.22     30.40    0.03566 

    -------------------------------------------------------- 
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        COLUMN  NO.     4  DESIGN PER ACI 318-02 - AXIAL + BENDING 

  

   FY - 392.3  FC -  23.5 MPA,  SQRE SIZE - 300.0 X 300.0 MMS, TIED 

           AREA OF STEEL REQUIRED =   963.0  SQ. MM 

  

   BAR CONFIGURATION       REINF PCT.   LOAD   LOCATION   PHI 

   ---------------------------------------------------------- 

     4 - 20 MM               1.396        5      STA     0.650 

   (PROVIDE EQUAL NUMBER OF BARS ON EACH FACE) 

   TIE BAR NUMBER    8 SPACING 192.00 MM 

  

       COLUMN INTERACTION: MOMENT ABOUT Z -AXIS (KN-MET) 

    -------------------------------------------------------- 

      P0        Pn max    P-bal.    M-bal.     e-bal. (MM) 

    2268.30   1814.64    804.79    122.19     151.8 

       M0       P-tens.   Des.Pn    Des.Mn     e/h 

      60.36   -492.94     46.38     46.86    0.28869 

    -------------------------------------------------------- 

  

       COLUMN INTERACTION: MOMENT ABOUT Y -AXIS (KN-MET) 

    -------------------------------------------------------- 

      P0        Pn max    P-bal.    M-bal.     e-bal. (MM) 

    2268.30   1814.64    804.79    122.19     151.8 

       M0       P-tens.   Des.Pn    Des.Mn     e/h 

      60.36   -492.94     46.38      9.35    0.05763 

    -------------------------------------------------------- 

 

   ********************END OF COLUMN DESIGN RESULTS******************** 

  

    64. END CONCRETE DESIGN 

    65. FINISH 

 

             *********** END OF THE STAAD.Pro RUN *********** 
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Tutorial Problem 3 

Analysis of a Slab 

���������	
������������	�����������
�
�������� !"����������#��������#����"�������������� 

- 
�	&'�()*�� 

- 	�����������
!"����#�+�+�������,�����#� 

- 	-�����.'������!"�� 

- 	-�����������/���. 

- 	-�����.������� 

- 	-������-����	����.	 

- 	-�����0�	���������  

- �-�	���������  

- �123
 ,
	���-��' 
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3.1 ��������	
� 

�������������������(4��,��!"��#�����������/���������� ������-�����
��#�+�+�������,�����#� 6 +������
�������1(����
��� !"��������������-����	�����, ��-����	����.	������ �
���-����	����.	�.'�71�� 

 

 
��������������������� 

��������	
	����� !"�����  30 :�. 

������������ E, ����������, ()� :�� 

��������� �����������������1	#������������1(��/ 3.2 

������������������ ��-����	 1: ��-����	����� 

��-����	 2: ��-����	�� 300 	.	./��.�. 

��-����	 3: 75
o
F #"�����/-����� �	,�������	��,�
��� 60

o
F 

����������������� Case 101: Case 1 + Case 2 
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Case 102: Case 1 + Case 3 

�	���	������  ��
����	�+������ 

3.2 ������������� 

��()*���������
�������(4�������� ��������
"�	+�������������(4� Space �
"�	 Meter �(4����#���
#� �
��
"�	 Kilo Newton �(4����#��� ���+"/�23
 ��������(4� slab 

 

�����������������
"�	 Add Plate �
��
�	 Finish ������1(����
��� 
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3.3 ����� �������������� 

����1
���������(��	����#���#�
� Joint �
�!�	�� ���#�
� Member �
��-������	����������� 
Joint ����1
�-���/���/���1	�������23
 �-���/� STAAD �"� 

JOINT COORDINATES 

1 0 0 0 ; 2 2 0 0 ; 3 2 0 2 ; 4 0 0 2  

5 4 0 0 ; 6 4 0 2 ; 7 6 0 0 ; 8 6 0 2 

9 2 0 4 ; 10 0 0 4 ; 11 4 0 4  ; 12 6 0 4 

ELEMENT INCIDENCES SHELL 

1 1 2 3 4 ; 2 2 5 6 3 ; 3 5 7 8 6  

4 4 3 9 10 ; 5 3 6 11 9 ; 6 6 8 12 11 

	�����������
�-�2��   4  �0�2���	� 
1. �+�	����,��	��	�� Copy/Paste 

2. �+�	����,��	��	���-� Translational Repeat 

3. �+� Structure Wizard �����1 Geometry 

4. �+� Mesh Generation ���������	��33?	�
�	 

 

!"#$��������%& ����� 

���'��: 

�(�
��������"� 

1. ���2���
"�	 Add Plate 2��
�	���������� �-�����	������	�������������1(����
��� ��@����	� X, 

Y, Z ���1	������/�.�:��#
��������7�!�� (������������/�	���2����#�
"�	��1 Geometry > 

Snap/Grid Node > Plate > Quad 

�
�	�
"�	������������ Geometry > Plate 

2. ������ Snap Node/Plate ������������������������7�! �
"�	��� Linear �!"/������#�
����	�����������B�	�"�����/��
������ �
"�	����� X-Z �
"�	�-��� 6 ����������-�����
�	� X �
� 4 �����-������	� Z ��#����� 1 ������������	� 
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�����)"��� !� 1 

3. �.�������/���+��������	��!�	�� (0, 0, 0), (2, 0, 0), (2, 0, 2), �
� (0, 0, 2) ���
-���� ��	��
���/��������� Node ����
�	(.C� Snap Node/Beam �
��
"/������� 2(�
�	��/�.�	-����� (0, 0, 0) 

4. �
�	��	����.���/��
"��"� (2, 0, 0), (2, 0, 2) �
� (0, 0, 2) 

�-������!�	���������� �12����	������������
��������� 

 

��"/��-����D��
�+������������������1( 

 

5. 
�����	�����#�
�	(.C� Close �������� Snap Node/Plate ����
���(4�����������1( 

 

 

6. �
"�	 �,�� 1 ��#�+� Plate Cursor   
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7. �
�	����� (.C��� �
"�	 Copy �
��
�	����� ����	������
"�	 Paste Plates �����#���������,����/
����"� X = 2, Y = 0 �
� Z = 0 ��	�,�� 1 

 

����
����
�	&'������7�! 

 

�����)"��� !� 3 

8. �,�� 3 ������	�,�� 1 �(4���#� X = 4 �+��0�	�������"� Paste with Move 

 

�����)"��� !� 4, 5 %�� 6 

9. �����"��	������,����	��#����#� Z = 2 �. ����
"�	��������,����#�
�	����� �(4�	������ 
�
��+� Copy �����# Paste Plates ������� 
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3.4 �(�
���0���1�'")"��� !� 

	����"/�����(
�/#����#���#��(4� cm �.'��������/��	-�����-������,��!"���"������� �-���/���/�+��"� 

UNIT CM KN 

ELEMENT PROPERTY 

1 TO 6 THICKNESS 30 

Steps: 

1. �
�	2���� Property Page ���1
���  

 

��"�����
"�	��	�����������:��# General | Property �����������������������:��#�����7�! 

 



STAAD.Pro 2005 : Tutorial 3 3 - 8 

 

2. �
�	(.C� Thickness �!"/�	-��������������,��!"�� �������� Properties 

3. �������� Plate/Surface Property ������������ 30 cm ��+����
"�	���.�1	�
"�	�(4� 
CONCRETE :�/��������2��+����� �.'���������	�������E���+���������/���#1����(��	�� 	�(.C� 
Add �
������#(.C� Close 

 

������ Properties ��	
�#�(4� 
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4. ��"/����	�������	������.	�,��������������	����� ����
"�	�0� Assign To View �
��
�	(.C� 
Assign ������������������������������1(����
��� ����
�	(.C� Yes �!"/�#"�#���-���/� 

 

�������������
�	&'�������1(����
��� 

 

�
�	��/�.���E��!"����/�����1(�!"/������/�
"�	2���	 

3.5 �(�
���0���1�'"!���0 

��"/�����
�	+����.'���������. �-���/���
��������1	����������"� 

DEFINE MATERIAL START 

ISOTROPIC CONCRETE 

E 2171.85 

POISSON 0.17 

DENSITY 2.35616e-005 

ALPHA 1e-005 

DAMP 0.05 

END DEFINE MATERIAL 

CONSTANTS 

MATERIAL CONCRETE MEMB 1 TO 6 

����������2������	-��������!�/����� ���������#��2��2��	-���� 	D�����/�2����	���1 Command | Material 

Constants �
�	-���������#��� 

3.6 �(�
��20������1 

�,��!"���1	#������������#������������ �����	���-�����
�.������������#1���/ node �-���/���/�+��"� 
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SUPPORTS 

1 2 4 5 7 10 FIXED 

Steps: 

1. �
�	2���� Support Page ���1
���  

 

��"�����
"�	��	�����������:��# General | Support �����������������������:��#�����7�! 

2. ������ Support ������������������1(����
��� 

 

 

3. �!"/�������	��	��	-���� node ��/���(4��.������� ����(?� Node Number ��#�
�	����
7�! �
"�	 Labels… �
��
�	��/ Node number 

4. �����	-������� node 1, 2, 5, 7, 4 �
� 10 �(4� Fixed support ����+� Node Cursor  

�
"�	 node ��
����� 

5. ��	�����
�	(.C� Create �������� Supports 

6. ����������/���������� ���(4���� Fixed ���	�(.C� Assign ������������(4�������1(����
��� 
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3.7 �(�
�����$
�����(�
���1��30� 

��-����	����.	�
�	�����	�'������/2������2�������������� �-���/���/�+��"� 

UNIT METER KG 

LOAD 1 DEAD LOAD 

SELF Y -1.0 

  

LOAD 2 EXTERNAL PRESSURE LOAD 

ELEMENT LOAD 

1 TO 6 PR GY -300 

  

LOAD 3 

TEMPERATURE LOAD 

1 TO 6 TEMP 40 30 

Steps: 

1. �
�	2���� Load Page ���1
���  

 

��"�����
"�	��	�����������:��# General | Load �����������������������:��#�����7�! 

2. �(
�/#����# Input Units ��#	-�������#���#��(4� meter ���#����(4� Kilogram 

LOAD CASE 1 

3. ������ Load �����������������:��# �!"/����/�	�'���	 ����
"�	 Load Cases Details �
��
�	
(.C� Add 

4. �����	�'�����.	 1 : DEAD LOAD ������ Selfweight Y -1 

LOAD CASE 2 
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5. ��-����	����.	�����/����(4������������+������ ����
�	�
"�	 Load Cases Details �
��
�	
(.C� Add �
"�	+��� Load ��� None ����+"/��(4� EXTERNAL PRESSURE LOAD �
��
�	 
Add 

6. �������� Add New Load Items ����
"�	 Pressure on Full Plate 7�#�������� Plate Loads 
������ -300 kg/m

2
 ��+��� W1 �
"�	��@��� GY �
��
�	(.C� Add 

 

7. ��"/����	��-����	������	���-�	���.	+������ �0� Assign ��/���#��/�.��"�	�� Assign To View  

�
����	�����-����	�
�����
���(4�������1(����
��� 

 

LOAD CASE 3 

8. �������-����		�'���/ 3 ����+"/� TEMPERATURE LOAD �
��
�	(.C� Add 



STAAD.Pro 2005 : Tutorial 3 3 - 13 

 

9. ��"/������� Add New Load ���������� ����
"�	����� Temperature 7�#������
"�	 
Temperature Loads ��	���������� 40 ��+��� Temperature Change for Axial Elongation 
�
� 30 ��+��� Temperature Differential from Top to Bottom �
��
�	(.C� Add 

 

10. ��"/����	��-����	������	���-�	���.	+������ �0� Assign ��/���#��/�.��"�	�� Assign To View �
�
�
�	(.C� Assign �������� Load 

 

3.8 �(�
�����$��(�
���1��30�� !����3(� 

��-����	����.	���	���-������/���.���������������������	�'� �-���/���/�+��"� 

LOAD COMBINATION 101 CASE 1 + CASE 2 

1 1.0 2 1.0 

LOAD COMBINATION 101 CASE 1 + CASE 3 

1 1.0 3 1.0 

Steps: 
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LOAD COMBINATION 101 

1. �!"/��������-����	�����/ 4 �(4�������	���-� ����
�	�
"�	 Load Cases Details �
��
�	 Add 

�������� Add New Load Cases ����
�	 Define Combinations ��	��#	���������:��# ���
+��� Load No: �(4� 101 �
�+"/��(4� CASE 1 + CASE 2 

2. �����	���� ��+��� Available Load Cases ����
�	�
"�	��-����	 1 �
��
�	(.C�  ��	����	D�
"�	
��-����	 2 �-��+�����#	�� ���������1' 1.0 �
�	�(.C� Add 

��-����	��� 101 ���1	����������� 

 
 

LOAD COMBINATION 102 

3. �!"/��������-����	�����/ 5 �(4�������	���-� ����
�	�
"�	 Load Cases Details �
��
�	 Add 

�������� Add New Load Cases ����
�	 Define Combinations ��	��#	���������:��# ���
+��� Load No: �(4� 102 �
�+"/��(4� CASE 1 + CASE 3 

4. �����	���� ��+��� Available Load Cases ����
�	�
"�	��-����	 1 �
��
�	(.C�  ��	����	D�
"�	
��-����	 3 �-��+�����#	�� ���������1' 1.0 �
�	�(.C� Add 

��-����	��� 102 ���1	����������� 
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����������	���(
�/#���������-����		���-����	D�������-�2����#	���
�	�
"�	�������� Load �
�	�
(.C� Edit… ������1(����
��� 

 

��	��	��������#	��	�(.C� Close 

��"/�	�'�����.	 (load cases) �1	������������
� ������#	�������������1
��� ����������������1( 
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���2�����D�����	�������	�'���-����	����.	���#����#�
� 

�������	D�����
��#�
"�	���1 File | Save ��"�	���#  Ctrl �����
�	� s 

3.9 �(�
��)�"����!"�����
4 

	��������� ��/���+��"���������+������ (linear static) �
�����	����#����7�����.
���� �-���/���/�+�
�"� 

PERFORM ANALYSIS PRINT STATICS CHECK 

Steps: 

1. ��	��	-�����-���/��������  ���2(��/���� Analysis/Print > Analysis ��	����������:��#���
������ 

2. �������� Analysis/Print Commands ��/���������� 	���
"�	+���	��������� �-�2����#	��
�
"�	��� Perform Analysis �!"/����2����#����7�����.
������� �
�	�
"�	 Statics Check 

�(4� print option 

 

�
�	(.C� Add �
������# Close 

������ Analysis �������:��# ���(4�����������1( 



STAAD.Pro 2005 : Tutorial 3 3 - 17 

 

 

3.10 �(�
���(���5��"��4
������!"�����
4 

�������	������(��	������,
�
��	���-��'����#����"� a) ���#�����+������ �
� b) ���(F�	���#�
��/�.���� ��	��	�������#��/�����-��������#�������(4� KN �
� Meter �
��-�����������+� Kg 
�
� Meter �-���/���/�+��"� 

UNIT METER KN 

PRINT ELEMENT STRESSES LIST 3 

UNIT KG METER 

PRINT ELEMENT FORCE LIST 6 

,
��
��������1	���#�
���23
 ����,
 �������(?��12���
��	���������  

Steps: 

1. 2(��/���1 Tools | Set Current Input Unit ����������#�(4� Meter �
� Kilo Newton 

2. �������-�����	-����	������,
���#1�������#��# Post-Print ��������
�	 Analysis/Print 

�
�	(.C� Define Commands ��!"����/��������������7�! 

3. �������� Analysis/Print Commands ��/���������� �
"�	��� Element Forces/Stresses  �
�
�
"�	 Print Element Stresses �
��
�	(.C� Add �����# Close 
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4. 2(��/���1 Tools | Set Current Input Unit ����������#�(4� Meter �
� Kilogram 

��	�����-�:�-�������/ 2 �
� 3 ��������/ 3 ����
"�	 Print Element Forces �
��
�	 Add �����# Close 

���������������� Post Analysis Print ���(4�������1(����
��� 
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5. ��	���+"/���#��-���/� PRINT ELEMENT STRESSES 	��+��������/ 3 ����
�	�
"�	�-���/���
��������	���1(��/�
� ��	�����+� Plate Cursor �
�	�
"�	+��������/ 3 

��"/�����
�	�
"�	�,��!"�� Assignment Method ��	
�#�(4� Assign to Selected Plated �
�	(.C� Assign 

6. ��	���+"/���#��-���/� PRINT ELEMENT FORCES 	��+������ 6 �-�:�-�������/ 4 #	�������
"�	
+������ 6 �����/���(4�+�����/ 3 

3.11 3(����!"�����
4%�����%11 

���/��-�	��������� ��#�
"�	�-���/� Run Analysis… ��	���1 Analyze ���������������������� 

 

������� engine ����
"�	�"� STAAD engine �
� STARDYNE Advanced Analysis engine ���
�(4�	��������� +����1��+�� 	���	������ ��"�	���	���#	����	����/�2� ������(4�	���-��'��	���
��
D	��"����	��� ������+� STAAD engine 

��	�����
�	(.C� Run Analysis �����������������	��������� ���(4�������1( 
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��/�.�:��#
����������������
"�	 Stay in Modeling Mode �
��
�	(.C� Done 

3.12 67�4%���&� 

���������-�	��������� 23
 ����,
���1	����������� �!"/������	��������"���
����,��!
����/
�(��	�����!� 23
 �����������	.
 .anl �������+� output viewer �(?��12�� �
�	2��������,
��
�1
��� ������ 

 

������ STAAD output viewer ������������ �������������,
��/������	�������� 

PRINT STATICS CHECK 

���
���
"/��
�����"/�#E��!�����1
������ 

  ***TOTAL APPLIED LOAD (KG METE) SUMMARY (LOADING   1) 

       SUMMATION FORCE-X = 0.00 

       SUMMATION FORCE-Y = -17298.83 

       SUMMATION FORCE-Z = 0.00 

       SUMMATION OF MOMENTS AROUND THE ORIGIN- 

       MX=       34597.66  MY=          0.00  MZ=     -51896.48 

  

   ***TOTAL REACTION LOAD (KG METE) SUMMARY (LOADING   1) 

       SUMMATION FORCE-X = 0.00 

       SUMMATION FORCE-Y = 17298.83 

       SUMMATION FORCE-Z = 0.00 

       SUMMATION OF MOMENTS AROUND THE ORIGIN- 

       MX= -34597.66  MY= 0.00  MZ= 51896.48 

  

   MAXIMUM DISPLACEMENTS (CM/RADIANS) (LOADING   1) 

   MAXIMUMS      AT NODE 

     X = 0.00000E+00 0 

     Y = -3.20681E-01 12 

     Z = 0.00000E+00 0 

     RX= 9.80406E-04 12 

     RY= 0.00000E+00 0 

     RZ= -6.49355E-04 9 

�-��������
�	�'�����.	�
�	 ��#�����(��	��2(��# 
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a. ,
����������/��	���-��
������� ����.�	-����� (0, 0, 0) 

b. ,
��������(F�	���#���/�.��������
������� ����.�	-����� (0, 0, 0) 

c. ��#���
"/������	��/�.� (3 ��#��
� 3 	����.�) 

,
�����	���� (a) ���������������	���
����	������	����/�#1��� (b) ���2������	�����������,
	��
������� �����,��!
���	������ �+���7��	�����#����#�7�! ��"�	�������-����	2���1	���� 

	����������#�	����
"/������	��/�.�������-���*�!"/��1���#1����������/#�����2����"�2�� 

��	,
��/������	���(4���-����		�'���/ 1 �(4���-����	������"� 17298.83 Kgs. 

STRESSES FOR ELEMENT 3 

����1
���(��	����#���#����
������� ������#���	�����/�.�@1�# ������+��������/ 3 

 

ELEMENT STRESSES    FORCE, LENGTH UNITS =  KN   METE 

STRESS = FORCE/UNIT WIDTH/THICK, MOMENT = FORCE-LENGTH/UNIT WIDTH 

ELEMENT       LOAD SQX        SQY          MX          MY          MXY 

                                     VONT     VONB        SX           SY           SXY 

      3                      1             -18.13      72.86        -3.96        -20.42        -3.35 
                                           1308.63    1308.63       0.00         0.00          0.00 
       TOP:  SMAX=  -220.33  SMIN= -1404.81  TMAX=   592.24  ANGLE= -11.1 
       BOTT:  SMAX= 1404.81 SMIN=   220.33  TMAX=   592.24  ANGLE= -11.1 

 
FORCES FOR ELEMENT 6 

����1
���(��	����#����
������� ��/���
��.�������/���+��������/ 6 

 

ELEMENT FORCES    FORCE,LENGTH UNITS= KG   METE 

   -------------- 

JOINT     FX          FY          FZ          MX          MY          MZ 

  

               ELE.NO.      6 FOR LOAD CASE     1 

  6  0.0000E+00  4.5323E+02  0.0000E+00 -1.1313E+03  0.0000E+00  7.9082E+02 

  8  0.0000E+00  5.0615E+02  0.0000E+00 -3.2047E+02  0.0000E+00  2.3981E+02 

12  0.0000E+00 -7.2078E+02  0.0000E+00  1.4890E-03  0.0000E+00 -1.4168E-03 

11  0.0000E+00 -2.3860E+02  0.0000E+00 -4.6697E+02  0.0000E+00 -6.0136E+02  



STAAD.Pro 2005 : Tutorial 3 3 - 22 

 

3.13 Post Processing 

���2�������,��!
��������1
��/�������2( 	��������� �-�2�������D����1�'  ���"/���"�����E������ Post-

processing �������-����+��!"/� 

a) ����,
���	��33?	�
�������
� 

b) ����1��������������������������������(
��7�#, 	��������	���+���� �
� 
(�����0�7�! 

c) �������#���	-��������
��1(7�! 

����������	�������1��������2��	
��2��
��� Tutorial 2 �-������,��!"��,
��/�������"� ���#��� 
�
� ������ ������#���	��� :�/������
�#�0���	������,
�����2��	
����������	���2( 

3.14 %���&�
� !8%�������%11'���� 

�
"�	���1 View | Tables… �
"�	 Plate Centre Stress 

 

������ Results Setup ����������������
�	 OK �����������������������1(����
��� 
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3.15 ����"��4'���� 

	��!��! ������-�2����#	���
�	����� (.C�����!"����/������
��
"�	 Print 

3.16 ������$58�
� !83$5%�����'�������1� 

���#���#��
����������#����
������� ���1	������������� �!"/��(
�/#����# ����
"�	���1 
Tools | Set Current Display Unit 

 ����������/���������� �
�	�
"�	 Force Units ������#��/����	���-����� Stress �
� Moment 

�
�	(.C� Apply �
������# OK 

 

3.17 ���2(�������$1��30������%���&� 

��������1����� post-processing ��#	���
�	���������������������1(����
��� 

 

 

 

������������������,
��		�'�����.	������� ����#�	�-�	��
�����
"�	���1 Results | Select Load 

Case… ��"/���������������������
"�		�'�����.	��/����	��������1(����
��� 
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�
�	(.C� Apply �����# OK 

3.18 ������2�8
� !8%�� 

������
�	&'�����+�������1���	�������� ������0���	������,
�"� 

a) ��	�������/��������:��# �
"�	��� Plate | Contour ��"� 

b) �
"�	��	���1 Results | Plate Stress Contour 
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��	��������/��������������
"�	������ 

• Load case – 102 

• Stress Type – Von Mis Top 

• Contour Type – Normal Fill 

• Index based on Center Stress 

• Re-Index for new view 

�
�	 Apply �
� OK ��2���,�71��������1( 
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Tutorial 4 

Interoperability 

(STAAD.etc) 

���������	
���
��
�����������
������������
�� STAAD.Pro ��� STAAD.etc ��������
����������� Tutorial 1 	��� !��"���#�����
��	�����$�������� �������%�&������ 

• �#����	%���� STAAD.etc 

• �#�&'(����)*�� 

• 
����������+(��� ��',�� STAAD.Pro 

• &&
���"����
��
-�
���#��.%&� STAAD.Pro 

• &&
����-���&�"��	����
-�
���#��.%&� STAAD.Pro 

• ���	
/�%�&�$�
��&&
����+(��� ��',���$�01�, STAAD.etc 
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4.1 ��������	
��� STAAD.etc 

STAAD.etc 	��� engineer’s structural toolkit �������$�(	�����,���&&
���������������
2���3&��(	��� "����
 -���&("
�& 0�� 	��/
 �&�
��2 ���
��(	�����,���0� 4�����	�������
��	���� 
STAAD.etc �����44$
�����
��&&
��� ����%�&�%/�%���	�/
 ���2�&	�!�&� -���
���(�  !�����	��� 
�5�2�&	�!�&� -���������	6!&� ���&!��3&�
��
 STAAD.etc �&����-$�����#�
��&&
���0��7����2�
����
�� STAAD.Pro ������"��%�&�$���
-�
���#��.%&� STAAD.Pro 

4.2 ���������� 

����������������� Tutorial 1 	�����	�����
 	������� STAAD.etc ��
��(	�����,���&&
���"��
��
 �-���&�"��	�� ����5�2�&��	��2,7����2�����
�� STAAD.Pro 

4.3 �����
�������������� �� STAAD.Pro 

	�(��2������
�� STAAD.Pro 	�!&
	��$ File > Open 	�!&
01�, Tut_01_portal.std ��
0�	�
�&��� 
../SPro2005/STAAD/Examp/US ������$�%������� 

 

4�����0��0���#�
��(	�����, Tut_01_portal.std ����#�2��%���2&��!& 	�!�&	�8�01�,���	�!&
	��$ Analyze 

> Run Analysis 	�!&

��(	�����,��� STAAD Analysis �����(
�59� Run Analysis 

4��
��(	�����,�#�	�/������ �����(
�59� Done 	 !�&�#�2��%���2&�2�&0� 4����%�&���-(� �������
�0%2��
�� Tutorial 1 
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���!�"
��������������� �� STAAD.Pro 

������

��(	�����,	��/�������	%���$������+(��� ��',���	�!&
	��$ Mode > Interactive Designs > 

Component Design �����&�+(��� ��',%&� STAAD.etc ������%:�����������%�����%&��&7�  .. 
	����� STAAD.Pro 2005 Build 1001 ��������$��������!& "����
 �-�� !�� ����-���&�"��	�� 

 

�����
������ Drag-and-Drop 

��
��������$���3%&� STAAD.etc ���
�	����,<�������0������$����2�&�
�������
0�����5�2�&��
����2������
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4.4 �#��$��������%&	' STAAD.Pro 

����%�&���	����&&
���"����
�#������5�2�& #1 	�(�����	�!&
�5�2�&���&�����	��$ Select > By List > 

Nodes… 	�!&
����	�% 1 ��
���
�� 4���#�4$
�5�2�&���4$
	�!&
��
���	�������� 

��
���������
0&�&�"����
  �����5�2�& #1 �����&"����
������%:���� �������!�&��0� 

 

4��0����%�&�$����
����������:
%&�	�����������	%��0� STAAD.etc ���(�������:
	��	���%���
2�����
����&� Y ������
���	���!&%���2�����
����&� Z %&�	�� 
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����&� Concrete Pedestal �����(
	&�	��!�&�����4$
&&
 	������0�����4� Loading ��(
��&� 
Reversal of Wind 	 !�&	&�	��!�&�����4$
&&
 

 

��
������(
 OK 	 !�&	�(��2��
��&&
���"����
�#������5�2�& #1 4��
��&&
����#�	�/� -�
��&&
���
������������2�������4��!& -�
���#��. ���
���#��. �����������	&��������� 

%&��������( 
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�����������( 

 

#�����&)�*�� 
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4.5 �#��#%,��'�"
$�����%&	' STAAD.Pro 

�#�	���	���
������%�&��������
��	�!&
�5�2�& #1 �2����0&�&� ��� �����
+
��&��2�2&� 

 

 
 

4.6 ��������-�	
�.&���%&	' STAAD.etc 

�5
���&&
����+(��� ��',��4$
���	
/� ��&�
��01�,%�&�$� “.std” ��

��01�����
5� “.etc” 
2�  &�� � � 	 �� � ������� 01�,  STAAD �! &  Tut_01_portal.std �� � ��� � �!� & 01�, &&
����� 	�� � 
Tut_01_portal.etc ��4$
���	
/����	���
�� 
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APPLICATION EXAMPLES 
 

���������	
�����
��� Getting Started Manual ���������	����������
��������	�����������
��� 

a) ����������������������	��  !	 Graphical User Interface (GUI) 

b) ��������"��#$����	�%�&��	�� STAAD '��'#�����
�����&���"�� 

�����	����� GUI ()������)�	�%����	�����������
 �"�	�������(*�+��,��������"����� STAAD 	-��
&�)����#�
��&�)	�� 

1) STAAD �&.�/� $#��#$���0	������������$����������1� ������*�+� STAAD ()��&�)����#
��	"��	���������������������$�2��
��$�������&��	�� 

��������3��� GUI ������ 
#�����
������������$��/�%/������ �"�4�����	-�����3�&
�����&
������

���3�����*�+��,������
)��&�%% 

2) � 
#�,������&.���&�%%$��4��������������������3"�(��%���3�	"������������ 

��2�"������
���()������ 
#�����
�����������"��#$��"����	�%�&��	�� STAAD.Pro /5�������(��������"��#
$���&���� Notepad ���� WordPad 	-��� �"�3�����"�$��"����	�%�&��	��()��	��"�(��%��&�%%��������
'��'#�,����������& ���������	�&.���"���6"����������,����� "��
� �
)������ 

 

 
��	���������������"��#"�2��"������"���&��	�� $,�����
��	���� File > New 
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������(�"��������
��	 Open STAAD Editor 
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����(������"��#()�����52����������&����
��� 

 

�����('��'#�,�������	�����������

��������"��#���"�� ������� GUI ���������
 �&��	��()������,�����
�52����%�2���
�������"����"� �����������3����	�52��������"
���
�����
�	�
��	�����%�$�
%��# 

 

�����
��	(�	���� Edit > Edit Input Command File 
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Example Problem 1:  
Plane frame with steel design 
 

�
��(�	$,�	�������)�#���2���	 ()$,�	���
��	����"�����#����� �
)������������#�������	���&
�����&
� 
(5�"���$,�	�������)�#��	���2� "�����	��"�(��%��"�7������2��8�$��� 

 

����������"������
����� 
#�,�����()�����"����� 

 STAAD PLANE 

$8	� 
#�,�����()�����"������,��� STAAD ��� PLANE ()�&.���������������)��%��% /5�������
'�	��()
	,����"�����	� X �
)�	� Y 

	,��������$��()�������
�	�����%�$�
%��#�������&����
��� �����
��	���� Tools > Set Current Input 

Unit … 

 

�
��	��������� Meter �
)������� Metric Ton 

�����"�����������
 ����
�	�������� Geometry > Beam �
�	����� View From +Z (�	$�
%��# 

 

5 m 

4 m 

2 m 

4 m 4 m 

0.8 t/m (WL)  

6 t 6 t 

1.6 t/m (LL) 

12 t (LL) 

1.5 (WL) t/m 
1.2 (LL) 1.2 (LL) 
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������"��� Snap Node/Beam 	,���� Construction Lines: 

�����	� X : Left = 0, Right = 8, Spacing 1 m  

�����	� Y : Left = 0, Right = 11, Spacing 1 m 

	�&89� Snap Node/Beam �
���������������
����������#�/��# (	�&89� Ctrl �����"���	�������"��(8�"������) 

 

������
����/5��()�&.�����3�	()�'������#����� *�������#����� 5, 7 �
) 8  

�
�	�
��	���#����� 5 �
��	���� Geometry > Split Beam �%�������	�&.� 4 ����$��6	�� �����2��
��	 
Add n Points ������ n = 3 �������&����
��� 
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$,���������	��	�%����%��# 7 �
) 8 ����%���&.� 3 ����$��6	�� ������"��� Snap Node/Beam ����
�	
���� Snap to existing nodes too 

 

�'������#���������3�	�'����������&����
��� 

 
�%����������
� 2 ��	�&.��������$��6	���'��������%�2,����	%��$8	$��"���	�� 

������&!�� 
#�,�������()'%�������'��������2 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 5 0; 3 8 5 0; 4 8 0 0; 5 0 9 0; 6 8 9 0; 7 4 11 0; 8 2 9 0; 
9 4 9 0; 10 6 9 0; 11 1.33333 9.66667 0; 12 2.66667 10.3333 0; 
13 5.33333 10.3333 0; 14 6.66667 9.66667 0; 15 2.66667 5 0; 16 5.33333 5 0; 
MEMBER INCIDENCES 

1 1 2; 2 2 15; 3 3 4; 4 2 5; 5 5 8; 6 6 3; 7 5 11; 8 7 13; 9 8 9; 10 9 10; 
11 10 6; 12 11 12; 13 12 7; 14 13 14; 15 14 6; 16 11 8; 17 8 12; 18 12 9; 
19 9 13; 20 13 10; 21 10 14; 22 15 16; 23 16 3; 
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	,��������"��������#���������
��	(�	"������
-	 $,�����
�	�������� General > Property �
�	&89� 
Section Database (�	������"��� Properties – Whole Structure ��"������
-	$�������52���()�����
&�)�$0"���6�
��&�)�$0�"����������$� ����
��	"������� South Korean �
�	���� Material ��	 	�
&89� View Table �'�������"���� 

 

(�	"����$�������52�������
��	����"�������2 

W350X350X137 ����35�����"����� 350 �.�. 	��� 350 �.�. ���	 137 	.	./�. 

W250X250X72, W500X200X79, W450X200X66 �
) L100X100X10 

 

�
�	�
��	 Use Cursor To Assign 	,��������"��������#����������2 

Ref 1: 1, 3, 6 →→→→ ��� 

Ref 2: 4 →→→→ ��� 
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Ref 3: 2, 22, 23 →→→→ ��� 

Ref 4: 5, 7-13 →→→→ (��$���
)���� 

Ref 5: 16-21 →→→→ $����5�$��� 

��� 
#�,�����()&��	>������ 

MEMBER PROPERTY KOREAN 

1 3 6 TABLE ST W350X350X137 
4 TABLE ST W250X250X72 
2 22 23 TABLE ST W500X200X79 
5 7 TO 15 TABLE ST W450X200X66 
16 TO 21 TABLE ST L100X100X10 

�8?��%�"�����"��()��(�	"������
-	 ST ����35�����"���������"�7�� 

"�������()	,����������#�����$�� 16-21 �&.�����3�	 ���������%�@'�)���"�����	� ���������@����
)
�����"# $,��������
��	���#�����$��"���	������������$#�
)	�&89� Ctrl ������ 

(�	��2��
��	���� Commands > Member Specifications > Truss… ���� 

�
��	�������� General > Spec �
��
�	&89� Beam… ������(� Specifications – Whole Structure 

�
�	�
��	�3% Truss �
�	�&89� Add ()&��	>���	�� MEMBER TRUSS �����	�� 
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�
��	"��
��	 Assign To Selected Beams �
�	�&89� Assign ��� 
#�,�����()�����	���'����52���� 

MEMBER TRUSS 

16 TO 21 

���#����������
� 2 ()�&.�(8���8�$��&
�������"�� (MZ released) $,�������������
��	���#����� 2 	�&89� 
Beam… �
��	�3% Release �
��	",������ Start �
)�����"# MZ �������&����
��� 

 

�
�	&89� Add �
� Assign �������� ()&��	>(8���8��52�����&����
 � 
#�,�����()�����	���'����52���� 

MEMBER RELEASE 

2 START 

"����()	,�����8?��%�"����8 �������&
������������� Tools > Set Current Input Unit… 

�&
�������������(�	 Meter �&.� Centimeter �������(�	 Metric Ton �&.� Kilogram 

�
��	�������� General > Material 	�&89� Create �
���������
����2 

Young’s Modulus (E) : 2.05e6  kg/cm
2
 

Poisson’s Ratio (nu) :  0.3 

Density :   7.85  kg/cm
3
 

�
�	�
��	 Assign To View �
�	�&89� Assign ���� 

�
��	���� Command > Material Constants > Density… ������ 7.85 

�
��	���� Command > Material Constants > Elasticity… ������ 2.05e6 
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�
��	���� Command > Material Constants > Poisson’s … �
�	�
��	 STEEL 

� 
#�,�����()�����	���'����52���� 

UNIT CM KG 

CONSTANTS 

E 2.05e+006 MEMB 1 TO 23 

DENSITY 7.85 MEMB 1 TO 23 

POISSON STEEL MEMB 1 TO 23 

	,����(8������%����
�	�������� General > Support �����(8������%�%% Fixed ���
�(8�"�������
� 1 
�
)�%% Pinned 
�(8�"�������
� 4 ���	����� 
#�,�����$���'����52������ 

SUPPORTS 

1 FIXED 
4 PINNED 

��������&��	��'��'#�����
���%�����#����� ���������
�	�
��	���#����� 1, 2 �
) 16 (�	��2��
��	����
Command > Pre Analysis Print > Member Information… 

�
�	�
��	���#����� 1, 2, 4, 5, 16 �
��
��	���� Command > Pre Analysis Print > Member 

Properties… 

� 
#�,�����()�����	���'����52���� 

PRINT MEMBER INFORMATION LIST 1 2 16 
PRINT MEMBER PROPERTIES LIST 1 2 4 5 16 

"�����&.�	��	,�����2,����	%��$8	������	�?�$�� 1 �&.��2,����	%��$8	��$���
)�2,����	%��$8	(� �&$������
���� General > Load �
�	�
��	 Load Cases Details �
�	�&89� New… �'���������2,����	%��$8	���� 
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������"���$�������52����
�	�
��	�3% Load Case �
��
��	 Primary "�2������� DEAD AND LIVE 

LOAD �,�����$�������� 
#�,�������� 

LOAD 1 LOADTYPE None  TITLE DEAD AND LIVE LOAD 

���()���������2,����	"����	��� ����
�	�
��	 LOAD 1 : DEAD AND LIVE LOAD �����	���
��
�	
&89� Add… �
��	 Selfweight Load Y -1 �������& 

 

�,�����$�������� 

SELFWEIGHT Y -1 

"��������� Nodal Load �'��� ��� Fy = -6 ton �
)��		�?� Fy = -12 ton �����	��()�����&.� 

 

	,���� FY -6 ���(8�"�� 15 �
) 16 ��� FY -12 	,����
�(8�"�� �,�����$�������� 

JOINT LOAD 

15 16 FY -6 
9 FY -12 

����������������������������  �,�����$�������� 
MEMBER LOAD 

22 UNI GY -1.6 
7 8 12 TO 15 UNI Y -1.2 

������2,����	%��$8		�?�$�� 2 ���
�'����$��/��� �,�����$�������� 

LOAD 2 LOADTYPE None  TITLE WIND FROM LEFT 

MEMBER LOAD 

1 4 UNI GX 0.8 
7 12 13 UNI Y -1.5 
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������2,����	%��$8	��� ��� 75% ���	�?�$�� 1+2 �,�����$�������� 

LOAD COMB 3 75 PERCENT DL LL WL 

1 0.75 2 0.75 

 

��!"# �� �$���� %&'� �(�� ")*�+!�����,� 
PERFORM ANALYSIS PRINT ALL 

"�2����	�?��2,����	$�� 1 �
) 3 �����	$�  ����&$���������� Analysis/Print > Post-Print �
�	&89� Define 

Command… �
�	�3% Load List �
��		�?�$�� 1 �
) 3 �������& 
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�,�����$�������� 

LOAD LIST 1 3 

"�������()��������&��	��'��'#4
$�����(�		�������)�#��������� /5��()�����@'�)4
����2,����		�?�$�� 1 
�
) 3 "��$�����	,��������,����� LOAD LIST 

�&$���������� Analysis/Print > Post-Print �
�	&89� Define Command…  

- �
�	�3% Member Forces �
�	�&89� Add 

- �
�	�3% Support Reactions �
�	�&89� Add 

������"��� Post Analysis Print ()&��	>���	���52���� 

 
�
�	$�
)���	�� �
��	 Assign To View �
�	�&89� Assign 

�,�����$�������� 

PRINT MEMBER FORCES LIST 1 TO 23 

PRINT SUPPORT REACTION LIST 1 4 

"����()�&.���2�"��	����	�%% ���()�&.������������
-	 "����"�7�� AISC ��2�"����	���	�������
	,����'������"��#"���6����&$���������� Design > Steel ������"��� Steel Design �
�	�
��	 AISC 

ASD 
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�
�	&89� Select Parameters… �
��
��	'������"��#�������&����
��� 

 
�
�	&89� Define Parameters… ����"���$�������52���()�����	��'������"��#$������
��	�����	,������������2 

BEAM = 1 

KY = 1.2 

NSF = 0.85 

PROFILE = W14 

RATIO = 0.9 

�����$,����-(�
����	��()�����52������ 

 

$���������	������&.�������������,�3�������'��)��������� Assign ������#����� ����
�	�
��	$�
)���	���
� 
Assign ������#����������2 

 BEAM 1  →→→→ Assign To View 

 KY 1.2  →→→→ Use Cursor To Assign →→→→ MEMBER 3, 6 

 NSF 0.85  →→→→ Assign To View 

 PROFILE W14 →→→→ Use Cursor To Assign →→→→ MEMBER 1, 3, 6 

 RATIO 0.9  →→→→ Assign To View 

�,�����$�������� 

PARAMETER 

CODE AISC 

BEAM 1 ALL 

KY 1.2 MEMB 3 6 

NSF 0.85 ALL 

PROFILE W14 MEMB 1 3 6 
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RATIO 0.9 ALL 

"�������"���	����������&��	����	�%%����
��	����"��$��&�)����$���8������ $,��������
�	&89� 
Commands… ������"���$�������52����
��	���	�� SELECT 	�&89� Add �
� Assign To View 

�,�����$�������� 

SELECT ALL 

������&��	��()�
��	����"��$��&�)����$���8����$8	���#�����	-"�� �"���$��&>�%�"��
�������������"���$��
�
�	�
��(��	���&����������� 	��(��	
8��()�
��	����"��$����1�$���8���	
8�������	�%$8	���#�������
	
8�� /5��3�����	,����()���'�2�$����	���&���%�$��% $,�������	���
�	&89� Commands…  

�
��	���	�� Group �
��
�	&89� Add 

�����	��()���� ? GROUP MEMB ����
�	�
��	�
� Assign ������#����� 1 3 6 �,�����$�������� 

GROUP MEMB 1 3 6 

$,�"���,����%	
8��������� 

GROUP MEMB 2 22 23 

GROUP MEMB 7 8 12 TO 15 

GROUP MEMB 5 9 TO 11 

GROUP MEMB 16 TO 21 

���������"��3�	�
��	������()���������	�%$����������	�������)�#���� �����2�(5�"���$,�	�������)�#������	���2� 
PERFORM ANALYSIS 

-� ��&'� �.(/0������������1� 
PARAMETER 

BEAM 1.0 ALL 

RATIO 1.0 ALL 

TRACK 1.0 ALL 

-� ��&'� � TRACK 2����!"# �� �-&�-����� ����22$3,�3�%���('�3*)�� ()�2#������ 
CHECK CODE ALL 

�,���������%� ���#�����$����������1�$���8�$����4
	���,��?��������$���8� ()3�	"�(��%���&.��&"��
��"�7��������� 

STEEL TAKE OFF 

�,���������%�%�	����&��	���������	��&����?��
-	����"��"���6$����� 
FINISH 

(%� 
#�,����� ���� STAAD ��� 
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Example Problem 2:  
Area load generation on floor structure 
 

����������	
� (�������������� X-Z) ����������������������
�������	
�� ! "�#�������� 
$�������������
�
����������%����$���������� �� 

"���& '���
����������%��(�� �
��������$%�#�� ����
�����������)����� '�������*+���'���
������
����%�$����,��$��'��-��� !"���'��,. �����,���#�-"���& �
���������	
�� !��
� $�#���/���.���.0��
��������$%�
#�������� ��������&��	!��.���
����������%�$�/����������������*������) �����
��
����������%�� !/�������
$�������!� AREA LOAD $���,����������*������) 

 

��*!-#���.����- ��	��(�*�����������.0� Floor ��������-����.0� Meter ���������.0� Kilogram 

��	������� X-Y ���-%--�� View From +Y 

#�
� construction line ��� X = 0, 4, 1.5 �����������"���. 

 

4 @ 1.5 m = 6 m 

3 m 

4.5 m 

2 m 
1 m 2 m 

1 m 
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#�
� cons. line ��� Z = 0, 7, 1.5 ���������������"���. 

 

#�
� cons. line ��� Z = 0, 20, 0.5 ���������������"���. 

 

��	�������	!�����(���������������#��$�,�����"���. 
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'��-���-���� !/�������'1
�-��	� 

UNIT METER KG 

JOINT COORDINATES 

1 0 0 0; 2 1.5 0 0; 3 3 0 0; 4 4.5 0 0; 5 6 0 0; 6 6 0 3; 7 4.5 0 3; 

8 3 0 3; 9 1.5 0 3; 10 6 0 7.5; 11 1.5 0 7.5; 12 0 0 7.5; 13 6 0 9.5; 

14 0 0 9.5; 15 5 0 3; 16 4 0 3; 17 5 0 7.5; 18 3 0 7.5; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 4 4 5; 5 5 6; 6 4 7; 7 3 8; 8 2 9; 9 9 8; 10 6 10; 

11 10 17; 12 11 9; 13 1 12; 14 12 11; 15 10 13; 16 13 14; 17 14 12; 

18 8 16; 19 7 15; 20 15 6; 21 16 7; 22 17 18; 23 18 11; 24 15 17; 

25 16 18; 

����������#�� ,.���� General > Property ��*�.%2- Section Database ��	������#�� 

MEMBER PROPERTY KOREAN 

1 TO 25 TABLE ST W300X200X65 

������������ !$���-�� Command > Material Constant 

UNIT CM KG 

CONSTANTS 

E 2.05e+006 MEMB 1 TO 25 
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POISSON STEEL MEMB 1 TO 25 

"��$%�������� !#���������� 

 

SUPPORTS 

1 5 10 12 TO 14 FIXED 

������
����������%���& � ! 1 ���,.���� General > Load #�
�(	!���� 
LOAD 1 LOADTYPE None  TITLE 800 KG PER SQM DL+LL 

��*�.%2- Add… ��	�� Area Load $��������"����� 800 kg/m
2 ��	� 0.08 kg/cm

2 ���� assign "���%����)
����� ����.����-$��������.��"����� 

AREA LOAD 

1 TO 25 ALOAD 0.08 

���������������������� 

PERFORM ANALYSIS PRINT LOAD DATA 

�����!� PRINT LOAD DATA $�����������'���
����������%���"����)������ !/�������$�� AREA 

LOAD 

,.���� Design > Steel ��	������-*�#��)���"���.'������� 
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������������� 
 
PARAMETER 

CODE AISC 

BEAM 1 ALL 

DMAX 50 ALL 

UNT 30 ALL 

UNB 30 ALL 

�����!� PARAMETER "(�"������������������������ �����	��"(�-�#�3�� AISC ASD ����-*�#��) 
BEAM ������"�������������&�%�4���� 1/12 �������-������)����� DMAX ��� DMIN ���������
���-�1�-��� !�%��������� !�%�'�����)������ !$���	�� UNT ��� UNB �	����-���.��+$������1���
�'��
.5������.5�������	!�"(�"���������&������������ !��-"�� 

��*�.%2- Commands… ��	�������!� SELECT ��.%2- Add ��	�� Assign "�����)������ !#������ 

SELECT MEMB 2 6 10 12 13 16 TO 18 23 TO 25 

�.0������!�"���.����-��	������#��� !.������� !�%�$��#��������������)������ !/����	�� 

FINISH 

�����!�"���.����-�*
��%���������� 
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Example Problem 3:  
Soil springs for portal frame 
 

����������	
����������������������� ����������������� ��!"���������
���� ���#��!$�������%�����	�
&����������'�(�!���)*(��+��, �������� #��!$���������,�����'�(���#��%���!���#�
��, 

 

Soil subgrade reaction = 4,200 Ton/m
3
 

Spring constant calculation: 

Spring of joint 1, 5, 10 & 14   = 2.4 × 0.3 × 4,200 = 3,024 Ton/m 

Spring of joint 2, 3, 4, 11, 12 & 13  = 2.4 × 0.6 × 4,200 = 6,048 Ton/m 

���(-���!�#��- �
���.�������������!"� Plane 	��,��,�-��,�!"� Meter 	��,�#���!"� Metric Ton 

�
�������� X-Y #
�-/--�� View From +Z 

��� construction line #�, X = 2, 2, 0.6 ��������������0���! 

 

13 4 

Typ. Width : 2.4 m 

1.2 m 

2.4 m 

4 Ton/m 

4 Ton/m 

2 Ton 

2 Ton 

3 m 

3 m 

6 m 

1 2 3 5 11 12 14 10 

6 

7 8 

9 
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��� cons. line #�, X = 2, 8, 1 #�, Y = 0, 6, 1 #
�,������������0���! 

 

��� Grid origin X = 6, cons. line #�, X = 2, 2, 0.6 #�, Y = 0, 2, 1 #
�,�����������0���! 

 

�
��!/1- Close #
�,�
��� Label 0	�#���	-���
%�/��� 

�
���
����/���%��������%���%,� 

 

�
����-�� Geometry > Renumber > Nodes… �
������(��&% X-coor (ascending) ��&�� 
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%��-�
�-��
'�(��������%*��-���� 

UNIT METER KG 

UNIT METER MTON 

JOINT COORDINATES 

1 -1.2 0 0; 2 -0.6 0 0; 3 0 0 0; 4 0.6 0 0; 5 1.2 0 0; 6 0 3 0; 7 0 6 0; 

8 6 6 0; 9 6 3 0; 10 4.8 0 0; 11 5.4 0 0; 12 6 0 0; 13 6.6 0 0; 

14 7.2 0 0; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 4 4 5; 5 3 6; 6 6 7; 7 7 8; 8 8 9; 9 9 12; 10 6 9; 

11 10 11; 12 11 12; 13 12 13; 14 13 14; 

�+�	��	����� &!	��� General > Property �
��!/1- Define… �
��� Rectangular 0����� YD #
� ZD 

MEMBER PROPERTY 

1 4 11 14 PRIS YD 0.3 ZD 2.4 

2 3 12 13 PRIS YD 0.6 ZD 2.4 

�
��!/1- Section Database �
���	����� 

MEMBER PROPERTY KOREAN 

5 6 8 9 TABLE ST W250X250X64 

7 10 TABLE ST W300X150X36 

�!
�(��	��,��,�-��,�!"� Centimeter 	��,�#���!"� Kilogram 

UNIT CM KG 

�
������2����� 5, 6, 7, 8, 9, 10 #
�,�+�	�������'�(����-�� Command > Material Constant 

CONSTANTS 

E 210000 MEMB 1 TO 4 11 TO 14 

E 2.05e+006 MEMB 5 TO 10 

DENSITY 7.85 MEMB 5 TO 10 

DENSITY 2.4 MEMB 1 TO 4 11 TO 14 

POISSON STEEL MEMB 5 TO 10 

POISSON CONCRETE MEMB 1 TO 4 11 TO 14 

&!���	��� General > Support �
��!/1- Create �
���#�� Fixed But #
�,0�������3���0�#�, FY ��,�
#�,��(��*�����	-����,�� MZ 

�,��������
����-�� View > Table 
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SUPPORTS 

1 5 10 14 FIXED BUT MZ KFY 30240 

2 TO 4 11 TO 13 FIXED BUT MZ KFY 60480 

�������+�	������'/��� �'�( 1 ���&!	��� General > Load ���.�(�,�� 
LOAD 1 LOADTYPE None  TITLE DEAD AND WIND LOAD COMBINED 

�
��!/1- Add… �
��� Selfweight '�4'�� Y -1 

SELFWEIGHT Y -1 

��������	�
����������� 
JOINT LOAD 

6 7 FX 2000 
���������	������� 

MEMBER LOAD 

7 10 UNI Y -40 

 
&!	������� Analysis/Print > Analysis �
��� No Print �
��!/1- Add 

PERFORM ANALYSIS  

&!	������� Post-Print �
��!/1- Define Commands… �
��#�� Analysis Results #
�,��!/1- Add 

PRINT ANALYSIS RESULTS 

FINISH 

�+���(�0	��!�#��-�����/����'+���� 
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Example Problem 4:  
Inactive members in a braced frame 
 

��������	
������������������
���	
���	�����������
�	����	���� ���!�����	�����	 ���
���#����	��$%��

&$�
�
�'�	�	�����$%��
�����	(���� ��
�� 	
���� ��������	
����
�'�	�	��$%��
�(���� ��
��% 

 

��)������������ ��*��+�)%���
���	
���� Plane �������	��	����� Meter �������
���� Metric Ton 

��*�����	  X-Y ����!���
 View From +Z 

���
 construction line ��� X = 0, 2, 6 ��� Y = 0, 2, 4 �������	
���
%�
���,� 

 

4 m 

4 m 

12 ton 

6 ton 

6 m 6 m 
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-���,����%����.,����	
-$���	�*� 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 4 0; 3 6 0 0; 4 6 4 0; 5 6 8 0; 6 12 8 0; 7 12 4 0; 

8 12 0 0; 

MEMBER INCIDENCES 

1 1 2; 2 3 4; 3 4 5; 4 5 6; 5 6 7; 6 7 8; 7 2 4; 8 1 4; 9 3 2; 10 3 7; 

11 8 4; 12 4 7; 13 7 5; 14 4 6; 

����	��	���	��%����
�'�	�	��$%��
�������
.�� ��*���
�'�	�	�������
�	��%��%�!/� Ctrl ��	
(�� 

 

	�������*�����, Commands > Member Specifications > Truss… ��*� 

��*�����	���� General > Spec ������)��!/� Beam… �����	� Specifications – Whole Structure 

��)���*���.  Truss �����%�!/� Add ���	�0�	��	� MEMBER TRUSS ���	��	� 

��*�������*�� Assign To Selected Beams �����%�!/� Assign ��(1�'��	���
����	��	��2)��-$���*� 

MEMBER TRUSS 

8 TO 11 13 14 

��	��%���	��% (����	 General > Property ��)��!/� Section Database ��*�����	��% 

MEMBER PROPERTY AMERICAN 

1 TO 3 5 6 TABLE ST W12X26  (!"#) 

4 7 12 TABLE ST W18X35  (%#&) 
8 TO 11 13 14 TABLE LD L50505 ('(%)'#%#*+,-.+() 
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�+����	��%�	��	�	
 American (AISC) ��	��	 ST ����		� standard single section ������	��	 LD ���
�		� long leg back-to-back double angle ��*��
	�������	
�����	
���#�3	�(��(%��%������(�� %�
����
�.,���	��%��	���� 0.0 

��*�����, Tools > Set Input Current Unit… ���������������� 

UNIT CM KG 

������	��%��	�
���	����, Command > Material Constant 

CONSTANTS 

E 2.05e+006 MEMB 1 TO 14 

POISSON STEEL MEMB 1 TO 14 

��	���
 CONSTANT �+���	��%�!��� ��)���%!�+�� E (modulus of elasticity), Poisson’s ratio, etc �+�
��	�������,����������-�
���#���	��� ��	���
 

SUPPORTS 

1 3 8 PINNED 

��	��%!%��
�� �  ��!������ !%��� 1, 3 ��� 8 

����	��	���	��%����
�'�	�	��$%��
�����   inactive �%���)���*���
�'�	�	�������
�	����� 

��*�����, Commands > Member Specifications > Inactive… ��*� 

(�������	���� General > Spec ��)��!/� Beam… �����	��	
 Specification �	
%�	�-�	-�
���	� 

��*�����	��	
������4%-$���	�����*���.  Inactive ������)��!/� Add ��*���)5� Assign To Selected Beam 

�����%�!/� Assign �����	���
�2)��-$���*� 

INACTIVE MEMBER 8 TO 11 13 14 

��	��)1���-�
�
�'�	�	����.,���*���(��.,���	�	�)%���	���	��� ����	�.,����
��������1�������
 

��*�����, Tools > Set Input Current Unit… ���������������� 

UNIT METER MTON 

���	
���	���� ���!�������� 1 �%�(����	 General > Load ���
+*����	 

LOAD 1 DEAD AND LIVE LOAD 

��)��!/� Add… ��*�� Member Load > Uniform Force �)6�	
 Y -1 

MEMBER LOAD 

4 7 UNI GY -1.5 

12 UNI GY -2 
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���
���������	�	��)���	��' �%�(����	 Analysis/Print > Analysis  

��*�� No Print Option ��)��!/� Add 

PERFORM ANALYSIS 

����	
�����������	���������������������������� !"	���#�$#���	���	��#���� 

����	��)��!/� Define Commands… ��*���.  Change ������)��!/� Add 

CHANGE 

��	���
������	����
�'�	�	����.,� Inactive (��������	��� ��� �	���7	2���*���%)� 

��	������*���
�'�	�	�%�
���,�-�	
��	
�������
��� Inactive 

 

INACTIVE MEMBER 9 11 13 

���	
���	���� ���!�������� 2 ������
��	��	
%�	�&�	� 

LOAD 2 WIND FROM LEFT 
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�����
�������	���!%��� 

JOINT LOAD 

5 FX 6 

2 FX 12 

 

���
���������	�	��)���	��' �%�(����	 Analysis/Print > Analysis  

��*�� No Print Option ��)��!/� Add 

PERFORM ANALYSIS 

����	��)��.  Change ������)��!/� Add 

CHANGE 

��	������*���
�'�	�	�%�
���,�-�	
��	
�������
��� Inactive 

INACTIVE MEMBER 8 10 14 
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���	
���	���� ���!�������� 2 ������
��	��	
%�	�-�	 

LOAD 3 WIND FROM RIGHT 

�����
�������	���!%��� 

JOINT LOAD 

6 FX -6 

7 FX -12 

 

���	
���	���� ���!����� 4 ��� 5 �����   Combination �����	
���� 1 ��  2 ��� 1 ��  3 %�
��� 
LOAD COMB 4 COMBINATION LOAD CASE 4 
1 0.75 2 0.75 
LOAD COMB 5 COMBINATION LOAD CASE 5 
1 0.75 3 0.75 
PERFORM ANALYSIS  

CHANGE 

(����	���� Post-Print ��)��!/� Define Commands…  

��)��.  Load List ��*���!��������	���� ���!� ��)��!/� Add 

��)��.  Member Forces �%�!/� Add �����%�!/� Close 

��)���*���	��	� PRINT MEMBER FORCES ���� assign to view 

LOAD LIST ALL 

PRINT MEMBER FORCES LIST 1 TO 14 

+"�!���,������������-��� 
LOAD LIST 1 4 5 

(����	 Design > Steel ��*���	��8	� AISC ASD  
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PARAMETER 

CODE AISC 

BEAM 1 ALL 

KY 0.5 ALL 

UNB 4 ALL 

UNT 4 ALL 

,������ 

CHECK CODE ALL 
FINISH 

��	���
�����������)���!%�	���	
	� 
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Example Problem 5:  
Support settlement on a portal frame 
 

��������	
�����	�����������
������	����������������
�	����� 

 

��������� �!��� �����#������
���	
� $� Space %������	��	�� $� Meter %����!�
� $� Metric Ton 

��������	� X-Y !�������
 View From +Z 

���
 construction line !�� X = 0, 2, 3 !�� Y = 0, 1, 3 !������	
���
��
���&  

 

����������
 Isometric View ���	� Y-Z !�� Grid Origin(m): X, Y, Z = 6, 0, 0 

���
 construction line !�� Y = 0, 1, 3 !�� X = 0, 2, 3 !������	
���
��
���&  

X 

Z 

3 m 

6 m 

Y 

6 m 
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'���&������(��)&����	
'*���	��� 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 3 0; 3 6 3 0; 4 6 0 0; 5 6 3 6; 6 6 0 6; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 4 3 5; 5 5 6; 

� �����%������	��	�� $� Centimeter 

�+	%��%��	��� , %��	 General > Property ���� �-� Define… ����� General �����	��
��� 

 

����� Assign To View !������� �-� Assign �,�� 
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UNIT CM MTON 

MEMBER PROPERTY 

1 TO 5 PRIS AX 60 IX 400 IY 12000 IZ 12000 

��������& Tools > Set Input Current Unit… � �����%����� $� 

UNIT CM KG 

!����+	%����	�
(��	����& Command > Material Constant 

CONSTANTS 

E 2.05e+006 MEMB 1 TO 5 

POISSON STEEL MEMB 1 TO 5 

�+	���
 CONSTANT �#��+	%�����������������#�� E (modulus of elasticity), Poisson’s ratio, etc �#�
��	(������&���� �!���'�
�%�.��+	%�����	%��
 

SUPPORTS 

1 4 6 FIXED 

�+	%������
���!��%����%��������� 1, 4 !�� 6 

���	
��+	%������(������(�� 1 ���, %��	 General > Load ���
#�����	 

LOAD 1 SINKING SUPPORT 

���� �-� Add… ����� Nodal Load > Support Displacement �����	 -1 cm (�/(	
 FY ���� �-� Add 

Assign �%������ 4 

SUPPORT DISPLACEMENT LOAD 

4 FY -1 

���
� �!���(+	�	������	�%0 ���, %��	 Analysis/Print > Analysis  

����� No Print Option ���� �-� Add 

PERFORM ANALYSIS 

, %��	���� Post-Print ���� �-� Define Commands…  

����!)� Analysis Results ���� �-� Add 

FINISH 

�+	���
�%�� �!�����������	�(+	
	� 
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Example Problem 6:  
Prestress and poststress loading 
 

��������	
�������������������������������������������  �!"#��#$����%&�'� 1) !"��$
�	�����
��� ����&������"($)�����*�	��#
���"( ��+'��	)
�������#���� (�������!��"	�
���� ���� 
PRESTRESS) �+� 2) ��������!".+�/0�������&�������	*!
!"��$
�	��������*�	��#
���"(��+'����
����#���� (�������!��"	�
�������� POSTSTRESS) 

 

 

��1(!��������! �+'���1�����#�������� Plane ��
�	���!	������ Meter ��
�	������� Metric Ton 

�+'������ X-Y �+�!�!!�� View From +Z ��	�+1*����  ���)+���& 

���� construction line ��� X = 0, 1, 12 ��� Y = 0, 10, 1.5 �+��#��������������)� 

12 m 

1 

1 

2 

3 

3 

5 

7 

Y 

2 

4 

6 

8 

7 

8 

9 

4 

5 

6 

6 m 

4.5 m 

4.5 m 
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�������"	�+������!�	�+� node �+� member ��!
 ��1(! � node ��	�+'� node �����!� 23(��� �+'���	
��� node cursor ��'��+'��!�) Select > By All > All Nodes �� node �"($)�+'� �+�	����#"��� 

�+'��!�) Geometry > Renumber > Nodes…  ����4+
��������! 

 

�!'(��+1 Yes  ����4+
��������! Renumber ����������'(��*������5�0����+
�� 
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�!'(��+1��6! Accept �!�	�+� node  �$) ����"	���!
 

+���������"	��!�	�+� member �) �*����!�"(������ 

���!)+�!��+�"($)#�����3��!��'� 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 12 0 0; 3 0 6 0; 4 12 6 0; 5 0 10.5 0; 6 12 10.5 0; 7 0 15 0; 

8 12 15 0; 

MEMBER INCIDENCES 

1 1 3; 2 3 5; 3 5 7; 4 2 4; 5 4 6; 6 6 8; 7 3 4; 8 5 6; 9 7 8; 

����� ����������	�+1�+'��$� General > Support  

#���� ����������� Fixed �+�� Assign ��� node �"( 1 �+� 2 ��'���"	���*7+&���!)+�
� 
SUPPORTS 

1 2 FIXED 

�������%#!���1�������������&����� ��
������+"(	���
�	
����	�+'��!�)  

Tools > Set Current Input Unit… 

��+"(	���
�	���!	������ Centimeter �+���
�	������� Kilogram 

������������ *����� General > Property �+1��6! Define… �+'� General �#
�
�����"� 

 

�+'� Assign To View �+���+1��6! Assign  �*�� 
UNIT CM KG 

MEMBER PROPERTY 

1 TO 9 PRIS AX 2400 IZ 720000 
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�+��������
����"( ��!�) Command > Material Constant �+'�������
� E (modulus of 

elasticity) �+� Poisson’s ratio ����"� 
UNIT CM KG 

CONSTANTS 

E 280000 MEMB 1 TO 9 

POISSON CONCRETE MEMB 1 TO 9 

�������
�	������� Mton ��
�	���!	������ cm  

#�����������������%"�"( 1 ��	*����� General > Load �����'(��
� 
LOAD 1 PRESTRESSING LOAD 

�+1��6! Add… �+'� Member Load > Pre/Post Stress �#
���!)+��!���)�����+
�� 

 
 

Assign ������&����� 7 �+� 8 ��'����#�����+
��  �*�����!)+����"� 
UNIT CM MTON 

LOAD 1 LOADTYPE None  TITLE LOAD 1 PRESTRESSING LOAD 

MEMBER PRESTRESS LOAD 

7 8 FORCE 136 ES 7.5 EM -30 EE 7.5 

�������������&����� 7 �+� 8 !"�����+�������� 136 ��� ������
�����1�+�"( ����1(!��� ES �+� ��#1��#�� 
EE �'� 7.5 2!. ���'� ��9)�	&$
��������� #
���"(+���
�����!	�� EM �	)
�(���
� c.g. +�!� 30 2!. 

����� LOAD CASE 2 ������� POSTSTRESS #
�����!)+�'(���!'���� ����"� 
LOAD 2 LOADTYPE None  TITLE LOAD 2 POSTSTRESSING LOAD 

MEMBER POSTSTRESS LOAD 

7 8 FORCE 136 ES 7.5 EM -30 EE 7.5 

#�(������!������1������& ��	*����� Analysis/Print > Analysis  

�+'� No Print Option �+1��6! Add 

PERFORM ANALYSIS 
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*�����	
�	 Post-Print �+1��6! Define Commands…  

�+1�$� Analysis Results �+1��6! Add 

FINISH 

���#�(���������!#1��#���������� 

�+'��!�) Analyze > Run Analysis … �!'(������%�#�� ��	*!
!"���.1�0+������+'� View Output File 

 

 

             **************************************************** 

             *                                                  * 

             *           STAAD.Pro                              * 

             *           Version  2005    Bld 1001.US           * 

             *           Proprietary Program of                 * 

             *           Research Engineers,  Intl.             * 

             *           Date=    APR  7, 2006                  * 

             *           Time=    14:48:28                      * 

             *                                                  * 

             *      USER ID: Suranaree University of Technolo   * 

             **************************************************** 

 

  

  

     1. STAAD PLANE 

INPUT FILE: EX6.STD 

     2. START JOB INFORMATION 

     3. ENGINEER DATE 07-APR-06 

     4. END JOB INFORMATION 

     5. INPUT WIDTH 79 

     6. UNIT METER MTON 

     7. JOINT COORDINATES 

     8. 1 0 0 0; 2 12 0 0; 3 0 6 0; 4 12 6 0; 5 0 10.5 0; 6 12 10.5 0; 7 0 15 0 

     9. 8 12 15 0 

    10. MEMBER INCIDENCES 

    11. 1 1 3; 2 3 5; 3 5 7; 4 2 4; 5 4 6; 6 6 8; 7 3 4; 8 5 6; 9 7 8 

    12. UNIT CM KG 

    13. MEMBER PROPERTY 

    14. 1 TO 9 PRIS AX 2400 IZ 720000 

    15. UNIT METER MTON 

    16. SUPPORTS 

    17. 1 2 FIXED 

    18. UNIT CM KG 

    19. CONSTANTS 

    20. E 280000 MEMB 1 TO 9 

    21. POISSON CONCRETE MEMB 1 TO 9 

    22. UNIT CM MTON 

    23. LOAD 1 LOADTYPE NONE  TITLE LOAD 1 PRESTRESSING LOAD 

    24. MEMBER PRESTRESS LOAD 

    25. 7 8 FORCE 136 ES 7.5 EM -30 EE 7.5 

    26. LOAD 2 LOADTYPE NONE  TITLE LOAD 2 POSTSTRESSING LOAD 

    27. MEMBER POSTSTRESS LOAD 

    28. 7 8 FORCE 136 ES 7.5 EM -30 EE 7.5 

    29. PERFORM ANALYSIS 

    STAAD PLANE                                              -- PAGE NO.    2 

 

 

  

  

            P R O B L E M   S T A T I S T I C S 

            ----------------------------------- 

  

     NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS =     8/     9/     2 

     ORIGINAL/FINAL BAND-WIDTH=     2/     2/      9 DOF 

     TOTAL PRIMARY LOAD CASES =    2, TOTAL DEGREES OF FREEDOM =     18 

     SIZE OF STIFFNESS MATRIX =        1 DOUBLE  KILO-WORDS 

     REQRD/AVAIL. DISK SPACE  =     12.0/  23852.2 MB 

  

 

  

  

    30. PRINT ANALYSIS RESULTS 

    STAAD PLANE                                              -- PAGE NO.    3 

 

 



STAAD.Pro 2005: Application Examples  Ex 6 - 6 

 

  

  

   JOINT DISPLACEMENT (CM   RADIANS)    STRUCTURE TYPE = PLANE 

   ------------------ 

  

 JOINT  LOAD   X-TRANS   Y-TRANS   Z-TRANS   X-ROTAN   Y-ROTAN   Z-ROTAN 

  

 

      1    1     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      2    1     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      3    1     0.1237    0.0000    0.0000    0.0000    0.0000    0.0004 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      4    1    -0.1237    0.0000    0.0000    0.0000    0.0000   -0.0004 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      5    1     0.1159    0.0000    0.0000    0.0000    0.0000    0.0007 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      6    1    -0.1159    0.0000    0.0000    0.0000    0.0000   -0.0007 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      7    1    -0.0011    0.0000    0.0000    0.0000    0.0000    0.0000 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

      8    1     0.0011    0.0000    0.0000    0.0000    0.0000    0.0000 

           2     0.0000    0.0000    0.0000    0.0000    0.0000    0.0000 

    STAAD PLANE                                              -- PAGE NO.    4 

 

 

  

  

   SUPPORT REACTIONS -UNIT MTON CM      STRUCTURE TYPE = PLANE 

   ----------------- 

  

 JOINT  LOAD   FORCE-X   FORCE-Y   FORCE-Z     MOM-X     MOM-Y     MOM Z 

  

 

      1    1     -2.73      0.00      0.00      0.00      0.00    683.74 

           2      0.00      0.00      0.00      0.00      0.00      0.00 

      2    1      2.73      0.00      0.00      0.00      0.00   -683.74 

           2      0.00      0.00      0.00      0.00      0.00      0.00 

    STAAD PLANE                                              -- PAGE NO.    5 

 

 

  

  

   MEMBER END FORCES    STRUCTURE TYPE = PLANE 

   ----------------- 

   ALL UNITS ARE -- MTON CM 

  

  MEMBER  LOAD  JT     AXIAL   SHEAR-Y  SHEAR-Z   TORSION     MOM-Y      MOM-Z 

  

 

  

      1    1     1      0.00      2.73     0.00      0.00      0.00     683.74 

                 3      0.00     -2.73     0.00      0.00      0.00     951.82 

           2     1      0.00      0.00     0.00      0.00      0.00       0.00 

                 3      0.00      0.00     0.00      0.00      0.00       0.00 

  

      2    1     3      0.00      6.35     0.00      0.00      0.00    1294.14 

                 5      0.00     -6.35     0.00      0.00      0.00    1562.36 

           2     3      0.00      0.00     0.00      0.00      0.00       0.00 

                 5      0.00      0.00     0.00      0.00      0.00       0.00 

  

      3    1     5      0.00      1.27     0.00      0.00      0.00     583.01 

                 7      0.00     -1.27     0.00      0.00      0.00     -11.63 

           2     5      0.00      0.00     0.00      0.00      0.00       0.00 

                 7      0.00      0.00     0.00      0.00      0.00       0.00 

  

      4    1     2      0.00     -2.73     0.00      0.00      0.00    -683.74 

                 4      0.00      2.73     0.00      0.00      0.00    -951.82 

           2     2      0.00      0.00     0.00      0.00      0.00       0.00 

                 4      0.00      0.00     0.00      0.00      0.00       0.00 

  

      5    1     4      0.00     -6.35     0.00      0.00      0.00   -1294.14 

                 6      0.00      6.35     0.00      0.00      0.00   -1562.36 

           2     4      0.00      0.00     0.00      0.00      0.00       0.00 

                 6      0.00      0.00     0.00      0.00      0.00       0.00 

  

      6    1     6      0.00     -1.27     0.00      0.00      0.00    -583.01 

                 8      0.00      1.27     0.00      0.00      0.00      11.63 

           2     6      0.00      0.00     0.00      0.00      0.00       0.00 

                 8      0.00      0.00     0.00      0.00      0.00       0.00 
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      7    1     3    138.56    -17.00     0.00      0.00      0.00   -3265.96 

                 4   -138.56    -17.00     0.00      0.00      0.00    3265.96 

           2     3    134.93    -17.00     0.00      0.00      0.00   -1020.00 

                 4   -134.93    -17.00     0.00      0.00      0.00    1020.00 

  

      8    1     5    129.86    -17.00     0.00      0.00      0.00   -3165.38 

                 6   -129.86    -17.00     0.00      0.00      0.00    3165.38 

           2     5    134.93    -17.00     0.00      0.00      0.00   -1020.00 

                 6   -134.93    -17.00     0.00      0.00      0.00    1020.00 

  

      9    1     7     -1.27      0.00     0.00      0.00      0.00      11.63 

                 8      1.27      0.00     0.00      0.00      0.00     -11.63 

           2     7      0.00      0.00     0.00      0.00      0.00       0.00 

                 8      0.00      0.00     0.00      0.00      0.00       0.00 

    STAAD PLANE                                              -- PAGE NO.    6 

 

  

  

   ************** END OF LATEST ANALYSIS RESULT ************** 

  

  

    31. FINISH 

  

  

             *********** END OF THE STAAD.Pro RUN *********** 
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Example Problem 7:  
Modelling offset connections in a frame 
 

��������	
������������������������
������ OFFSET �������������	�� ����	�	�!"	�#����������#����
$
��������	%�������&����' ������ ����� ���!"	�#�����������("���������)'�����*�+	���� MEMBER 

OFFSETS 

 

�������	�,����� �� ��'	�����������,-	 Plane +	�����������,-	 Meter +	�������,-	 Metric Ton 

�� ����	�& X-Y ��������� View From +Z �������%���	  &	$"�&��# 

���� construction line �	� X = 0, 1, 6 �	� Y = 0, 2, 4.5 ���������������)	�", 

 

4.5 m 

4.5 m 

6 m 

17.5 cm 17.5 cm 

15 cm 
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����"������$
�("��������	��� � 

STAAD PLANE 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 4.5 0; 3 0 9 0; 4 6 9 0; 5 6 4.5 0; 6 6 0 0; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 4 4 5; 5 5 6; 6 2 5; 7 5 1; 

�*�+	�+	�����)+����#����� ��������� ���(& General > Property 

����,�.� Section Database )	+	������ Properties 

�� ��+	������+�/� South Korean �������+� �	��	���%$�$
��� 

�� �� W Shape : W350x350x131 ��������,�.� Add ����)	������ 

�� �� W Shape : W300x150x36 ��������,�.� Add ����)	������ 

�� �� Angle ������������ �� LD = Long leg back-to-back double angle : L150x90x16 

Assign +	����� W350x350x131 )+��,-	�� 

Assign +	����� W300x150x36 )+��,-	��	 

Assign +	����� L150x90x16 )+��,-	$��	���$��� 

����"������$
�("��������	��� � 

MEMBER PROPERTY KOREAN 

1 2 4 5 TABLE ST W300X150X36 

3 6 TABLE ST W350X350X131 

7 TABLE LD L150X90X16 

�����������	� OFFSET 
�����������������������	� 

$*�%����������� ���(& General > Spec ����,�.� Beam… 

�� ��+	����)+��������	��)+��� ���(& Offset �� �� Start )���� 0.175 m ���)	�", �������� Add 

����,�.� Beam.. > Offset > End > -0.175 m )	��	 X 

Assign $����� Offset )+���	 

����,�.� Beam.. > Offset > End > -0.175 m )	��	 X ��� -0.15 m )	��	 Y 

MEMBER OFFSET 

3 6 START 0.175 0 0 

3 6 END -0.175 0 0 

7 END -0.175 -0.15 0 
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�*�+	���������&��������� ���(& General > Support  

������������&�&& Pinned ���� Assign )+� node $
� 1 ��� 6 +� ���
�	)	%0�#����"���� 
SUPPORTS 

1 6 PINNED 

�*�+	�	�*�+	��&��$����������� ���(& General > Load 

����,�.� New… ������ ���(& Load Case ����' ����� WIND LOAD �*����$
�)'�� � 

LOAD 1 LOADTYPE None  TITLE WIND LOAD  

)	����������� WIND LOAD �1������	�� )+������� ��������,�.� Add… 

 

�� �� Nodal Load )���� Fx = 10 Mton ��� 20 Mton ���� Assign )+� node 2 ��� 3 +� �1��1#�*���� 
JOINT LOAD 

2 FX 10 

3 FX 20 
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������ ���(& Analysis/Print �������� Add )	+	������$
�������	�� �*����$
�)'�� � 

PERFORM ANALYSIS 

�����(& Post-Print ��,�.� Define Commands… 

�� �� WIND LOAD ����)	 Load List 

�����(& Member Forces ��� Support Reaction ����)'� Assign To View 

�� ����	" Analyze > Run Analysis 

 

 

             **************************************************** 

             *                                                  * 

             *           STAAD.Pro                              * 

             *           Proprietary Program of                 * 

             *           Research Engineers,  Intl.             * 

             *                                                  * 

             **************************************************** 

  

     1. STAAD PLANE 

INPUT FILE: Ex7.STD 

     2. START JOB INFORMATION 

     3. ENGINEER DATE 25-APR-06 

     4. END JOB INFORMATION 

     5. INPUT WIDTH 79 

     6. UNIT METER MTON 

     7. JOINT COORDINATES 

     8. 1 0 0 0; 2 0 4.5 0; 3 0 9 0; 4 6 9 0; 5 6 4.5 0; 6 6 0 0 

     9. MEMBER INCIDENCES 

    10. 1 1 2; 2 2 3; 3 3 4; 4 4 5; 5 5 6; 6 2 5; 7 5 1 

    11. DEFINE MATERIAL START 

    12. ISOTROPIC STEEL 

    13. E 2.09042E+007 

    14. POISSON 0.3 

    15. DENSITY 7.83341 

    16. ALPHA 1.2E-005 

    17. DAMP 0.03 

    18. END DEFINE MATERIAL 

    19. MEMBER PROPERTY KOREAN 

    20. 1 2 4 5 TABLE ST W300X150X36 

    21. 3 6 TABLE ST W350X350X131 

    22. 7 TABLE LD L150X90X16 

    23. CONSTANTS 

    24. MATERIAL STEEL MEMB 1 TO 7 

    25. MEMBER OFFSET 
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    26. 3 6 START 0.175 0 0 

    27. 3 6 END -0.175 0 0 

    28. 7 END -0.175 -0.15 0 

    29. SUPPORTS 

    30. 1 6 PINNED 

    31. LOAD 1 LOADTYPE NONE  TITLE WIND LOAD 

    32. JOINT LOAD 

    33. 2 FX 10 

    34. 3 FX 20 

    35. PERFORM ANALYSIS 

     

            P R O B L E M   S T A T I S T I C S 

            ----------------------------------- 

  

     NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS =     6/     7/     2 

     ORIGINAL/FINAL BAND-WIDTH=     4/     4/     13 DOF 

     TOTAL PRIMARY LOAD CASES =    1, TOTAL DEGREES OF FREEDOM =     14 

     SIZE OF STIFFNESS MATRIX =        1 DOUBLE  KILO-WORDS 

     REQRD/AVAIL. DISK SPACE  =     12.0/  23810.0 MB 

  

    36. PRINT MEMBER FORCES LIST 1 TO 7 

     

   MEMBER END FORCES    STRUCTURE TYPE = PLANE 

   ----------------- 

   ALL UNITS ARE -- MTON METE 

  

  MEMBER  LOAD  JT     AXIAL   SHEAR-Y  SHEAR-Z   TORSION     MOM-Y      MOM-Z 

  

      1    1     1    -14.47     -0.17     0.00      0.00      0.00       0.61 

                 2     14.47      0.17     0.00      0.00      0.00      -1.37 

  

      2    1     2     -7.47      9.97     0.00      0.00      0.00      22.50 

                 3      7.47     -9.97     0.00      0.00      0.00      22.36 

  

      3    1     3     10.03     -7.47     0.00      0.00      0.00     -21.05 

                 4    -10.03      7.47     0.00      0.00      0.00     -21.14 

  

      4    1     4      7.47     10.03     0.00      0.00      0.00      22.45 

                 5     -7.47    -10.03     0.00      0.00      0.00      22.69 

  

      5    1     5     37.50     -0.36     0.00      0.00      0.00      -1.63 

                 6    -37.50      0.36     0.00      0.00      0.00       0.00 

  

      6    1     2     20.14     -7.00     0.00      0.00      0.00     -19.91 

                 5    -20.14      7.00     0.00      0.00      0.00     -19.63 

  

      7    1     5    -38.25      0.03     0.00      0.00      0.00       0.21 

                 1     38.25     -0.03     0.00      0.00      0.00       0.06 

  

   ************** END OF LATEST ANALYSIS RESULT ************** 

  

    37. PRINT SUPPORT REACTION LIST 1 6 

 

   SUPPORT REACTIONS -UNIT MTON METE    STRUCTURE TYPE = PLANE 

   ----------------- 

  

 JOINT  LOAD   FORCE-X   FORCE-Y   FORCE-Z     MOM-X     MOM-Y     MOM Z 

  

 

      1    1    -30.36    -37.50      0.00      0.00      0.00      0.00 

      6    1      0.36     37.50      0.00      0.00      0.00      0.00 

  

  

   ************** END OF LATEST ANALYSIS RESULT ************** 

  

  

    38. FINISH 
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Example Problem 8:  
Concrete design for a space frame 
 

��������	
������������������������������	
�
���	�	���
���
������
�	����� �	�� 	��!�������
��"��
�	��������������������	������	 �������"#���$%������	�	&'��'��	������	��� P-Delta 

 

���(�����)����� ��*��+��'���
���	
�),� Space �������	��	��),� Meter �������
�),� Metric Ton 

��*�����	� X-Y ����#���
 View From +Z 

���
 construction line ��� X = 0, 2, 6 ��� Y = 0, 2, 3 �������	
���
'�
���%) 

 

��*���#���
 Isometric View ������*��"#��
���	�	� 

��*�����% Geometry > Translational Repeat… ��*(������	���'
�-���	�����	'�
��� 

Global direction: Z  

No of Steps: 1 

Step Spacing: 6 

X 

Z 

Y 
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��*(����� OK �&'����
���	
 

 
����%����'�"�(.%����	
�-���	�*� 

UNIT METER MTON 

JOINT COORDINATES 

1 0 0 0; 2 0 3 0; 3 6 3 0; 4 6 0 0; 5 6 6 0; 6 12 6 0; 7 12 3 0; 

8 12 0 0; 9 0 0 6; 10 0 3 6; 11 6 3 6; 12 6 0 6; 13 6 6 6; 14 12 6 6; 

15 12 3 6; 16 12 0 6; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 4 3; 4 3 5; 5 5 6; 6 6 7; 7 7 8; 8 3 7; 9 2 10; 10 3 11; 

11 5 13; 12 6 14; 13 7 15; 14 9 10; 15 10 11; 16 12 11; 17 11 13; 

18 13 14; 19 14 15; 20 15 16; 21 11 15; 

�)��(���������	��	��),� Centimeter 

� 	��'���	��' &)���	 General > Property ����)#/� Define… ��*�� Rectangle '�
��� 

���: YD = 30 cm, ZD = 30 cm 
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���: YD = 60 cm, ZD = 30 cm 

� 	��(
"�(�+��*� 
UNIT CM MTON 

MEMBER PROPERTY 

1 3 4 6 7 14 16 17 19 20 PRIS YD 30 ZD 30 

2 5 8 TO 12 15 18 21 PRIS YD 60 ZD 30 

��*�����% Tools > Set Input Current Unit… �)��(��������),� 

UNIT CM KG 

����� 	��'��	�
"�(	����% Command > Material Constant 

CONSTANTS 

E 220000 MEMB 1 TO 21 

POISSON CONCRETE MEMB 1 TO 21 

DENSITY 0.0024 MEMB 1 TO 21 

� 	��(
 CONSTANT �+�� 	��'�#!���������'#�+�� E (modulus of elasticity), Poisson’s ratio, etc �+�
��	"�(����%����)�������
������ 	������	���
 

SUPPORTS 

1 4 8 9 12 16 FIXED 

� 	��'#'��
�������-'����������#'��� 1, 4, 8, 9, 12 ��� 16 

���	
�� 	�������"#���!�"�( 1 �'�&)���	 General > Load ���
+*(���	 

LOAD 1 (1.4DL+1.7LL) 

����)#/� Add… ��*�� Selfweight �����	 -1.4 "�0"	
 Y ����)#/� Add 

SELFWEIGHT Y -1.4 

����� 	�����1��
�	� 

MEMBER LOAD 

2 5 8 TO 13 15 18 21 UNI GY -4 

���	
�� 	�������"#���!�"�( 2 ���
+*(���	 
LOAD 2  0.75(1.4DL+1.7LL+1.7WL) 

� 	�� 	������!� 1 �	�+�2� 	�%!'��� 0.75 
REPEAT LOAD 

1 0.75 
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	����������
�����	&)"�(#'��� 

JOINT LOAD 

10 13 14 FZ 2 

11 15 FZ 4 

��(
�)�����" 	�	������	��� �'�&)���	 Analysis/Print > Analysis  

�����.� PDelta Analysis ��*�� No Print Option ����)#/� Add 

PDELTA ANALYSIS 

&)���	���� Post-Print ����)#/� Define Commands…  

�����.� Member Forces ����)#/� Add ���� assign ����
���	�	�'�
��� 

PRINT MEMBER FORCES LIST 14 16 18 20 21 

&)"�(���	 Design > Concrete ��*���	��3	� ACI ��������)#/� Select Parameters… ��*��'�
��� 

 

����)#/� Define Paramaters…  

��*���	��	� Maxmain � 	��'��	'������������4�"�(�#'"�(��+����	������������	 25 mm 

��*���	��	� Track ��*�������� (1) ����)#/� Add ������*�������� (2) ����)#/� Add �������� Close 

�)�	�5�	��	��-�������	��	
 Concrete Design "	
'�	���	'�
��'
���%)��	
��	
 

Assign �	��	� MAXMAIN ��� Assign To View 

Assign �	��	� TRACK 1 �������	���	���� 21 

Assign �	��	� TRACK 2 �������	���	���� 18 
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� 	��(
"�(�+��*� 

START CONCRETE DESIGN 

CODE ACI 

MAXMAIN 25 ALL 

TRACK 2 MEMB 18 

TRACK 1 MEMB 21 

����)#/� Commands… ��*���	��	� DESIGN BEAM ��������)#/� Add 

��*���	��	� DESIGN COLUMN ����)#/� Add ��������)#/� Close 

	�����" 	�	� assign ��	����
���	�	� '�
��� 	��(
 
DESIGN BEAM 18 21 

DESIGN COLUMN 14 16 

END CONCRETE DESIGN 

FINISH 

� 	��(
����)����������#'�	�" 	
	� 
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Special Problem 1 

Stadium 

 

 

 

 

1.1 ��������	
����� 

���������	
�������������������� ����	��������� New ��������
������������ Space ����� Meter 
������� !� ��!�  "�#����� Kilo Newton ������� !"�� �� ���$�%&�'�����	����� stadium 

��������(����������� Add Beam "�� �����)*� Finish 

1.2 �����	��������������������� 

���$������+����� Geometry > Beam ����#���$������
������$����������������� �������������#��, X-Y 

"�� �����)*� View From + Z  "�� �����
��������+��������� 

���-�"�� �����)*� Close 
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���.�$���/0$�������0	����!+�,��#��, X-Y ��� ��!� ��"� "�� X = 10 �. ����) X = 0 (0� X = 10 

�. ���������� copy �&��.�$������0	�����	.�	�",, translation "�# circular 20$��#��"� .�������+�
�����������$�������"�� Y ���� 

 

�����
���.�	���
!�������.'�����,������#��)�.�	��� ������������+ Select > By All > All 

Beams 

.3� Circular Repeat 
!����%����  ������������+ Geometry > Circular Repeat… 

���$�������"���0	������������������+��������� 

z 
 

x 
 

x = 20, z = 0 
 

10 m 
 

40 m 
 

40 m 
 

Origin 
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���$����� OK 
����#(+�������0	������+��������� 

 

�&�����!��(+�������!+� �!��/0$�%������#%��/��#.�$(+�������#��!%� ����������������/�$�.3���	����%� 

(���4������%�"�� �������������
!����������)���� View From + Y "�� �������.'�����,���������
�+��������� (�������%����������� Ctrl ����% �"�� �������.�$�������������� 
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.3� Translational Repeat ����%����  ������������+ Geometry > Translational Repeat… 

���$�������"���0	������������������+��������� 

 

 

��������� Circular Repeat "�# Translational Repeat .3��� �.�$��������%� �������.3� Mirror +
����	 

������,�)����.3�%�
!���.+�,��'���,�����������"���#�)*�+���������� 

 

������� �.�$�������.3� Mirror �����+��������� 



STAAD.Pro 2005 : Special Problem 1 : Stadium 1 - 5 

 

 
 

����%���� Mirror  ������������+ Geometry > Mirror… ���$�������"���0	�������������+���
���+��������� 
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�����
������� �
��������+��������� 

 

��$� Mirror 
!����� Mirror Plane : X – Y, Plane at Z = -20 m �#%�
��������+��������� 

 

�����)���� Isometric View  �/�$�+
���������� ��������%���� 3D Rendered View  
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